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Abstract 
 

Scott, S.N., I.S. Burns, D.J. Semmens, L. Levick, S.N. Miller, M. Hernandez, D.C. Goodrich, W.G. 
Kepner, 2006, Automated Geospatial Watershed Assessment (AGWA) – A GIS-Based Hydrologic 
Modeling Tool: Documentation and User Manual; U.S. Department of Agriculture, Agricultural Research 
Service, ARS-1446. 

 
Planning and assessment in land and water resource management are evolving from simple, local-

scale problems toward complex, spatially explicit regional ones. Such problems have to be addressed 
with distributed models that can compute runoff and erosion at different spatial and temporal scales. The 
extensive data requirements and the difficult task of building input parameter files, however, have long 
represented an obstacle to the timely and cost-effective use of such complex models by resource 
managers. 

 
The USDA-ARS Southwest Watershed Research Center, in cooperation with the U.S. EPA Office of 

Research and Development, has developed a GIS tool to facilitate this process. A geographic information 
system (GIS) provides the framework within which spatially-distributed data are collected and used to 
prepare model input files and evaluate model results for two watershed runoff and erosion models: 
KINEROS2 and SWAT. 

 
AGWA is designed as a tool for performing relative assessment (change analysis) resulting from land 

cover/use change. Areas identified through large-scale assessment with SWAT as being most 
susceptible to change can be evaluated in more detail at smaller scales with KINEROS2. AGWA includes 
functions to assist in land cover/land use modification, in scenario development for individual watersheds 
and for areas of interest, and in best management practice and erosion management analyses. Results 
can be visualized as percent or absolute change for a variety of output and derived parameters. These 
features are intended to assist resource managers in identifying the most important areas for watershed 
restoration efforts and preventative measures.
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Disclaimer
 

The development of this document and the AGWA tool has been funded by the U.S. Environmental 
Protection Agency and carried out by the U.S. Department of Agriculture's Agricultural Research Service. 
Mention of trade names or commercial products does not constitute endorsement or recommendation for 
use by the Environmental Protection Agency or the Department of Agriculture. The Automated Geospatial 
Watershed Assessment (AGWA) tool described in this manual is applied at the user's own risk. Neither 
the U.S. Environmental Protection Agency, the U.S. Department of Agriculture, nor the system authors 
can assume responsibility for system operation, output, interpretation, or use.
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Introduction 
 

The Automated Geospatial Watershed Assessment (AGWA) tool is a multipurpose hydrologic analysis 
system for use by watershed, water resource, land use, and biological resource managers and scientists 
in performing watershed- and basin-scale studies. It was developed by the U.S. Agricultural Research 
Service's Southwest Watershed Resource Center to address four objectives: 

 
1. To provide a simple, direct, and repeatable method for hydrologic model parameterization 
2. To use only basic, attainable GIS data 
3. To be compatible with other geospatial watershed-based environmental analysis software 
4. To be useful for scenario development and alternative futures simulation work at multiple 

scales. 
 
AGWA provides the functionality to conduct all phases of a watershed assessment for two widely used 

watershed hydrologic models: the Soil Water Assessment Tool (SWAT); and the KINematic Runoff and 
EROSion model, KINEROS2. SWAT, developed by the U.S. Agricultural Research Service, is a long-term 
simulation model for use in large (river-basin scale) watersheds. KINEROS, also developed by the U.S. 
Agricultural Research Service, is an event driven model designed for small semi-arid watersheds. The 
AGWA tool has intuitive interfaces for both models that provide the user with consistent, reproducible 
results in a fraction of the time formerly required with the traditional approach to model parameterization. 

 
Data used in AGWA include Digital Elevation Models (DEMs), land cover grids, soils data, and 

precipitation data. All are available at no cost over the internet for North America, and other areas around 
the world. A more detailed description of these data types can be found in the Data Requirements 
section. 

 
AGWA is an extension for the Environmental Systems Research Institute's (ESRI's) ArcView versions 

3.x, a widely used and relatively inexpensive geographic information system (GIS) software package. The 
GIS framework is ideally suited for watershed-based analysis, which relies heavily on landscape 
information for both deriving model input and presenting model results. In addition, AGWA shares the 
same ArcView GIS framework as the U.S. Environmental Protection Agency's Analytical Tool Interface for 
Landscape Assessment (ATtiLA), and Better Assessment Science Integrating Point and Nonpoint 
Sources (BASINS). This facilitates comparative analyses of the results from multiple environmental 
assessments. In addition, output from one model may be used as input in others, which can be 
particularly valuable for scenario development and alternative futures simulation work. 
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Watershed Modeling 
 

Since the development of the Stanford Watershed Model (Crawford and Linsley, 1966) numerous 
hydrologic models have been developed that use watersheds as the fundamental spatial unit to describe 
the various components of the hydrologic cycle. Watershed models have five basic components: 
watershed (hydrologic) processes and characteristics; input data; governing equations; initial and 
boundary conditions; and output (Singh, 1995). Despite their uniform general structure, however, various 
treatments of the five model components has resulted in a significant range of available model types. 
Distinguishing between these different model types is an important first step in selecting the appropriate 
model for a project. 

 
Watershed models are generally classified according to the method they use to describe the 

hydrologic processes, the spatial and temporal scales for which they are designed, and any specific 
conditions or intended use for which they are designed. Some knowledge of these components is highly 
recommended when selecting the combination that is best suited to a specific watershed and task. 

 
Process Description 
Watershed models can be divided into two main types according to how they treat the spatial component 
of watershed hydrology (Figure 1). Lumped, or lumped-parameter models treat an entire watershed as 
one unit and take no account of the spatial variability in processes, input, boundary conditions, or the 
hydrologic properties of the watershed. In contrast, distributed models ideally account for all spatial 
variability in the watershed explicitly by solving the governing equations for each pixel in a grid. In reality, 
neither of these extremes are suitable for watershed modeling because a lumped framework is a gross 
oversimplification and a distributed framework requires enormous amounts of data that are not readily 
obtainable. As a result most models have combined aspects of both approaches and subdivide the 
watershed into smaller elements with similar hydrologic properties that can be described by lumped 
parameters. This model type is commonly referred to as partially distributed, or quasi-distributed. 

 

 
 
Figure 1. Process-based classification of watershed models, after Singh (1995). 
 
The description of the hydrologic processes within a watershed model can be deterministic, stochastic, 

or some combination of the two. Deterministic models are models in which no random variables are used, 
i.e. for each unique set of input data the model will compute fixed, repeatable results (e.g. Law and 
Kelton, 1982). The governing equations describing the hydrologic and soil erosion processes in a 
deterministic model should be a major factor in selecting a model. Models with equations based on 
fundamental principles of physics or robust empirical methods are the most widely used in computing 
surface runoff and sediment yield. Stochastic models, in contrast, use distributions for each variable to 
generate random values for model input (e.g. Clarke, 1998). As a result, the output from a stochastic 
model is itself random, with its own distribution, and can thus be presented as a range of values with 
confidence limits. 

 
The vast majority of watershed models are deterministic, including both KINEROS and SWAT. Fully 

stochastic models, in which all components of the model are stochastic, are virtually non-existent (Singh, 
1995). Stochastic generation of input variables, however, is commonly used to optimize models, or 
determine model sensitivity to various input variables. If only parts of a model are described by the laws 
of probability then it is commonly referred to as quasi-deterministic, quasi-stochastic, or mixed. 
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Spatial Scale 
A watershed can range from as little as one hectare to hundreds of thousands of square kilometers. The 
spatial scale for which a model is designed can play a significant role in how specific processes are 
treated. Runoff in large watersheds (> 1000 km2), for instance, is dominated by channel storage. In 
contrast, runoff from small watersheds (< 100 km2) is dominated by overland flow. For intermediate 
watersheds it is important to account for the essential concept of homogeneity and averaging of 
hydrologic process in the models. 

 
Spatial scale is an important criterion in the selection of a model because the storage characteristics 

may vary at different watershed scales, that is, large watersheds have well developed channel networks 
and channel phase, and thus, channel storage is dominant. Such watersheds are less sensitive to short 
duration, high intensity rainfalls. On the other hand, small watersheds are dominated by the land phase 
and overland flow, have relatively less conspicuous channel phase, and are highly sensitive to high 
intensity, short duration rainfalls. 

 
Temporal Scale 
Hydrologic processes may occur at different time scales, therefore it is important to consider models that 
operate from event to daily to yearly time scales. At the event time scale, models typically do not compute 
inter-storm soil moisture conditions and therefore this information must be provided as an initial condition 
to initiate the model run. Event based models may be employed for storm events of relatively short 
duration or to finalize the design of technically complex structural and nonstructural management 
practices. On the other hand, continuous-time hydrologic models can simulate precipitation, available 
surface storage, snowmelt, evapotranspiration, soil moisture, and infiltration in a seasonal framework. 
These models typically operate on a time interval ranging from a fraction of an hour to a day. The 
principal advantage of continuous modeling is that it can provide long-term series of water and pollutants 
loadings. 

 
Land Use 
Many studies have shown that the land uses within a watershed can account for much of the variability in 
stream water quality (Omernick, 1987; Hunsaker et al., 1992; Charbonneau and Kondolf, 1993; Roth et 
al., 1996). Agriculture on slopes greater than three percent, for example, increases the risk of erosion 
(Wischmeier and Smith 1978). A drastic change in vegetation cover, such as clear cutting in the Pacific 
northwest, can produce 90% more runoff than in watersheds unaltered by human practices (Franklin, 
1992). The linkage between intact riparian areas and water quality is well established (Karr and 
Schlosser, 1978; Lowrance et al., 1984). For example, riparian habitats function as "sponges", greatly 
reducing nutrient and sediment runoff into streams (Peterjohn and Correll, 1984). 

 
The percentage and location of natural land cover influences the amount of energy that is available to 

move water and materials (Hunsaker and Levine, 1995). Forested watersheds dissipate energy 
associated with rainfall, whereas watersheds with bare ground and anthropogenic cover are less able to 
do so (Franklin, 1992). The percentage of the watershed surface that is impermeable, due to urban and 
road surfaces, influences the volume of water that runs and increases the amount of sediment that can be 
moved (Arnold and Gibbons, 1996). Watersheds with highly erodible soils tend to have greater potential 
for soil loss and sediment delivery to streams than watersheds with non-erodible soils. 

 
Moreover, intense precipitation events may exceed the energy threshold and move large amounts of 

sediment across a degraded watershed (Junk et al., 1989; Sparks, 1995). It is during these events that 
human-induced landscape changes may manifest their greatest negative impact. 

 
A direct and powerful link exists between vegetation and hydrological processes in semi-arid 

environments. Vegetation plays a pivotal role in determining the amount and timing of the runoff which 
ultimately supplies mass and energy for the operation of hydrologic and erosive processes (Graf, 1988). 
Most analyses that assess the variability of sediment yield demonstrate that at the lower end of the 
precipitation scale (representing semi-arid conditions), small changes in annual precipitation bring about 
major changes in vegetation communities and associated sediment yields (Graf, 1988). For example, for 
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a mean annual temperature of 10° C, the Langbein and Schumm (1958) curve reaches a peak at an 
effective precipitation of about 300 mm (Figure 2), trailing off at lower values because of lower runoff 
totals and at higher ones because an increasingly abundant vegetation cover affords better protection 
against erosion. 

 

 
Figure 2. Erosion as a function of precipitation. After Langbein & Schumm (1958) 
 
It should be clearly noted that methods for transforming various land cover and land use 

characteristics into distributed hydrologic model parameters are not well developed for a wide range of 
conditions. For management purposes, many approaches rely largely on empirical studies from large 
numbers of small plots and catchments to relate land cover and land use to effective hydrologic model 
parameters. The curve number method (Chow et al., 1988) and the USLE or RUSLE method for 
predicting soil erosion (Renard et al., 1997) are examples of this type of approach to relate land 
cover/land use to hydrologic model parameters. The transformation of land cover/land use conditions into 
meaningful hydrologic and erosion parameters, and quantifying the associated uncertainty is a major 
challenge in watershed modeling. 

 
Effects of aggregation of landscape attributes on watershed response 
Recent papers (e.g. Roth et al., 1996; Weller et al., 1996) suggest that the importance of landscape 
features may change in different environmental settings, or when moving from one spatial scale to 
another. Therefore, methods to analyze and interpret broad spatial scales are becoming increasingly 
important for hydrological and ecological studies. Parameters and processes important at one scale are 
frequently not important or predictive at another scale, and information is often lost as spatial data are 
considered at coarser scales of resolution (Meentemeyer and Box, 1987). Furthermore, hydrological 
problems may also require the extrapolation of fine-scale measurement for the analysis of broad-scale 
phenomena. Therefore, the development of methods that will preserve information across scales or 
quantify the loss of information with changing scales has become a critical task. 

 
Wood et al. (1988) carried out an empirical averaging experiment to assess the impact of scale. They 

averaged runoff over small subwatersheds, aggregating the subwatersheds into larger watersheds, and 
repeating the averaging process. By plotting the mean runoff against mean subwatershed area, they 
noted that the variance decreased until it was rather negligible at a watershed scale of about 1 km2. That 
analysis has been repeated for the runoff ratio (Wood, 1994) and evaporation (Famiglietti and Wood, 
1995) using data from Kings Creek, which was part of the FIFE '87 experiment. Results from the 
experiment show that at small scales there is extensive variability in both runoff and evaporation. This 
variability appears to be controlled by variability in soils and topography whose correlation length scales 
are on the order of 102 - 103m, typical of hillslopes. At an increased spatial scale, the increased sampling 
of hillslopes leads to a decrease in the difference between subwatershed responses. At some scale, the 
variance between hydrologic response for watersheds of the same scale should reach a minimum. 

 
Integration of geographic information systems and remote sensing in hydrologic modeling 
Spatially distributed models of watershed hydrological processes have been developed to incorporate the 
spatial patterns of terrain, soils, and vegetation as estimated with the use of remote sensing and 
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geographic information systems (GIS) (Band et al., 1991; 1993; Famiglietti and Wood, 1991; 1994; Moore 
and Grayson, 1991; Moore et al., 1993; Wigmosta et al., 1994; Star et al., 1997). This approach makes 
use of various algorithms to extract and represent watershed structure from digital elevation data. Land 
surface attributes are mapped into the watershed structure as estimated directly from remote sensing 
imagery (e.g. canopy leaf area index), digital terrain data (slope, aspect, contributing drainage area) or 
from digitized soil maps, such as soil texture or hydraulic conductivity assigned by soil series. 

 
Over the past decade numerous approaches have been developed for automated extraction of 

watershed structure from grid digital elevation models (e.g. Mark et al., 1984; O'Callagham and Mark, 
1984; Band, 1986; Jenson and Dominque, 1988; Moore et al., 1988; Martz and Garbrecht, 1993; 
Garbrecht and Martz, 1993; 1995; 1996). O'Callagham and Mark (1984) define a digital elevation model 
(DEM) as any numerical representation of the elevation of all or part of a planetary surface, given as a 
function of geographic location. The most widely used method for the extraction of stream networks that 
has emerged is to accumulate the contributing area upslope of each pixel through a tree or network of cell 
to cell drainage paths and then prune the tree to a finite extent based on a threshold drainage area 
required to define a channel or to seek local morphological evidence in the terrain model that a channel or 
valley exists (Band and Moore, 1995). 

 
The techniques used for delineation of the drainage path network by surface routing of drainage area 

and local identification of valley forms are ultimately dependent on a topographic signal generated in a 
local neighborhood on the DEM. As the approach is used to extract watershed structure with increasingly 
lower resolution terrain data, higher frequency topographic information is lost as the larger sampling 
dimensions of the grids act as a filter. Therefore, if watershed structural information is used to drive the 
hydrological model, the scaling behavior and consistency of the derived stream network with grid 
dimension needs to be addressed. One of the primary questions dealing with automated extracted 
channel network is that of the appropriate drainage density. Some authors suggest criteria to find this 
appropriate scale. For example, Goodrich (1991) found a drainage density of approximately 0.65 to 1.52 x 
10-3m for watersheds greater than 1 hectare was adequate for kinematic runoff modeling in semi-arid 
regions. Similarly, La Barbera and Roth (1994) proposed a filtering procedure based on the identification 
of threshold value for the quantity Ask, where A is the contributing area, S the stream slope and k = 2. 
This procedure consists in the progressive removal from the drainage network of the first order stream 
which presents the minimum Ask value; the procedure is iterated up to a given target value for the area 
drained by first order streams. Calore et al. (1997) found that above a certain threshold, an increase in 
resolution in the spatial description of drainage networks obtained from a DEM cannot be directly linked to 
an increase of information. The criterion they used for assessing the amount of information contained in 
the drainage was based on the information entropy concept of Shannon (1948). 

 
Land use is an important watershed surface characteristic that affects infiltration, erosion, and 

evapotranspiration. Thus, almost any physically based hydrologic model uses some form of land use data 
or parameters based on these data (Spanner et al., 1990; 1994; Nemani et al., 1993). Distributed models, 
in particular, need specific data on land use and their location within the basin. Some of the first research 
for adapting satellite derived land use data was done by Jackson et al. (1976) with the US Army Corps of 
Engineers STORM Model (US Army Corps of Engineers, 1976). However, most of the work on adapting 
remote sensing to hydrologic modeling has been with the Soil Conservation Service (SCS) runoff curve 
number model (US Department of Agriculture, 1972). The SCS model has been widely used in hydrology 
and water resources planning of agricultural areas. The model was originally developed for predicting 
runoff volumes from agricultural fields and small watersheds. However, it has been expanded for 
subsequent use in a wide variety of conditions at many basin sizes including urban and suburban areas. 
In early work with remotely sensed data, Jackson et al. (1977) demonstrated that land cover (particularly 
the percentage of impervious surface) could be used effectively in the STORM Model (US Army Corps of 
Engineers, 1976). In a study of the upper Anacostia River basin in Maryland, Ragan and Jackson (1980) 
demonstrated that Landsat-derived land use data could be used for calculating synthetic flood frequency 
relationships. Results can be erroneous if land use is mislabeled. A study by the US Army Corps of 
Engineers (Rango et al., 1983) estimated that any individual pixel may be incorrectly classified about one-
third of the time. However, by aggregating land use over a significant area, the misclassification of land 
use can be reduced to about 2% (Engman and Gurney, 1991). 
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More recently, vegetation classification studies implementing digital satellite data have utilized higher 

spatial, spectral, and radiometric resolution Landsat Thematic Mapper (TM) data with much more 
powerful computer hardware and software. These studies have shown that the higher information content 
of TM data combined with the improvements in image processing power result in significant 
improvements in image processing power resulting in significant enhancement in classification accuracy 
for more distinctive classes (Congalton et al., 1998). 

 
A detailed analysis of the effects of the thematic accuracy of land cover is necessary before any 

attempt on using the hydrologic modeling tool to determine the vulnerability of semi-arid landscapes to 
land cover changes. The accuracy of maps made from remotely sensed data is measured by two types of 
criteria (Congalton and Green, 1999): location accuracy and, classification or thematic accuracy. Location 
accuracy refers to how precisely map items are located relative to their true location on the ground. 
Thematic accuracy refers to the accuracy of the map label in describing a class or condition on the earth. 
For example, if the earth's surface was classified as forest, thematic map accuracy procedures will 
determine whether or not forest has been accurately labeled forest or inaccurately labeled as another 
class, such as water. 

 
The widespread acceptance and use of remotely sensed data has been and will continue to be 

dependent on the quality of the map information derived from it. However, map inaccuracies or error can 
occur at many steps throughout any remote sensing project. According to Congalton and Green (1999), 
the purpose of quantitative accuracy assessment is the identification and measurement of map errors. 
Quantitative accuracy assessment involves the comparison of a site on a map against reference 
information for the same site. The reference data is assumed to be correct. 

 
The history of accuracy assessment of remotely sensed data is relatively short, beginning around 

1975. Researchers, notably Hord and Brooner (1976), van Genderen and Lock (1977), proposed criteria 
and techniques for testing map accuracy. In the early 1980s more in-depth studies were conducted and 
new techniques proposed (Rosenfield et al., 1982; Congalton et al., 1983; and Aronoff, 1985). Finally, 
from the late 1980s up to present time, a great deal of work has been conducted on accuracy 
assessment. An important contribution is the error matrix, which compares information from reference 
sites to information on the map for a number of sample areas. The matrix is a square array of numbers 
set out in rows and columns that express the labels of samples assigned to a particular category in one 
classification relative to the labels of samples assigned to a particular category in another classification. 
One of the classifications, usually the columns, is assumed to be correct and is termed the reference 
data. The rows usually are used to display the map labels or classified data generated from remotely 
sensed data. Error matrices are very effective representation of map accuracy, because the individual 
accuracy of each map category are plainly described along with both errors of inclusion (commission 
errors) and errors of exclusion (omission errors) present in the map (Congalton and Green, 1999). A 
commission error occurs when an area is included in an incorrect category. An omission error occurs 
when an area is excluded from the category to which it belongs. In addition to clearly showing errors of 
omission and commission, the error matrix can be used to compute overall accuracy. 

 
Soils information derived from a GIS are generally gathered in a similar manner to vegetation, with the 

exception that remote sensing often cannot provide critical information about soil properties, especially if 
the soil is obscured by a vegetation canopy (Band and Moore, 1995). Substantial progress has been 
made in estimating near-surface and profile soil water content with active and passive microwave sensors 
and in the estimation of hydraulic properties by model inversion (e.g. Entekhabi et al., 1994). However, in 
general, soil spatial information is the least known of the land surface attributes relative to its well-known 
spatial variability that has been observed in many studies (Nielsen and Bouma, 1985). 

 
Kinematic Runoff and Erosion Model - KINEROS 
KINEROS utilizes a network of channels and planes to represent a watershed and the kinematic wave 
method to route water off the watershed (Figure 3). It is a physically-based model designed to simulate 
runoff and erosion for single storm events in small watersheds less than approximately 100 km2. More 
detailed technical information about KINEROS can be found at http://www.tucson.ars.ag.gov/kineros/.  
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Figure 3. A schematic representation of the KINEROS program. 
 

Soil Water Assessment Tool - SWAT 
The Soil and Water Assessment Tool (SWAT) (Arnold et al., 1994) was developed to predict the effect of 
alternative management decisions on water, sediment, and chemical yields with reasonable accuracy for 
ungaged rural basins. It is a distributed lumped-parameter model developed at the USDA Agricultural 
Research Service (ARS) to predict the impact of land management practices on water, sediment and 
agricultural chemical yields in large (basin scale) complex watersheds with varying soils, land use and 
management conditions over long periods of time (> 1 year). SWAT is a continuous-time model, i.e. a 
long-term yield model, using daily average input values, and is not designed to simulate detailed, single-
event flood routing. Major components of the model include: hydrology, weather generator, 
sedimentation, soil temperature, crop growth, nutrients, pesticides, groundwater and lateral flow, and 
agricultural management. The Curve Number method is used to compute rainfall excess, and flow is 
routed through the channels using a variable storage coefficient method developed by Williams (1969). 
Additional information and the latest model updates can be found at http://www.brc.tamus.edu/swat/. 
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AGWA Tool Overview 
 

The AGWA tool, packaged as an e an extension for the ESRI ArcView 3.x GIS software, uses geospatial 
data to parameterize two watershed runoff and erosion models: KINEROS, and SWAT. A schematic of 
the procedure for utilizing these models with AGWA is presented below in Figure 4. AGWA is a modular 
program that is designed to be run in a step-wise manner. 

 

 
Figure 4. Basic processing steps for AGWA. 
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The AGWA extension for ArcView adds the AGWA 
Tools menu to the View window, and must be run from an 
active view. The AGWA Tools menu is designed to reflect 
the order of tasks necessary to conduct a watershed 
assessment, which is broken out into five major steps: 

 
1. Watershed delineation and discretization 
2. Land cover and soils parameterization 
3. Writing a precipitation file for model input 
4. Writing parameter files and running the chosen model 
5. Viewing results 

 
In more detail... 
Step 1. Watershed Delineation and Discretization: The 

user first creates a watershed outline, which is a grid based 
on the accumulated flow to the designated outlet (pour 
point) of the study area. A polygon shapefile is built from t
watershed outline grid. The user then specifies the 
threshold of contributing area for the establishment of 
stream channels, and the watershed is divided into model 
elements required by the model of choice. From this point, 
the tasks are specific to the model that will be used, but 
both follow the same general process. If internal runoff 
gages for model validation or ponds/reservoirs are present 
in the discretization, they can be used to further subdivide 
the watershed. 

he 

 
Step 2. Land cover and soils parameterization: AGWA is predicated on the presence of both land 

cover and soil GIS coverages. In step 2, the watershed is intersected with these data and parameters 
necessary for the hydrologic model runs are determined through a series of look-up tables. The 
hydrologic parameters are added to the polygon and stream channel tables. 

 
Step 3. Writing a precipitation file for model output: Rainfall input files are built. For SWAT, the user 

must provide daily rainfall values for rainfall gages within and near the watershed. If multiple gages are 
present, AGWA will build a Thiessen polygon map and create an area-weighted rainfall file. For 
KINEROS, the user can select from a series of pre-defined rainfall events or choose to build his/her own 
rainfall file through an AGWA module. Precipitation files for model input are written from uniform (single 
gage) rainfall or distributed (multiple gage) rainfall data. 

 
Step 4. Writing parameter files and running the chosen model: At this point, all necessary input data 

have been prepared: the watershed has been subdivided into model elements; hydrologic parameters 
have been determined for each element; rainfall files have been prepared. The user can proceed to run 
the hydrologic model of choice. 

 
Step 5. Viewing results: AGWA imports the model results and adds them to the polygon and stream 

maps' tables for display. A separate module controls the visualization of model results. The user can 
toggle between viewing the total depth or accumulated volume of runoff, erosion, and infiltration output for 
both upland and channel elements. This enables problem areas to be identified visually so that limited 
resources can be focused for maximum effectiveness. Model results can also be overlaid with other 
digital data layers to further prioritize management activities. 

 
Changes for AGWA 1.5 

New to 1.5 
Support for riparian buffer modeling with KINEROS, including the capability of comparing simulations 

between unbuffered and buffered watersheds 
Support for spatially distributed precipitation files for KINEROS 
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Nitrogen and phosphorous modeling for SWAT 
Hydrologic Response Unit simulation for SWAT 
Support for GAP vegetation datasets 
Support for landcover modification using a burn severity map with the Landcover Modification Tool 
Support for watershed groups, including discretization and simulation of multiple watersheds as one 

unit either with multiple outlet locations or with the area of interest tool 
Improved handling of SSURGO datasets, including correction of internal voids, extension of the 

dataset to correspond to watershed boundaries, spatial and tabular dataset merge tools, and 
tabular dataset import tools 

Improved handling of contributing source areas for higher order planes with the CSA enforcement 
option 

Support for KINEROS batch processing 
Improved handling of AGWA datasets, including AGWA metadata and the ability to easily transfer 

watersheds and related datasets between projects and users 
Additional simulation display options, including timestep sequencing for KINEROS and SWAT, the 

ability to standardize the classification scheme based on previous simulation results, and the 
inclusion of nitrogen and phosphorus outputs for SWAT and percent error for KINEROS 

Addition of non-releasing ponds to exclude regions of a watershed from simulation 
Support for nested watersheds 
Addition of XY coordinate specification for watershed outlets 
New selection option for weather generator files using a point theme 
Support for adjustable stream grids for watershed outlet placement 
User-specified DAT directory defaults for SWAT inputs files 
Support for displaying KINEROS multipliers for any stored simulation 
Landcover lookup table editing for SWAT HRU parameters (crop, urban simulation method, and urban 

landcover) 
 
Changes from 1.4 
Improved handling of internal breakpoints, including internal gages, ponds, and reservoirs 
Improved KINEROS plane splitting 
Improved flow length calculations for KINEROS 
Improved error checking for watershed discretization 
Improved handling of simulation results, including the capability to re-import deleted results tables 
Improved handling of watershed delineation and discretization options 
Improved handling of SWAT precipitation file generation 
Improved handling of the SWAT subwatershed selection discretization option 
Improved handling for rerunning SWAT simulations to retain original output files 
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Set-up and Installation 
 
Hardware and Software Requirements 
The AGWA tool is not a stand alone program.  
It requires the Environmental Systems Research 
Institute's (ESRI) ArcView 3.x software and the 
Spatial Analyst Extension for working with grid-
based data. AGWA is available in two releases, as 
an extension for BASINS 3.1 (version 1.4) and as a 
stand alone extension (version 1.5), both requiring 
ESRI’s ArcView software. The AGWA tool is 
designed to run on Microsoft Windows versions 95, 
98, NT 4.0, 2000, ME, and XP. Processor speed 
does have a significant impact on the time required 
to perform the watershed delineation and other 
tasks in AGWA.  

 
Installation 
The AGWA tool comes as a collection of files that 
are necessary for its operation. These files are 
organized as follows in both agwa1_5.zip, and the 
AGWA CD: 

 
ArcView extension agwa1_5.avx 
datafiles directory – database files and 

supplementary extensions (grid01.avx, and 
xtools.avx). 

models directory – model executables and 
associated files 

gisdata directory – example data 
documents directory – presentations and 

example documents 
manual directory – user manual and associated 

files 
 
For users downloading the file agwa1_5.zip 

please unzip these files and directories to a 
directory named AGWA, e.g. C:\AGWA. 

 
For users with an AGWA CD, please copy the 

entire AGWA directory to your computer, creating 
e.g. C:\AGWA. Once this directory has been 
established you will need to change the 
permissions for it (everything is converted to 'read 
only' when written to the CD). 

 
For Windows 2000 and XP – Right click on the 

AGWA directory to view the directory Properties 
window and uncheck the “read only” box. When 
you click OK or Apply, the Confirm Attribute 
Changes window will pop up and prompt you to 
choose whether you would like to apply the change 
to just the specified AGWA directory, or to also 
include subfolders and files. Please select the 

latter to ensure that “read-only” is unset for all files 
in the directory. 

 
For Windows 95, 98 and NT – File permissions 

cannot be set recursively for subfolders and files 
through a folder properties window. Instead, select 
Run from the Start Menu to bring up the window 
shown on the right. Type "attrib -R C:\AGWA\*.* /S" 
in the text 

 
When the AGWA directory and its associated 

subdirectories have been created on your hard 
drive: 

 
Drag or paste the extension file (agwa1_5.avx) 
into the \ESRI\AV_GIS30\ARCVIEW\EXT32\ 
directory. Two supplementary extensions 
(grid01.avx, and xtools.avx) can optionally be 
copied from the datafiles subdirectory to 
\ESRI\AV_GIS30\ARCVIEW\EXT32\. These 
two extensions provide the user with additional 
capabilities when preparing data for AGWA, 
and potentially for analyzing results within 
ArcView. 

 
Open ArcView and select Extensions from the 
File menu. To activate the AGWA extension 
click the box next to its name in the Extensions 
window and then click OK. You are now ready 
to begin using AGWA, but be sure to read the 
File Management section first. If the two 
supplementary extensions will be used then 
they can be turned on at this time as well, but 
these can be turned on/off and used at any 
time. 
 
To take full advantage of the AGWA extension, 

users should set the AGWA environmental 
variable. To set the variable, go to the 
Environment Variables tab in the System dialog. 
Add a new variable called “AGWA” and set the 
path to the main AGWA directory, for example, 
c:\agwa\. This variable should not be changed 
once set. Instructions for setting the environment 
variable: 
 

For Windows 2000 and XP 
1. From the Start Menu select 

Settings>Control Panel 
2. Double click on the System icon 
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3. From the System Properties window 
select the Advanced tab, and then click the 
Environment Variables button. 

4. For the user variables, click on the New 
button and set its name to “AGWA” (without 
the quotes), and its value to “C:\AGWA” or 
wherever you have established your AGWA 
directory. This will give AGWA a head start 
in locating files and save you time in the 
long run.  

 
For Windows NT 
1. From the Start Menu, select 

Settings>Control Panel 
2. Double click on the System icon 
3. From the System Properties window 

select the Environment tab, and then click 
the Environment Variables button. 

4. For the user variables, click on the New 
button and set its name to “AGWA” (without 
the quotes), and its value to “C:\AGWA” or 
wherever you have established your AGWA 
directory. This will give AGWA a head start 
in locating files and save you time in the 
long run.  

 
For Windows 95 & 98 
1. Open the file c:\autoexec.bat in a text editor 

– this can be accomplished by right clicking 
on the file in the Explorer window and 
selecting Edit. 

2. Add the following line to the autoexec.bat 
file: 

 
set AGWA=agwadir 

 
where “agwadir” is the folder that will 
contain all your AGWA-related files and 
directories, for example: C:\AGWA.  

3. Restart your computer to activate the 
changes to autoexec.bat. 

 
Important – Do not ever use spaces anywhere 

in the path to this directory (e.g. "C:\My 
Documents\AGWA") because ArcView has 
problems dealing with file and folder names that 
contain spaces. 
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File Management 
 
File management in any ArcView-based 
application is extremely important. ArcView 
projects maintain references to many files that are 
generated or used, and moving or deleting these 
files incorrectly will cause problems. Since this 
happens frequently when working and data 
directories are not fixed (i.e. user-selected or 
default directories), the AGWA extension manages 
them for you. When the AGWA extension is loaded 
into a project it prompts the user to select a name 
for a new project directory. This directory is then 
created and the project is automatically saved to it. 
In addition, several additional subdirectories are 
created for writing various input and output files 
used by AGWA. This, in combination with the 
option to set a system environmental variable 
“AGWA”, allows AGWA to locate many files without 
prompting the user, and in other instances when 
the user must select a file it opens the appropriate 
directory when asking the user to select a file. 

 

 
Figure 5. The AGWA file structure 
 
The AGWA directory contains all projects and 

their associated datasets (Figure 5). The creation 
of this directory was described in Set-up and 
Installation>Installation. Each project directory 
contains three subdirectories:  

 
av_cwd, which serves as the working directory 

for the project; 
rainfall, which contains all precipitation files 

generated by AGWA; and, 
simulations, which contains a simulation 

directory for each simulation, SWAT or 
KINEROS, performed within AGWA. 

 

The handling of simulations, particularly 
KINEROS simulations, has been changed for 
version 1.5. Unlike earlier versions, where input 
files were stored in a kin_sims directory, KINEROS 
input files are now stored in a separate 
subdirectory in a manner similar to that of SWAT 
simulations. At no time should spaces be used in 
AGWA file names. 

 
Users are encouraged to create a datafiles 

directory and a gisdata directory in the main 
AGWA directory. AGWA searches for required 
tabular datasets in the datafiles directory during a 
number of processing steps. These files include 
the kin_lut.dbf, the wgnfiles.dbf, all landcover 
lookup tables, and tabular datasets for soils. 

 
The datafiles directory also contains several 

SWAT default data files, including the 
crop2000.dat and urban2000.dat files. Because 
these files can be modified to include user-defined 
landcover or urban landuse types, AGWA allows 
users to set the default directory location for all of 
the required DAT files. This directory can be 
changed at any time with AGWA 
Tools>Preferences. After AGWA creates the new 
project directory, it searches for the DAT files in the 
AGWA datafiles directory. If the files are not 
located there, AGWA prompts you to locate the 
crop2000.dat file to set the default location. 

AGWA 

project 

 
The models directory contains the executables 

for SWAT and KINEROS. It also contains the 
executable for the multifractal surface generator 
utilized by the Landcover Modification Tool 
(lcmf.exe). 

 
The manual directory contains the dynamic help 

files accessed by AGWA through any Help button. 
If this directory (and the manual) are not located by 
AGWA, the manual cannot be accessed from an 
AGWA project. 
 

Project information regarding the current state 
of AGWA preferences is stored in the AGWA.odb 
file in the project directory. This file should not be 
deleted. 

 
All spatial data should be projected to a suitable 

projection with units in METERS. Failure to do so 
will result in unusable watersheds and erratic 
AGWA behavior. DO NOT set the View Projection. 

datafiles 

manual 

av_cwd 

rainfall 

models simulations 
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It is the user's responsibility to provide correctly 
projected datasets. The View’s Map Units must 
also be set to meters.  

 
Required Files and Datasets 
These files are either required for different AGWA 
components or created during processing. In many 
cases, the AGWA generated files are required for 
later processing steps. User-specified names are 
indicated by <name>, where name indicates the 
type of object the name refers to.  

 
Watershed Raster Inputs 
Digital elevation model (required): A raster 

dataset, supplied by the user, encompassing the 
study area. This file is used by AGWA in 
determining watershed boundaries and other 
model-specific parameters. If the user decides to 
fill any sinks in the raster (an option available 
through AGWA), this new dataset is located in the 
av_cwd directory. 

 
Flow direction grid (optional): A raster dataset, 

specific to a given DEM, representing the direction 
of flow throughout a study area. This dataset can 
be created within AGWA (file located in the av_cwd 
directory) or can be generated outside of AGWA 
and added to the view before attempting to 
generate a watershed. 

 
Flow accumulation grid (optional): A raster 

dataset, specific to a given DEM, representing the 
accumulation of runoff throughout a study area. 
This dataset can be created in AGWA (file located 
in the av_cwd directory) or can be generated 
outside of AGWA and added to the view before 
attempting to generate a watershed. 

 
Stream map: A raster dataset representing the 

cells into which a specified number of cells flow. 
This grid is generated by AGWA; the threshold can 
be determined by a user based on DEM resolution 
and degree of network complexity required. The 
stream map is used for user-identified outlet 
location and, if using the area of interest watershed 
delineation method, for dynamically locating 
outlets.  

 
Watershed Components 
Outlet (optional): A point theme containing one 

or more outlet locations. 
 
HGR.dbf (required): A table containing the 

hydraulic geometry relationships available for use 
during watershed discretization. This table is 
available for download from the AGWA website. 

Watershed outline: A raster representing the 
total area draining to the specified outlet. This 
dataset is created by AGWA and can be found in 
the working directory. This grid must have a unique 
name within the project. 

 
Watershed discretization: A polygon shapefile 

representing the subwatershed or plane elements 
at the specified contributing source area for a 
given watershed outline. This file must have a 
unique name within the project. 

 
Stream Network: A polyline shapefile 

representing the stream elements at the specified 
contributing source area for a given watershed 
outline. 

 
Area of interest boundary (optional): A polygon 

shapefile containing the boundary or boundaries 
for an area of interest to create a watershed group. 
This shapefile is only necessary to use this 
delineation/discretization option. 

 
Metadata: An object database file (ODB) 

containing file creation, parameterization, and 
simulation information (as <watershed name> 
.odb). This file replaces the watershed and stream 
comments from earlier AGWA versions. This file is 
necessary to use a watershed in AGWA. A 
metadata file is also created for the watershed 
outline and must be present in the AGWA working 
directory to reuse the outline. 

 
Landcover Components 
Landcover (required): A raster dataset 

representing the distribution of landscape classes 
across a study area. Several datasets are 
supported by AGWA, including NALC, MRLC, and 
GAP landcovers. The landcover attribute table 
must contain a VALUE field and a NAME field. The 
surface should extend beyond the boundaries of 
the watershed for successful watershed 
parameterization. 

 
Landcover lookup table (required): A dBASE 

formatted table containing parameter values by 
landcover class. Each record is identified by a 
unique key, identical to the values contained in the 
VALUE field of the landcover raster. Additional 
parameters include cover, interception, Manning's 
N, percent impervious and curve number values 
(A, B, C, and D).  AGWA provides several lookup 
tables; custom tables, containing the parameters 
described above, can also be utilized for landcover 
parameterization. 
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<watershed>_HRUs.dbf: A table containing the 
areas of each landcover type found within a SWAT 
subwatershed. Required to simulate hydrologic 
response units. 

 
Soil Components 
Soils (required): A polygon shapefile or 

coverage representing the soil types across the 
study area. Supported soil classifications include 
STATSGO, SSURGO, and FAO. The dataset 
should extend beyond the watershed boundaries 
and not contain any internal voids for successful 
soils parameterization. 

 
Soil tables (required): Each soil classification is 

associated with a tabular dataset. AGWA requires 
specific tables from each dataset to perform 
parameterization: 

 
STATSGO: Required dataset includes the 

comp.dbf and layer.dbf tables. These are 
organized by state and are available from the 
AGWA website. The state directories should be 
located in the AGWA datafiles directory. 

 
SSURGO: Required dataset includes the 

comp.txt, chorizon.txt, and chtexgrp.txt files. 
Although the SSURGO dataset is available as 
an Access database, this dataset cannot be 
utilized by AGWA. These files can be located 
anywhere on the computer but must be 
imported by AGWA before or during the 
parameterization process. Imported tables can 
be found in the av_cwd directory. 

 
FAO: Required dataset includes the 

FAO_summ, FAO_world, FAO_Africa, and 
FAO_properties tables. These are available 
from the AGWA website and should be located 
in the datafiles directory. 
 
temp_kin_soil_lut.dbf: Temporary soils table 

created during soils parameterization for 
KINEROS. It contains the depth-weighted 
averages for each soil classification within the 
watershed. This file is updated for each 
parameterization. The file is maintained to aid in 
error resolution. 

 
<watershed name>_temp_swat_soil_lut.dbf: 

Temporary table containing hydraulic conductivity 
(KS) and hydrologic soil group averages (based on 
component percent) by soil classification. 

 
<watershed name>_soil_lut.dbf: Required table 

containing the soil layers for each soil classification 

within the watershed. This file is used during 
SWAT input file generation to describe the 
subwatersheds. 

 
soil_output.dbf: Temporary table containing 

hydraulic conductivity and hydrologic soil group 
values area-weighted for each subwatershed. 
These values are based on the component 
averages found in the temp_swat_soil_lut.dbf table 
for the watershed. The averages are transferred to 
the watershed attribute table during the 
parameterization process. 

 
Precipitation Components: KINEROS 
Precipitation-frequency grid (optional): A grid 

representing the accumulated depth for an event of 
a given return period for a region.  

 
dsgnstrm.dbf (optional): A table containing 

design storm parameters for southeastern Arizona. 
This table is used to generate precipitation files for 
the design storm option for KINEROS. 

 
raingage point theme (optional): A shapefile 

containing raingage locations. This file is used if 
generating distributed precipitation files for 
KINEROS. 

 
Precipitation event table (optional): A table 

containing precipitation information for each event. 
The file must correspond to a specific format (see 
KINEROS>Generating precipitation 
files>Multiple Gage Inputs for more information). 

 
Precipitation file (*.pre): This file contains time-

depth or time-intensity pairs for one or more 
raingage locations. These files can be created in 
AGWA (located in the project's rainfall directory) or 
can be created outside of AGWA if the correct 
format is followed (see the KINEROS 
documentation at 
http://tucson.ars.ag.gov/KINEROS for more 
information). 

 
Precipitation Components: SWAT 
unweighted precipitation file: This file contains a 

record for every day to be used in generating the 
file. The table must be formatted properly (see 
SWAT>Generating precipitation files for more 
information) and must include fields for each gage. 

 
Raingage point theme: A point theme for 

raingage locations. The attribute table must 
contain a gage identifier field with a field name 
other than ID and with values corresponding to 
those found in the unweighted precipitation file. 
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Thiessen polygons (optional): A polygon 
shapefile, generated by AGWA, containing the 
Thiessen polygons for a specific raingage theme. 

 
Thiessen-Watershed intersection (optional): A 

shapefile generated by AGWA to calculate the 
weighted average precipitation for each 
subwatershed. 

 
weights.dbf (optional): This file is created during 

the Thiessen polygon precipitation processing and 
can be found in the av_cwd directory. There is no 
need to modify this file. 

 
Precipitation file (*.pcp): A file containing the 

weighted average precipitation for each 
subwatershed or a uniform precipitation for the 
watershed for each day in the unweighted 
precipitation file. 

 
Temperature file (*.tmp): This file contains the 

maximum and minimum temperatures (in degrees 
Celsius) for each day in a given time period. This 
file is not created by AGWA and must be supplied, 
properly formatted, by the user. See the SWAT 
User’s Manual for more information. 

 
wgnfiles.dbf (required): A table containing the 

weather generator stations for the western United 
States. This table can be used to select the WGN 
file to use during SWAT simulation. 

 
Wgnpoints.shp (optional): A point theme 

containing point locations for weather generator 
stations in the western United States. This dataset 
can be used to select the WGN file to use during 
SWAT simulation. 

 
WGN files (*.wgn): These files contain weather 

generator data for SWAT. The information includes 
statistics for a number of parameters that SWAT 
uses to estimate missing temperature data and 
other climate inputs. WGN files are provided for 
each state and can be found in the state 
subdirectories of the datafiles directory. For more 
information, see the SWAT User’s Manual. 

 
swatpptfiles.dbf (required): This table maintains 

a record of SWAT precipitation files for each 
watershed. The table contains the full path to the 
precipitation file and the start and end dates of the 
files. 

 
Simulation Output Components 
Plane or subwatershed table: A dBASE file, 

named “p” + <simulation name>_<parameter file 

basename>_<precipitation file basename>.dbf 
(KINEROS) or “p” + <simulation name>.dbf 
(SWAT), containing the simulation summary 
values. This table must be in the project to view the 
results of a simulation. 

 
Channel table: A dBASE file, named “c” + 

<simulation name>_<parameter file 
basename>_<precipitation file basename>.dbf 
(KINEROS) or “c” + <simulation name>.dbf 
(SWAT), containing the simulation summary 
values. This table must be in the project to view the 
results of a simulation. 

 
Hydrograph outputs (KINEROS): Two dBASE 

files, <watershed name>_plane_sim.dbf and 
(watershed name>_channel_sim.dbf, containing 
the plane and channel outputs for each timestep in 
the simulation. These can be viewed sequentially. 

 
Subwatershed and Reach outputs (SWAT): 

Two text files (added to the project as tables), <sim 
name>_sbs.txt and <sim name>_rch.txt, containing 
the subwatershed and channel outputs for each 
timestep in the simulation. The timestep is based 
on the selected frequency, daily, monthly, or 
yearly, of the simulation. These can be viewed 
sequentially. 

 
HRU ouputs (SWAT): An additional table, 

<watershed name>_HRU_results.dbf, that contains 
subwatershed outputs for each HRU in each 
subwatershed for each time step. This table cannot 
be displayed through the GIS. 

 
Moving spatial data 
Spatial datasets should not be moved between 
directories using Microsoft Windows Explorer. 
These datasets generally consist of several files; if 
one of the files is omitted, the dataset is unusable. 
To transfer datasets, use the Manage Data 
Sources option from the View’s File menu. This 
function can be used to move watersheds and 
stream networks; however, to ensure compatibility 
with other AGWA projects, the ODB file must also 
be moved to the same directory as the watershed. 
The watershed will not be available in AGWA if this 
file cannot be located. We recommend moving 
AGWA datasets with the AGWA Datasets option 
(AGWA Tools>Manage AGWA Datasets). This 
option provides import and export functionality for 
all AGWA watersheds. 

 

Automated Geospatial Watershed Assessment Tool  23



Watershed Delineation and Discretization 
 
Watershed delineation is the first step in the 
process of using the AGWA tool. To delineate or 
discretize a watershed, go to AGWA 
Tools>Delineate watershed. This is used for both 
KINEROS and SWAT. This step requires that you 
enter the basic data types (described in File 
management>Required Files and Datasets) that 
are required to compute the watershed boundary 
and then divide the watershed into a series of 
planes or subwatersheds.  

 
Watershed information can be viewed at any 

time with AGWA Tools>View metadata. This 
information was previously (version 1.42c and 
earlier) stored in the watershed theme’s 
comments. 

 
Basic Concepts 

 
Stream Map 
The stream map is a theme containing all 

streams for a given DEM. It represents all cells in 
the DEM that receive runoff from a certain number 
of cells (Figure 6). This number is the threshold 
value for the map and represents the number of 
cells rather than an area or percent. The threshold 
for the stream map can be set to create a more or 
less complex network. The default value of 2500 is 
recommended for DEMs with a resolution of 30m; 
however, this default may be too coarse for higher 
resolution DEMs.  

 

 
Figure 6. AGWA-generated stream map 

(threshold = 2500). 
 
The stream map is used as a visual aid when 

locating outlet locations when creating an 
individual watershed (with the original AGWA 
process). It is also used by the area of interest 
delineation option to define the potential outlet 

locations – any outlet must fall along the stream 
map. 

 
Watershed Outline 
A watershed outline is the result of the 

delineation process. The boundary represents all 
cells of a given DEM that drain to the specified 
outlet location. An outline can be used to create 
watersheds for each model and for different 
complexities. Figure 7 shows an example of a 
watershed outline. 

 

 
Figure 7. Example of a watershed outline. 
 
Contributing Source Area (CSA) 
This value determines the level of geometric 

complexity in the discretized watershed. It is the 
threshold at which flow becomes channelized. 
Lower CSAs produce more watershed elements; 
higher CSAs, fewer elements (Figure 8). The 
default value is 2.5%, which produced the best 
results during preliminary analysis.  
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Figure 8. Differences in watershed complexity 

based on contributing source area. (Top) CSA = 
5%; (bottom) CSA = 2.5%. 

 
KINEROS Flow Length  
Flow length is length of the path from a source 

to a channel, as indicated by flow direction. AGWA 
offers two methods for calculating flow length of 
lateral planes in KINEROS. The default method 
assumes a geometric abstraction, where the plane 
is considered a rectangle with a length equal to the 
channel length of the associated stream and the 
width (or flow length) equal to the plane area 
divided by the channel length. This method must 
be used to add riparian buffers to a KINEROS 
watershed. 

 
The second method calculates the mean flow 

length of the plane element. Flow length is based 
on the following: 
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where L is the flow length, D is the flow length from 
cell i, and a is the area of cell i (Syed, 1999).  
 

The flow length of the source planes (any plane 
element ending with 1) is calculated the same for 
both methods. This calculation considers the 
source plane as a triangular abstraction, where 
flow length is 3/2 the distance between the plane 
centroid and the upstream node of the associated 
channel. Length is equal to the plane area divided 
by the flow length. See Figure 9. 

 

 
Figure 9. Geometric abstractions of KINEROS 

plane elements. 
 
The flow length method can be changed in 

AGWA Tools>Preferences. 
 
Hydraulic Geometry Relationships 
These relationships refer to bankfull hydraulic 

geometry relationships and they define the bankfull 
channel width and depth based on watershed size. 
Bankfull relationships are useful in that they define 
channel topography with minimal input and effort 
by the user; however, there are some drawbacks. 
The relationships are designed to be applied to 
very specific physiographic regions and outside of 
these regions the performance of the relationships 
in accurately depicting the channel geometries 
severely declines. Also, deriving relationships for 
specific regions is very labor intensive, requiring 
field work and analysis. At this time, only two 
relationships are defined: Walnut Gulch 
Experimental Watershed in southeastern Arizona 
(Miller, 1995) and the Coastal Plain of North 
Carolina (Sweet and Geratz, 2003). These 
relationships are provided in the HGR.dbf table as 
part of the AGWA datafiles download. See 
Advanced Options>Hydraulic Geometry for 
more information. 

 
Watershed and Stream parameters 
 
KINEROS Watershed  

WS# (WS_): watershed number 
Area: the area of the plane element in internal map 

units 
Slope: the zonal mean slope of the plane element 

in percent rise 
X Centroid: the X coordinate of the plane element's 

centroid 
Y Centroid: the Y coordinate of the plane element's 

centroid 
Width: the flow length of the plane element, based 

on a geometric abstraction or the mean flow 
length to the channel element 

Length: the length of the plane element, parallel to 
the channel 
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KINEROS Stream 
Stream# (Stream_): stream number 
Cont_chan: contributing element to the given 

stream (WS# or Stream#) 
Length: length of the channel element (in map 

units) 
Order: stream order of the channel element (1 = 

first order, 99 = higher order) 
Slope: channel slope derived from elevation of end 

nodes (percent rise) 
Down_width: downstream width of channel 

element (map units) 
Up_width: upstream width of channel elements 

(map units) 
Down_depth: downstream depth of channel 

element (map units) 
Up_depth: upstream depth of channel element 

(map units) 
Man: Manning roughness coefficient (0-1) 
SS1: bank slope side 
SS2: bank slope side 
Wool: indicates use of wetted perimeter function 
CV: coefficient of variation of Ksat 
Ksat: saturated hydraulic conductivity (mm/hr) 
G: mean capillary drive (mm) 
Dist: pore size distribution index  
Por: porosity (cm3/cm3) 
Rock: volumetric rock fraction 
Pct_clay: fractional clay content (0-1) 
Pct_silt: fractional silt content (0-1) 
Pct_sand: fractional sand content (0-1) 
SP: rainsplash coefficient 
COH: soil cohesion coefficient 
Sequence: integer values indicating channel 

sequence 
Area: upland and lateral areas contributing directly 

to the channel element (m2) 
Cum_area: sum of all upland and lateral elements 

contributing to the channel (m2) 
 
SWAT Watershed 

WS# (WS_): watershed number 
Area: area of the subwatershed (map units) 
Slope: zonal mean slope of the subwatershed 

(percent rise) 
Max_FlwLength: maximum flow length of the 

subwatershed (map units) 
 
SWAT Stream 

Stream# (Stream_): stream number 
Cont_chan: contributing element of the channel 

element (WS# or Stream#) 
Length: length of the channel element (map units) 
Order: stream order of the channel (1 = first order; 

99 = higher orders) 

Slope: channel slope derived from elevation of end 
nodes (percent rise) 

Sequence: integer values indicating channel 
sequence 

Area: upland area contributing directly to the 
channel (map units) 

Cum_area: sum of all areas contributing directly to 
the channel 

Swat_id: integer values for SWAT routing 
Storage_Loc: storage location number used in 

SWAT routing 
 
 

Watershed Delineation 
Several options are available for watershed 
delineation and discretization with AGWA. These 
options include: 

 
• Create a new watershed 
• Create a nested watershed 
• Create a watershed group 

o Multiple Outlet Locations 
o Area of Interest Delineation 

• Edit a watershed group 
o Append watersheds 
o Extract watersheds 
o Remove watersheds 

• Use existing watershed delineation(s) 
• Select subwatersheds from a SWAT 

watershed 
• Apply channel buffers to a KINEROS 

watershed 
 
To access these options, select AGWA 

Tools>Delineate watershed. In the Watershed 
Options dialog (figure 10), select the option that 
best suits your needs and click Continue. To use 
an existing watershed outline or create multiple 
watersheds, also select one of the two available 
choices. The relevant dialog is opened based on 
your selection. 
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Figure 10. Watershed Delineation and 

Discretization Options dialog. 
 

Create a new watershed 
This option generates a new watershed from a 

user-specified outlet and is divided into two steps – 
watershed delineation and watershed 
discretization. Before proceeding to the delineation 
process, the user must identify the raster surfaces 
to be utilized. These surfaces include a digital 
elevation model (DEM), a flow direction grid (FDG) 
and a flow accumulation grid (FACG). An 
additional surface, a stream map, is generated 
following the selection of these inputs to facilitate 
outlet location. The stream map represents all 
streams for a specific DEM. In previous versions of 
AGWA (1.4X and earlier), the threshold for these 
streams was set to a default of 2500, where all 
cells receiving runoff from at least 2500 cells are 
identified as streams. AGWA 1.5 allows users to 
adjust this threshold as the default threshold may 
not produce detailed enough networks for high-
resolution DEMs. Users can also select an existing 
stream map to use during outlet identification. See 
Figure 11. 

 

 

A 

B 

C 

D 

Figure 11. Watershed Delineation dialog. A) 
DEM Selection panel; B) Flow Direction Creation 
and Selection Panel; C) Flow Accumulation 
Creation and Selection panel; D) Stream Map 
Creation and Selection panel. 

 
First, select the DEM in the DEM Selection 

panel. If you have not already added a DEM to the 
view, you are given the option to do so here; 
otherwise, select the DEM from the combobox.  
Once a DEM is selected (it must be actively 
selected from the combobox), you are given the 
option of filling sinks with the Fill Selected DEM 
button. Sinks are isolated depressions in the 
elevation surface that can cause flow routing 
problems, and are common in USGS DEMs that 
have not been corrected. Click Accept to proceed. 

 
Then, select a flow direction (FDG) grid in the 

Flow Direction Creation and Selection panel. If an 
FDG for the selected DEM has not already been 
generated and added to the view, you must click 
the Create FDG button. Otherwise, select an FDG 
from the combobox (new FDG grids are added to 
the combobox upon successful generation). Click 
Accept to proceed. 

 
Select a flow accumulation (FACG) grid in the 

Flow Accumulation Creation and Selection panel. If 
an FACG for the DEM has not already been 
generated and added to the view, you must click 
the Create FACG button. Otherwise, select an 
FACG from the combobox (new FACG grids are 
added to the combobox upon successful 
generation). Click Accept to proceed. 
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Finally, select a stream grid in the Stream Map 
Creation and Selection panel. If you wish to use an 
existing stream map, select the Select an existing 
stream grid radio button. Select the stream map 
from the combobox and click Accept to proceed. If 
you wish to generate a new stream map, select the 
radio button for Create a new stream grid. The 
default value is set to 2500 cells, which is 
appropriate for 30m DEMs. Enter a new name for 
the stream map (8 character limit) and enter a 
threshold. Threshold values are based on the 
number of cells contributing runoff to a given cell. 
Click Accept to proceed. 

 
Once all of the selections have been made, 

click Continue. 
 
AGWA then directs you to the Watershed 

Outline dialog (figure 12). This dialog allows you to 
select a point location for the watershed outlet. 
(NOTE: to use multiple outlets, return to the 
Watershed Options dialog and select Create a 
watershed group>Multiple outlet locations.) 
Enter a name for the watershed outline to be 
created in the Watershed Outline Name panel and 
select a method for identifying the outlet in the 
Outlet Type Selection panel.  

 
Select a point from an existing theme – select a 
point theme in the view. Using the selection 
tool, select a point (User-defined Outlet panel). 
 
Interactively identify a point – using the click 
tool, click a location on the DEM to use as an 
outlet. Try to click near a stream (on the stream 
map). The location may be adjusted based on 
the point of highest flow accumulation within the 
specified radius (Point Location Selection 
panel). 
 
Provide XY coordinates – type in an X and Y 
coordinate pair to serve as the outlet. These 
values must be in the same coordinate system 
as the input grids and must intersect the 
selected DEM. It is the user's responsibility to 
provide appropriate XY coordinates. Click Go to 
continue (XY Coordinate Entry panel). 
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Figure 12. Watershed Outline dialog. A) 
Watershed Outline Name panel; B) Outlet Type 
Selection panel; C) User-defined Outlet panel; D) 
Point Location Selection panel; E) XY Coordinate 
Entry panel. 

 
Once you've located the outlet, AGWA will 

generate a watershed outline. AGWA determines 
the outlet based on the intersection of the specified 
point and the stream map and the available outlet 
locations within a given radius. Outlet locations that 
do not intersect the stream map may be moved to 
a suitable location on the stream map before 
watershed discretization occurs. The new outlets 
are generally at the lowest point within a radius of 
2.5 times the DEM cellsize of the specified outlet. 
Outlets that intersect the stream map will not be 
adjusted. If, at this time, the outline looks incorrect, 
you can cancel the process. If the outline is 
acceptable, AGWA proceeds to the Watershed 
Discretization dialog.  

 
Create a nested watershed 
A nested watershed contains regions of 

different complexity. These regions are identified 
by locating additional outlets upstream of the main 
watershed outlet and specifying different CSA 
values for each region. AGWA automatically 
identifies the main watershed outlet and any 
upstream breakpoints; the user only needs to 
provide a point theme containing all of the points 
with each point identified with an integer ID in the 
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attribute table. Figure 13 shows an example of a 
nested watershed. 

 

 
Figure 13. A nested watershed. The highlighted 

planes reflect the increased complexity of the 
region upstream of the internal breakpoint. 

 
The process for creating these watersheds 

begins in the same way as the process for creating 
a new watershed, with selecting the raster surfaces 
from the Watershed Delineation dialog. Once 
Continue is clicked, however, the user is directed 
to the Nested Watershed Delineation dialog to 
select the watershed outlet and internal 
breakpoints to be used during discretization. 
 

In the Nested Watershed Delineation dialog 
(Figure 14), select the point theme containing the 
outlet locations in the Outlet Selection panel. This 
theme does not have to contain any attributes to 
characterize an outlet as upstream to another – 
AGWA automatically identifies and processes 
those points. The point theme must contain an ID 
field, containing integer identifiers for each point. 
Select both the main outlet location and any 
internal (upstream) points to be used during 
delineation and discretization. Nested watersheds 
cannot be part of a watershed group; AGWA will 
terminate the processing if another source outlet is 
identified. To correctly generate the nested 
watershed, AGWA must delineate a watershed 
outline for each outlet. To retain these outlines for 
use later, check the Save datasets option and 
enter a name for the watershed outlines in the 
Save Dataset panel. This shapefile can be used to 
create another nested watershed or a watershed 
group of overlapping watersheds. Click Continue. 
If the delineation process is successful, AGWA 

opens the Multiple Watershed Discretization 
dialog. If the watersheds do not look correct, the 
process can be halted at this time. 

 

 

A 

B 

Figure 14. Nested Watershed Delineation 
dialog. A) Outlet Selection panel; B) Save Dataset 
panel. 
 

Create a Watershed Group 
A watershed group is a collection of AGWA 

watersheds, for either KINEROS or SWAT, that are 
discretized, parameterized and simulated as a unit. 
Each watershed in the group is numbered and 
parameterized as a normal AGWA watershed but 
is identified by a GROUP number to separate each 
watershed and by a GROUPID number to uniquely 
identify each element. 

 
Multiple outlet locations 
This option allows you to select two or more 

outlets from an existing point theme. First, select 
the point theme containing the outlets from the 
combobox on the Outlet Selection panel (Figure 
15). Use the selection tool to select the points to 
use. When selecting multiple points, it may be 
necessary to click on the selection tool more than 
once, especially if using the Shift key. To save the 
watershed outlines to reuse at a later time, check 
the Save datasets option and enter a name for the 
watershed outlines in the Save Dataset panel. 
Click Continue. If the delineation process is 
successful, AGWA opens the Multiple Watershed 
Discretization dialog. If the watersheds do not look 
correct, the process can be halted at this time. 
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Figure 15. Multiple Outlet Watershed 

Delineation dialog. A) Outlet Selection panel; B) 
Save Dataset panel. 

 
Area of Interest outlet locations 
This option dynamically locates outlets based 

on an area of interest boundary so that the 
boundary is completely covered by watersheds. 
This can be used to delineate watersheds for 
parks, ranches, urban developments, islands, etc. 
(Scott, 2005). 

 
 To use this option, you must create a polygon 

shapefile containing at least one boundary region. 
From the Area of Interest Delineation dialog 
(Figure 16), select the boundary theme in the 
Boundary Layer Selection panel. If the shapefile 
contains more than one polygon, use the selection 
tool to select the boundary of interest. Only one 
boundary can be used at a time. Next, define the 
analysis extent in the Analysis Extent Definition 
panel. This polygon limits the area within which 
AGWA will search for outlets. This is used both to 
reduce the potential size of the final watersheds as 
well as to exclude any regions that you do not wish 
to use during the process. See Figure 17 for an 
example of the boundary and analysis extent 
polygons. 
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Figure 16. Area of Interest Watershed 
Delineation dialog. A) Boundary Layer Selection 
panel; B) Analysis Extent definition panel; C) 
Stream Order grid Creation and Selection panel; 
D) Minimum Boundary Threshold Selection panel; 
E) Save Dataset panel. 

 
 
AGWA uses stream order to assist in the outlet 

location process. The stream order grid can be 
reused for other boundaries, so, in a method 
similar to that of the flow direction and flow 
accumulation grids, the stream order grid can be 
selected from existing grids in the view or created 
from the selected flow direction and flow 
accumulation grids in the Stream Order grid 
Creation and Selection panel. 

 
In some instances, the watersheds created to 

completely cover the watershed may not contribute 
significantly to the water balance of the area of 
interest. These watersheds may occupy only a 
small fraction of the boundary; the inclusion of 
these watersheds requires additional processing 
time that may not be beneficial. To exclude small 
watersheds, set the minimum area slider to a value 
greater than zero on the Minimum Boundary 
Threshold Selection panel. Setting this slider to 
zero will include all watersheds that intersect the 
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area of interest and have a valid outlet within the 
analysis extent. Any other value will ignore those  
watersheds that occupy less than the minimum 
size. First, select a range of percents, 0-0.1, 0-1, 0-
10 (all values in percent), and click Update. Drag 
the slider to the desired percent.  

 
To reuse the watershed outlines, check the 

Save datasets checkbox and enter a name for the 
outlines in the Save Dataset panel. Click 
Continue. 
 

 
Figure 17. Area of Interest Watershed 

Delineation results with a minimum area threshold 
of 0.2%. Several regions of the boundary were 
excluded from the delineation process due to this 
threshold. Note the placement of the original outlet 
locations and the final outlet locations. 
 

The process begins by locating potential outlets 
at the intersection of the boundary polygon and the 
stream network. Outlets are rejected if the stream 
flows into the boundary – these streams will be 
captured by another outlet, or if another outlet is 
identified downstream. Outlets are located at 75% 
of the distance from the start of the stream 
segment; if this falls within the boundary and 
another stream segment is not available 
downstream, the process fails. To avoid this, adjust 
the boundary.  

 
These initial outlets are adjusted based on the 

stream network. The next downstream segment is 
tested against the current outlet location – if it 
captures more streams that flow from the 
boundary, the current outlet is replaced and the 
next potential outlet is tested. The goal of this step 
is to locate outlets so that all of the streams within 
the boundary are accounted for with the fewest 

number of outlets possible given the constraints of 
the boundary and analysis extent. 

 
Once the outlets have been located, 

watersheds are delineated for each point. The 
union of these watersheds is compared against the 
boundary polygon. If gaps in the coverage exist, 
further processing is necessary. This processing 
involves moving outlets downstream one segment 
and testing that delineation, unioned with the 
existing delineations, against the boundary. If a 
stream segment is not found downstream or 
AGWA determines that the next downstream 
segment is a much larger tributary, a new outlet is 
located along the flow path from the midpoint 
between the two watersheds. If an area is smaller 
than the minimum threshold, the gap is ignored. 

 
If the watershed delineation looks correct, 

proceed to the Multiple Watershed Discretization 
dialog. 

 
Edit a watershed group 
Individual watersheds can be appended to an 

existing group, removed from a group or extracted 
from the group to be processed separately. 
Extracting a watershed does not affect the 
watershed group; it simply copies the selected 
watershed to a new shapefile to be modeled 
independently from the group. 

 
Parameterization information is discarded when 

a watershed is extracted or added to a group. The 
modified group or extracted watershed must be 
reparameterized before performing any 
simulations.  

 
Append watersheds 
To append a watershed, select the watershed 

group to be modified in the Group Selection panel 
(Figure 18). Only individual watersheds discretized 
for the same model and, if KINEROS, the same 
flow length method as the group can be appended. 
Select one or more individual watersheds to 
append from the Available Watershed List. Click 

the  button to add the selected watershed to 
the Selected Watershed List. To remove a 
watershed from the Selected Watershed List, 

select the watershed and click . The removed 
watershed will be added back in the available 
watershed list. Click Continue when satisfied with 
the selections. The selected watersheds will be 
added to the group and the metadata updated to 
reflect the modification. This option can also be 
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used to create a watershed group from existing 
watersheds. 

 
If appending a watershed to a KINEROS group 

or creating a new KINEROS group, the flow length 
method utilized during watershed discretization 
must be identical for all selected watersheds. This 
value can be checked with AGWA Tools>View 
Metadata under the “Flow length” parameter. 

 

 
Figure 18. Edit Watershed Groups dialog, 

Append Watershed Panel. A) Group Selection 
panel; B) Available Watershed List; C) Selected 
Watershed List. 

 
Remove watersheds 
To remove a watershed, select the watershed 

group (Figure 19). Select the group number and 
click Remove. The selected watershed will be 
deleted from the group's watershed and stream 
themes and the metadata updated. This option 
cannot be reversed. 

 

 
Figure 19. Edit Watershed Groups dialog, 

Remove Watershed panel. 

Extract watersheds 
To extract a watershed, select the watershed 

group (Figure 20). Select a group number from the 
combobox. Enter a name for the new watershed. 
Click Extract. The selected watershed will be 
copied into a new watershed; the associated 
stream network will also be copied. This watershed 
can then be simulated independently of the 
watershed group. It does not modify the original 
watershed group. 

 

 

A 
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Figure 20. Edit Watershed Groups dialog, 
Extract Watershed panel.  

 
Use existing watershed delineation(s) 
Watersheds can be re-discretized using an 

existing watershed outline or, in the case of a 
group, a set of watershed outlines. A watershed 
outline created in AGWA 1.5 has metadata, in the 
form of an ODB file, associated with it. This 
metadata contains the name of the DEM, flow 
direction, flow accumulation and stream grids used 
to create the file. These inputs should be located in 
the view but do not need to be selected again. The 
presence of this file is required to reuse an outline. 

 
First, select the type of outline you wish to use. 

Use an existing watershed grid is identical to the 
Use existing option from previous versions of 
AGWA. Click Continue to proceed to the 
Watershed Discretization dialog. When asked, 
select the watershed grid you wish to use. AGWA 
only considers watershed grids created with the 
provided delineator as valid watershed 
delineations.  

 
Use an existing watershed group allows you 

to reuse the delineated watersheds from a 
watershed group or nested watershed. 
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Delineations for a nested watershed can be used 
to discretize a watershed group or a nested 
watershed. To rediscretize a nested watershed, 
click Yes when queried; to discretize a watershed 
group from a nested watershed delineation, click 
No. This selection will not affect later 
discretizations. Click Continue to proceed to the 
Multiple Watershed Discretization dialog.  

 
 
Select a subwatershed from a SWAT 
watershed 
This option allows you to select a SWAT 

subwatershed to act as a watershed outline. In 
many cases, SWAT watersheds are used to 
identify problem areas on a watershed that can 
then be simulated at a more detailed level with 
KINEROS. This option is best suited to larger 
SWAT subwatersheds. 

 

 
Figure 21. Select a SWAT Subwatershed 

dialog. A) Watershed Selection and Name panel; 
B) SWAT Subwatershed Selection panel. 

 
To create a new watershed from a SWAT 

watershed, you must first create the SWAT 
watershed. Select the watershed from the 
combobox on the Watershed Selection and Name 
panel (Figure 21). Enter a name for the watershed 
outline. As before, this outline can be reused to 
create watersheds of different complexity. Using 
the select tool on the Subwatershed Selection 
panel, select one subwatershed from the 
watershed. The tool automatically extracts the 
appropriate outlet and creates a new watershed 
outline.  

 
Once the outline is created, AGWA proceeds to 

the watershed discretization dialog. Select the 
watershed options and contributing source area 
and click Continue. See Figure 22 for an example. 

 
Figure 22. Creating a watershed from a SWAT 

subwatershed. (left) The original SWAT watershed; 
(center) the selected SWAT subwatershed; and 
(right) the new KINEROS watershed. 
 

In some cases, the selected SWAT 
subwatershed does not produce a valid watershed 
configuration. Potential issues include failure to 
identify the outlet of the stream network (i.e. the 
network terminates at the junction of two 
channels), the inclusion of very small plane or 
channel elements that interfere with numbering or 
routing algorithms, and other numbering errors. 
These errors, particularly the outlet identification 
error, cannot be resolved by adjusting the CSA.  

 
Apply channel buffers to a KINEROS 
watershed A 

This option allows you to install channel buffer 
elements on an existing KINEROS watershed. 
Buffers can be added to any channel segment and 
can be one of three types: 

B  
• a buffer extending the length of the entire 

channel; 
• a buffer extending from one endpoint of the 

channel to an internal breakpoint; 
• and, a buffer falling between two internal 

breakpoints. 
 

The endpoints of the buffer element are identified 
by the user, as is the buffer width. Both lateral 
elements can be buffered; however, both sides 
must share the same endpoints (Scott, 2005). 
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Figure 23.  Apply Riparian Buffers to a 

KINEROS Watershed dialog. A) Watershed 
Selection and Name panel; B) Lateral Element 
Selection panel. 

 
Select the watershed to be buffered on the 

Watershed Selection and Name panel (Figure 23). 
Using the selection tool on the Lateral Element 
Selection panel, select one or more plane 
elements to buffer. Any plane that is not a zero 
order upland can be selected. Click Continue to 
proceed to the buffer geometry definition. The 
selection process is shown in Figure 24. 

 

 
Figure 24. Lateral element selection process. 

The buffer is defined for the channel associated for 
the selected element and will fall to the left or right 
of the channel depending on which lateral element 
is selected. 

 

 

B 

Figure 25. Buffer Geometry Specification dialog.  
 
Each selected plane element is listed in the 

table (Figure 25). Select a plane number to 
highlight the plane in the view. Double-click to 
enter a buffer width (Figure 26). The minimum 
buffer width is determined by the DEM resolution. If 
both lateral elements are selected, AGWA will ask 
twice for the buffer width, once for each lateral. 
These values do not have to be the same. The 
width will be added to the table.  

 

 
Figure 26. Buffer width specification. The width 

is set for the selected lateral element 
 
After setting the width, use the point tool to add 

the first endpoint. Clicking near the channel 
endpoint will set the buffer endpoint to the channel 
endpoint. Use the click tool again to set the other 
point. To buffer the entire segment, locate both 
points near the channel endpoints. Endpoints only 
have to be set once for each lateral pair. See 
Figure 27. Buffer endpoints do not have to fall 
directly on the stream; however, care should be 
taken to place the locations as close as possible. 
Again, endpoints within 10% of the length of the 
channel will be moved to the channel endpoint. 
Repeat for each selected plane (unless its lateral 
has already been set). Click Continue to create 
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the buffered watershed. Figure 28 shows the 
results of the buffering process. 

 
 

 
Figure 27. Buffer length specification. Using the 

point tool, click along the channel of the highlighted 
lateral element to place a buffer endpoint. This 
step must be performed twice for each lateral 
plane to be buffered.  

 

 
Figure 28. The new buffer elements. Note the 

increased complexity for the affected lateral 
planes. 

 
To create the buffer, AGWA performs one of 

two processes: for whole channel buffers, AGWA 
simply splits the lateral element to achieve the 
desired buffer width; for any buffer with one or 
more internal breakpoint, AGWA must rediscretize 
that plane element and its lateral so that the proper 
routing can occur. Whole channel length buffers do 

not affect the watershed or stream numbering 
other than the assignment of a watershed number 
to the buffer element. If the plane must be 
rediscretized, the most upstream elements retain 
the original plane and channel numbers while the 
new elements are numbered based on the next 
available value (Figure 29). Buffers are numbered 
according to their upland and stream elements. If 
the upland plane number is odd, the buffer number 
ends in 5; if even, it ends in 6. These values are 
reserved for buffer elements. Plane and channel 
parameters are recalculated following successful 
buffer creation. 
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Figure 29. Buffer numbering schematic for 

lateral watersheds 12 and 13. (a) Entire reach 
buffer (buffer  = 16); (b) Buffer a reach segment 
terminating at a reach endpoint (buffer = 15); and 
(c) Buffer an interior reach segment (buffer = 26). 

 
In some cases, AGWA cannot create buffers at 

the specified locations. Failures can be due to 
ArcView issues, including errors converting the 
new watershed grid or errors generating the 
watershed grid. Should this occur, it is unlikely that 
adjusting the buffer endpoints for that channel will 
resolve the issue; however, whole channel length 
buffers can always be created for those plane 

elements. Other errors generally involve splitting or 
numbering errors. These errors may be resolved 
by relocating the endpoints. Again, whole channel 
length buffers can always be generated. Analysis 
of these errors indicates that, in general, buffer 
creation fails approximately 8% of the time, with 
50% of those errors related to ArcView issues 
(Scott, 2005). 

 
Flow length must be adjusted to reflect the new 

configuration of the selected plane element. 
Adjustments are based on the proportion of the 
new element to the original plane and assumes a 
rectangular abstraction of the planes (Woolhiser et 
al., 1990). For planes not flowing directly onto a 
buffer, the new width is 

 

orig

n

FL
PA

W
)%*(

=  

 
where W is the width, A is the area, %Pn the 
percent of the original plane area occupied by the 
new plane, and FLorig is the original flow length. 
The  new flow length is 

 

origFLFL =  
 

For upland planes (flowing directly onto a buffer 
element), the new width is 
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W
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=  

 
where %Pup is the percent of the original plane 
area occupied by the upland plane and %B is the 
percent of the original plane occupied by the buffer 
element. The flow length for upland planes 

 

W
PA

FL up%*
=  

 
The buffer flow length is always set to the specified 
buffer width. 

 
Watershed Discretization 

 
Individual watersheds 
Discretization options for individual watersheds 

can be found on the Watershed Discretization 
dialog (Figure 30). The user can choose from a 
number of options to modify the internal watershed 
boundaries. These options incorporate different 
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kinds of internal breakpoints to split planes and 
channels in specific locations. Available options 
include internal gages, ponds or reservoirs, non-
releasing ponds and no breakpoints. If the option 
involves using internal breakpoints, AGWA will 
open the Point Selection dialog (see Watershed 
Discretization>Internal Breakpoints: Gages, 
Ponds and Reservoirs for more information). 

 

 
Figure 30. Individual Watershed Discretization 

dialog. A) Watershed Name panel; B) Model 
Selection panel; C) Contributing Source Area 
Selection panel; D) Internal Breakpoint Selection 
panel; E) CSA Enforcement Selection panel. 

 
Enter a watershed name in the Watershed 

Name panel. This name is limited to 4 characters 
in length. Two new shapefiles will be created for 
the watershed – a stream network named “s” + the 
entered name and a discretized watershed named 
“w” + the entered name. Click Accept to continue. 

 
Select a model for the discretized watershed in 

the Model Selection panel. KINEROS and SWAT 
require different parameters and routing conditions, 
so watersheds discretized for one model cannot be 
used for the other. 

 
Enter a contributing source area value as either 

a contributing area (in acres or hectares, 
depending on the selected units) or as a percent of 
the watershed in the Contributing Source Area 
Selection panel. Changes to one value will 
automatically update the other. Click Accept. 

 
Select an internal breakpoint option from the 

Internal Breakpoint Selection panel. To not use 
internal breakpoints, select None. To discretize the 
watershed with internal gages, select Use internal 
gages. To use either KINEROS ponds or SWAT 

reservoirs, select Use ponds (releasing). To use 
non-releasing ponds to exclude regions of the 
watershed, select Use ponds (non-releasing). 
See Watershed Discretization>Internal 
Breakpoints: Gages, Ponds, and Reservoirs for 
more information. Users can also choose to 
enforce the specified CSA for lateral elements in 
the watershed using the checkbox on the CSA 
Enforcement Selection panel. See Watershed 
Discretization>CSA Enforcement for more 
information. Click Continue to discretize the 
watershed. A 

 
CSA Enforcement B 
In some instances, ArcView may discretize 

subwatersheds that exceed the specified CSA 
value. The Enforce CSA option allows users to 
automatically place internal breakpoints to split any 
lateral elements that exceed the specified CSA 
(this option only affects planes with an area greater 
than 1.85 the specified CSA). When this occurs, 
AGWA will determine new breakpoints within that 
element based on the flow accumulation and the 
specified CSA. Processing begins at the upstream 
node of the channel and proceeds downstream. 
No breakpoints are added within 10% of the 
channel length of the downstream node. The 
breakpoints cannot be modified by the user during 
processing. Figure 31 compares a SWAT 
watershed before and after discretization with the 
CSA Enforcement option. 

C 

D 

E 

 

 
Figure 31. Results of CSA enforcement. (left) 

SWAT watershed discretized with 3.2% CSA; 
(right) SWAT watershed discretized with 3.2% CSA 
and with CSA Enforcement. Note the increased 
complexity in the center of the watershed. 

 
 
Multiple or nested watersheds 
Watershed discretization for watershed groups 

or nested watersheds is similar to that for individual 
watersheds. It does not, however, support internal 
breakpoints for either watershed type. Please note 
that due to the delineation process, the boundaries 
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for both the delineation and the internal plane 
elements will be slightly different from those 
generated if using the same outlet for an individual 
watershed. Watershed parameters will also be 
slightly different. AGWA provides a tool to extract 
an individual watershed from a group should 
further analysis of an individual watershed be 
warranted. 

 
The discretization process is the same for 

watershed groups created with area of interest 
boundaries or with multiple outlet locations. AGWA 
displays each watershed in the listbox 
(Contributing Source Area Entry panel) by a unique 
identifier in the Multiple Watershed Discretization 
dialog (Figure 32). To locate a watershed in the 
view, select a record in the listbox. The selected 
watershed with be highlighted. To set the CSA for 
that watershed, double-click in either the 
Contributing Area column or the % of Watershed 
column to enter a value. CSA can be set for either 
a percent of the watershed or a contributing area 
(with area in the selected units). The other value is 
automatically calculated. Because the watershed 
delineations can vary greatly in size, a CSA must 
be entered for each watershed.  

 
The Nested column contains information 

regarding the type of outlet used to delineate each 
watershed in the group. If Nested is FALSE, the 
watershed used a main outlet and does not 
represent an upstream region of another outlet. If 
Nested is TRUE, the selected watershed 
represents an upstream region of a main outlet. 
This parameter cannot be modified. 

 
Select a model for all of the watersheds in the 

group from the Model Selection panel. 
 
Finally, enter a name for the watershed group 

on the Watershed Name panel. Click Continue to 
discretize the group. 

 

 

A 

B 

C 

Figure 32. Multiple Watershed Discretization 
dialog. A) Contributing Source Area Entry panel; B) 
Model Selection panel; C) Watershed Name panel.  

 
Temporary watershed and stream network 

shapefiles are created for each watershed in the 
group. These are parameterized separately and 
merged into one watershed network and one 
stream network shapefile once the 
parameterization has been completed successfully 
for all watersheds in the group. To avoid any 
attribution errors in other AGWA processes, the 
group contains two additional identifiers for both 
watershed and stream – a GROUP number that 
identifies which group the element belongs to, and 
a GROUPID number that serves as a unique ID. 
The GROUP number is also used to identify the 
watershed metadata for each watershed in the 
group. The GROUPID is used to associate 
landcover and soils tables as well as results tables 
to the watershed and stream network. Figure 33 
shows an example of a discretized watershed 
group. 
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Figure 33. Discretized watersheds for a 

watershed group. 
 

Nested watersheds not part of a group are 
numbered and parameterized as an individual 
watershed. These datasets will not contain 
GROUP or GROUPID values. 

 
Internal Breakpoints: Gages, Ponds, and 
Reservoirs 
AGWA provides several options for defining 

internal breakpoints in a watershed. These options 
include internal gages, KINEROS ponds, SWAT 
reservoirs and non-releasing ponds. Internal gages 
are used to split planes at specific locations to 
compare model estimates with observed discharge 
values. KINEROS ponds and SWAT reservoirs are 
water storage elements. Non-releasing ponds 
indicate regions of the watershed that will be 
excluded from the simulation process. 

 
The selection process for the breakpoints is the 

same for each option. In the Point Selection dialog 
(Figure 34), select the point theme from the Point 
Theme Selection panel. Use the selection tool on 
the Point Selection panel to select the points to be 
used. If the selected option is KINEROS ponds, 
SWAT reservoirs, or non-releasing ponds, select 
the point theme ID field from the list provided. This 
value will be used to identify pond locations for 
data input during later processing steps. Click OK 
to continue. 

 
 

 

A 

B 

Figure 34. Point Selection dialog. A) Point 
Theme Selection panel; B) Point Selection panel. 

 
Internal breakpoints increase the potential for 

error during watershed discretization. To reduce 
this potential, make sure that the point theme is in 
the same projection as the input grids and that the 
points are not in close proximity with each other or 
stream junctions (ponds or reservoirs close to the 
junctions are not used to modify the watershed 
configuration). Adjusting the point location and the 
CSA may resolve the errors. 

 
Internal Gages 
Internal gages are used to split the watershed 

and stream network at specific locations. This 
makes it possible to compare measured and 
estimated runoff at a point or series of points.  

 
Points should be located within 100 meters of 

the stream network to ensure successful snapping. 
The points cannot be located within 10% of the 
channel length of a junction or within 5 cells (based 
on the DEM resolution) of each other. If AGWA 
detects points within these tolerances, they will be 
ignored. 

 
Note that the presence of gages can result in 

improper watershed configurations, including 
unsplit KINEROS planes, misnumbered planes and 
orphaned stream segments. AGWA contains 
several checks for various errors but the user 
should inspect the final watershed carefully before 
proceeding.  

 
KINEROS Ponds 
Ponds are created in a manner similar to that of 

internal gages; however, if a pond is too close to a 
junction, the proper location is assumed to be the 
junction and the correct routing should occur.  

 
Additional parameters are required when 

simulating ponds in KINEROS. AGWA will prompt 
you to locate this file during parameter file 
generation. These parameters should be contained 
in an comma-delimited text file that describes the 
rating curve for the pond. The file may contain 
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parameters for more than one pond, and must 
have the following formatting: 

 
ID, STOR, NUM 
Volume, Discharge, Surface Area 
... 
... 
Volume, Discharge, Surface Area 
ID, STOR, NUM 
Volume, Discharge, Surface Area 
... 
... 
Volume, Discharge, Surface Area 
  
Example: 
1, 0, 4  <--------------ID, STOR, NUM 
0.00, 0.00, 24959.11 
3833.24, 0.49, 25345.83 
... 
... 
28090.92, 1.31, 277728.55 
2, 0, 8  <--------------ID, STOR, NUM 
0.00, 0.00, 24959.11 
3833.24, 0.49, 25345.83 
... 
... 
28090.92, 1.31, 27728.55   
 

with NUM number of lines per each pond ID 
containing volume in m3, pond outflow discharge in 
m3/s, and pond surface area at each volume in m2. 
STOR is the initial pond storage volume in m3. 
Each ID from the pond point theme used during 
the delineation process must have a set of entries 
in the text file. The formatting requirements are 
very specific, so the user should make an effort to 
follow the above format as closely as possible. 

 
Note that it is possible for pond elements to be 

overwhelmed. This occurs when rainfall and runoff 
entering the pond element exceeds the volume 
and capacity of the pond element, as specified in 
the pond input file. This error may be hard to 
detect, because it may appear that KINEROS runs 
to completion when, in reality, it failed on the pond 
element. If AGWA does not regain control after a 
KINEROS run using ponds or if results are not 
properly imported, KINEROS failed. To fix this 
problem, increase the rating table for the pond by 
adding more values to the pond input text file. 

 
SWAT Reservoirs 
A SWAT reservoir is similar to a KINEROS 

pond in that the reservoir lies on a channel 
segment. A second water storage element is 
available in SWAT, ponds, but these are not 

supported by AGWA. Ponds are water storage 
locations within a subwatershed and do not affect 
watershed discretization. Reservoirs are created in 
a manner similar to that of internal gages; 
however, if a reservoir is too close to a junction, 
the proper location is assumed to be the junction 
and the correct routing should occur. A channel 
can only contain one reservoir in AGWA due to the 
discretization process. 

 
Reservoir input files are defined through the 

SWAT Reservoir Input dialog (Figure 35). Once the 
watershed has been successfully discretized 
AGWA will display the dialog. Locate the main 
input data file using the Browse button on the 
Input File Selection panel. Click Accept to 
continue. 

 
Select an Outflow Simulation Code from the 

Outflow Simulation Code Selection panel. Each 
code requires a specific input format as outlined 
below. Click Process to parameterize the 
reservoirs. 

 

 

A 

B 

Figure 35. SWAT Reservoir Input dialog. A) 
Input File Selection panel; B) Outflow Simulation 
Option Selection panel. 

 
The input files regardless of the Outflow 

Simulation Code must contain the following values 
in this order on ONE line: 

 
ID, MORES, IYRES, ESA, EVOL, PSA, PVOL, 
VOL, SED, NSED, K, FLOWMX1, FLOWMX2, 
FLOWMX3, FLOWMX4, FLOWMX5, 
FLOWMX6, FLOWMX7, FLOWMX8, 
FLOWMX9, FLOWMX10, FLOWMX11, 
FLOWMX12, FLWOMN1, FLOWMN2, 
FLOWMN3, FLOWMN4, FLOWMN5, 
FLOWMN6, FLOWMN7, FLOWMN8, 
FLOWMN9, FLOWMN10, FLOWMN11, 
FLOWMN12 
 

where ID is the point theme identifier; MORES is 
the month the reservoir became operational; 
IYRES is the year the reservoir became 
operational (if either MORES or IYRES is 0, SWAT 
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assumes the reservoir is operational at the start of 
the simulation); ESA is the reservoir surface area 
when filled to the emergency spillway (ha); EVOL 
is the volume of water needed to fill the reservoir to 
the emergency spillway (104m3); PSA is the 
reservoir surface area when filled to the principal 
spillway (ha); PVOL is the volume of water needed 
to fill the reservoir to the principal spillway (104m3); 
VOL is the initial reservoir volume (104m3); SED is 
the initial sediment concentration (mg/L); NSED is 
the equilibrium sediment concentration (mg/L); K is 
the hydraulic conductivity of the reservoir bottom 
(mm/hr); FLOWMX1-12 is the maximum daily 
outflow for the month (m3/s); and FLOWMN1-12 is 
the minimum daily outflow for the month (m3/s). For 
FLOWMX and FLOWMN, you may set all months 
to zero if you do not want to trigger this 
requirement. 

 
Additional input values required for each of the 

outflow simulation options are listed below. These 
inputs must appear immediately after the inputs 
listed above on the same line. It is important to 
note that all data associated with an ID is located 
on one line. 

 
Outflow Simulation Code 0: 
RR, the average daily principal spillway release 

rate (m3/s). The following example is a reservoir 
with a point theme ID of 2. 

 
2,0,0,2444,17269,1445,6772,6772,350,350,0.0
8,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,10
00 
 
Outflow Simulation Code 1: 
RESMONO, the full path name of the text file 

containing monthly outflow data. The following 
example is a reservoir with a point theme ID of 2. 

 
2,0,0,2444,17269,1445,6772,6772,350,350,0.0
8,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0, 
1000, c:\agwa\projects\agwa_proj\reservoir.txt 
 
This monthly outflow data file is separate from 

the reservoirs input text file. It must be in the 
following format (comma-delimited): 

 
Line 1: can contain anything less than 80 
characters in length (not used by SWAT) 
Each line after contains the monthly values for 
one year of the simulation. 
Ex: for reservoir #5 
0.0,0.0,0.0,0.0,0.0,0.0,0.0,0.0,0.0,0.0,0.0,0.0 
 
 

Outflow Simulation Code 2: 
 
FLOD1R, FLOD2R, NDTARGR, STRAG1, 
STRAG2, STRAG3, STARG4, STARG5, 
STARG6, STARG7, STARG8, STARG9, 
STARG10, STARG11, STARG12 
 

where FLOD1R is the beginning month of non-
flood season; FLOD2R is the ending month of non-
flood season; NDTARGR is the number of days 
required to reach target storage from current 
reservoir storage; STARG1-12 is the monthly 
target reservoir storage (104m3). The following 
example is a reservoir with a point theme ID of 2. 
 

2,0,0,2444,17269,1445,6772,6772,350,350,0.0
8,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,7,
12,90,6772,6772,6772,6772,6772,6772,6772,6
772,6772,6772,6772,6772 
 
Outflow Simulation Code 3: 
RESDAYO, the full path name of the text file 

containing daily outflow data. The following 
example is a reservoir with a point theme ID of 2. 

 
2,0,0,2444,17269,1445,6772,6772,350,350,0.0
8,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0, 
1000, c:\agwa\projects\agwa_proj\reservoir.txt 
 
This daily outflow data file is separate from the 

reservoirs input text file. It must be in the following 
format: 

 
Line 1: can contain anything less than 80 
characters in length (not used by SWAT) 
Each line after contains the daily outflow value. 
There should be one line of data for each day of 
the simulation. 
 
Data from the reservoir input text file is placed 

in a dBASE formatted table in the AGWA project. 
The structure of this table varies depending on the 
selected outflow simulation code and follows the 
same order as the input text files. This table can be 
edited; however, the outflow simulation codes 
cannot be changed. When the user opts to run the 
simulation, AGWA looks for the pond theme (“p” + 
watershed name) in the view. If it is located, 
AGWA writes the reservoir elements to the routing 
file (.fig) and writes the reservoir data files (.res, 
which contains all of the reservoir data; .lwq, which 
derives no user inputs from AGWA – these files 
contain the water quality data and can be modified 
in a text editor; and the daily or monthly outflow 
files (for codes 1-3)). See the SWAT User's 
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Manual for more information regarding required 
inputs and formats for the reservoir data files.  

 
Non-releasing Ponds 
Non-releasing ponds do not allow any 

discharge from any upstream element to flow past 
that point. All upstream elements are removed 
from the watershed. No additional information is 
required. 

 
Setting the hydraulic geometry relationship 
If the default hydraulic geometry has not been 

set (see Advanced Options>Hydraulic 
Geometry), AGWA will ask the user to select from 
two options. The first option uses the AGWA 
default hydraulic geometry relationship for Walnut 
Gulch; the other allows users to select from a 
different relationship in the HGR.dbf or define a 
new relationship. The second option should only 
be used by those familiar with the watershed to be 
modeled. 
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Landcover and Soils Parameterization

 
 

Before running KINEROS or SWAT simulations for 
your watershed, hydrologic parameters must be 
derived from the landcover and soils data. Each 
model requires a different set of parameters. 
Landcover datasets must be in raster format; soil 
datasets must be in vector format. 

 
KINEROS Parameters 

Int: interception depth (mm) 
Cover: fraction of surface covered by intercepting 

cover – the rainfall intensity is reduced by this 
fraction until the specified interception depth 
has been accumulated (0-1) 

Mann_n: Manning roughness coefficient (0-1) 
Pave: fraction of surface covered by erosion 

pavement (0-1) 
Splash: Rainsplash coefficient (0-1) 
Rock: Volumetric rock fraction, if any. If Ksat is 

estimated based on textural class, it should be 
multiplied by (1- rock) to reflect this rock 
volume. 

Ks:Saturated hydraulic conductivity (mm/hr) 
G: mean capillary drive – a zero value sets the 

infiltration at a constant value of Ks (mm) 
Por: porosity (cm3/cm3) 
Smax: maximum relative saturation (0-1) 
Cv: coefficient of variation of Ks 
Fract_sand: fractional sand content (0-1) 
Fract_silt: fractional silt content (0-1) 
Fract_clay: fractional clay content (0-1) 
Dist: pore size distribution index. Used for 

redistribution of soil moisture during unponded 
intervals 

Coh: Soil cohesion coefficients 
Ks_final: area-weighted Ks value 
Pct_imperv: percent of watershed covered by 

impervious materials 
 
SWAT Parameters 

CN: area-weighted curve number based on soil 
type and landcover 

Cover: fraction of surface covered by intercepting 
cover – rainfall intensity is reduced by this 
fraction until the specified interception depth 
has been accumulated (0-1) 

HydValue: weighted hydrologic group value used 
to determine curve number 

Ks: saturated hydraulic conductivity (mm/hr) 
Soil_id: value of the soil ID field (MUID, MUKEY or 

SNUM) of the dominant soil type 
 

Additional soil parameters are included in the 
<watershed name>_soil_lut.dbf. This table 
contains values for each layer in each soil 
component found in the watershed. 

 
The parameterization process requires the 

provided kin_lut.dbf table (Figure 36). These 
parameters were derived from the KINEROS 
manual (1990) and Rawls et al. (1982). The table 
is used to obtain the necessary soil parameters not 
found in the soils databases. Several soil 
parameters are modified by AGWA to avoid errors 
or improve estimates.  

 
The textures listed in the table refer to soil 

textures found in STATSGO and SSURGO soil 
components (U.S.D.A., 1994; U.S.D.A., 1995). 
Several additional textures were added to 
accommodate the FAO soils dataset. The soil 
parameters include 

 
KS: Saturated hydraulic conductivity (mm/hr) 
G: Net capillary drive (mm) 
Por: porosity (cm3/cm3) 
Smax: Maximum relative soil saturation (0-1) 
Cv: Coefficient of variation of KS 
Sand: Fractional sand content (0-1) 
Silt: Fractional silt content (0-1) 
Clay: Fractional clay content (0-1) 
Dist: Pore size distribution index 
Kff: soil erodibility factor (0-1). 
 

 
Figure 36. The kin_lut.dbf. 
 

 
Landcover 
Weighted hydrologic parameters are derived from 
landcover data in conjunction with a lookup table. 
Each lookup table is related to a specific type of 
landcover through the landcover classification 
number (the value of the grid cell). AGWA provides 
several lookup tables, including NALC, MRLC, 
SWGAP, NY, and MRLC_FIRE. All values found in 
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the landcover raster must be found in the selected 
lookup table. 

 
The SWGAP land cover map uses a more 

detailed classification system than the other land 
cover maps used in AGWA. Since hydrological 
properties are not available for these detailed 
classes, whenever possible, each SWGAP land 
cover type was given a value matching a land 
cover type from the National Land Cover Data 
(NLCD) set to obtain the hydrologic properties for 
the models The remaining SWGAP land cover 
types were given a NLCD value based on the 
larger ecological system they were in.  

 
AGWA provides fire assessment capabilities 

using the Burn Severity option in the Landcover 
Modification Tool and the provided MRLC_FIRE 
landcover lookup table. The table contains MRLC 
parameters modified to reflect field observations 
for three classifications (Canfield and Goodrich, 
2005). See Advanced Options>Landcover 
Modification Tool>Analyze an area with a burn 
severity map for more information. 

 
Landcover parameters are area-weighted 

averages based on the landcover types within 
each plane or subwatershed. Using the ArcView 
TabulateArea feature, AGWA calculates the 
proportion of each landcover type within a plane. 
These values are then used with the relevant 
parameter from the selected lookup table to 
determine the average value for the plane or 
subwatershed. 

 
In some cases, a landcover surface will contain 

values that do not correspond to a recognized 
landcover, such as “Clouds” or “Water”. This 
classification indicates an area with no landcover 
data and is usually accompanied by a 
corresponding record in the landcover lookup table 
with all hydrologic soil group (A, B, C, D) values set 
to zero or to 100. Any landcover with all 
parameters set to zero or with all hydrolgoic soil 
group values to 100 will be excluded from the 
normal area-weighting process and from the HRU 
parameterization process. 

 
KINEROS 
Landcover parameters for KINEROS are area-

weighted averages based on the intersection of the 
watershed with the landcover raster. Four 
parameters are required: cover, interception, 
Manning's N, and percent impervious. The 
averages are written to the watershed attribute 
table. 

SWAT 
Landcover parameters for SWAT are based on 

the landcover intersection and the average 
hydrologic soil group as determined by soils 
parameterization. Derived parameters include 
hydrologic soil group and KS. KS is based on the 
soil texture of the first soil layer and the kin_lut 
table values. The parameters are written to the 
watershed attribute table.  

 
Hydrologic Response Units 
AGWA 1.5 supports SWAT hydrologic response 

units (HRU). An HRU is a region within a 
subwatershed that, as defined by AGWA, has 
unique landcover attributes. HRUs are not 
identified spatially within the watershed nor do the 
HRU elements interact during simulation. Each 
HRU is simulated independently before estimates 
are summed for the subwatershed. See the SWAT 
User’s Manual for more information. 

 
To use HRUs, users must include a CROP, 

URBAN, and URBANLU field in the landcover 
lookup table. CROP contains the class code (the 
integer value preceding the name) from the 
crop2000.dat file. See Advanced 
Options>Preferences>SWAT DAT Defaults for 
more information regarding the default 
crop2000.dat file. URBAN contains the urban 
simulation code used in the HRU file. The value 
must correspond to one of the following values: 

 
0: no urban sections in the HRU 
1: urban sections in the HRU simulated using 

USGS regression equations 
2: urban sections in the HRU simulated using 

build up/wash off algorithms 
 
The URBANLU field contains the urban land 

use identification number from the urban2000.dat 
file. If the URBAN value is greater than 0, the 
URBANLU value must also be specified. Urban 
processes override plant growth processes in an 
HRU, so the CROP value is not utilized if URBAN 
is greater than 0.  

 
The HRU process creates a second landcover 

table called <watershed name>_HRUs.dbf. This 
table contains the areas of each landcover class 
found in each subwatershed. The table is required 
to use HRUs for a given watershed in a SWAT 
simulation. See SWAT>Inputs and Execution for 
information regarding HRU simulation. 

 
The CROP, URBAN, and URBANLU values can 

be edited using the SWAT DAT preferences. Go to 
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Advanced Options>Preferences to edit any 
landcover table based on values in the default DAT 
files. These values can be added to the tables or 
existing values can be modified.  

 
Default CROP values 
This option allows users to specify CROP 

values for each landcover class in the landcover 
lookup table. These values should be set based on 
the default CROP file. If the user wishes to use 
default crop values, all affected parameters will be 
set using the Range Brush (16) crop type; 
otherwise the values will be based on the CROP 
values set in the lookup table. The CROP value for 
the subwatershed is set to the CROP value of the 
dominant landcover within the subwatershed. 
These values can be modified during the SWAT 
initialization process if Nitrogen and Phosphorus 
Modeling is selected (this step does not require 
additional information). 

 
See Advanced Options>Preferences>SWAT 

DAT Defaults or SWAT>Inputs and 
Execution>Nitrogen and Phosphorus Modeling 
for more information. 

 
Custom Lookup Tables 
Any landcover classification can be used with 

AGWA if the user supplies the properly formatted 
lookup table. The lookup table must be keyed to 
the landcover raster by a CLASS field with a record 
for each value in the landcover raster. To use the 
Landcover Modification Tool (see Advanced 
Options>Landcover Modification Tool) or to use 
with a buffered watershed, the table must also 
have a NAME field. Other required fields include 
Percent Cover, Interception, Manning's N, Percent 
Impervious, and curve numbers for hydrologic 
groups A, B, C, and D. Figure 37 shows an 
example lookup table. 

 

 
Figure 37. Example landcover lookup table for 

the MRLC classification scheme. 
 

Soils 
AGWA supports three soils datasets – STATSGO, 
SSURGO, and FAO. Example datasets for each 
soil type are provided in the AGWA gisdata and 
datafiles download.  

Soils Datasets 
STATSGO 
STATSGO datasets are identified by the MUID 

field in the soil theme's attribute table. Datasets will 
not be recognized by AGWA without this field.  

 
STATSGO soil types are identified by an MUID 

(map unit ID) field. For each MUID, there are 
predefined components that describe the spatial 
variation within a particular soil type. For instance, 
there may be three components associated with 
MUID AZ061 (see Figure 38). Each component 
occupies a certain percentage of the larger soil 
type (MUID); the component percentages must 
sum to 1. Component information is stored in a file 
called comp.dbf for each state in the United States. 
A component is composed of different layers. 
Layer information is stored in the layer.dbf file for 
each state.  

 

AZ061

Components for AZ061 

 
 
Figure 38. STATSGO structure. 
 
SSURGO 
SSURGO datasets are identified by the MUKEY 

field in the soil theme's attribute table. Datasets will 
not be recognized by AGWA without this field.  

 
Like the STATSGO dataset, the SSURGO 

dataset is composed of components and horizons 
(i.e. layers). See Figure 39. A similar weighting 
process is used for this dataset. 

 

AZ067
AZ076
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Component 3 
(20%) Layers for Component 1 

Layer 1 2” 
Component 2 

(45%) Layer 2 2” 
9” 

Layer 3 
 
 

5”
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Figure 39. SSURGO Structure. 
 
In some cases, the SSURGO tables will not 

correspond to the correct formatting required by 
AGWA. If an error occurs, double-check the 
formatting of the SSURGO dataset being used. 
The correct formatting can be found in the 
SSURGO Access database (version 2000) 
provided in the AGWA gisdata\ssurgo_tables 
directory. The fields in the component, chorizon, 
and chtexgroup tables in the user-provided 
SSURGO database should correspond to those in 
the provided AGWA database. The number and 
order of the fields must match those in the 
provided SSURGO database for soil processing to 
be successfully performed. 

 
It is important that the SSURGO dataset 

extends beyond the watershed boundary. Voids in 
this coverage can lead to failure during 
parameterization or during SWAT simulation of the 
watershed. Previously this condition halted the 
parameterization process and required 
manipulation of the spatial dataset to correct. Now, 
a dedicated SSURGO tool is included with AGWA 
that allows users to remove internal voids, to 
extend the dataset beyond a given watershed and 
to merge spatial and tabular datasets (see 
Advanced Options>SSURGO Tool). Users are 
strongly encouraged to use the provided tool when 
editing SSURGO datasets. 

 
FAO 
FAO datasets are identified by the SNUM field 

in the soil theme's attribute table. Datasets will not 
be recognized by AGWA without this field. To use 
the dataset, first reproject the dataset to a 
geographic projection with decimal degrees and 
then to UTM or some other projection with units in 
meters.  

 

The FAO datasets and tables were obtained 
either from the Food and Agriculture Organization 
of the United Nations (FAO/UNESCO, 2003) Soil 
Map of the World CD-ROM, or from C.A. Reynolds 
research (Reynolds et al., 1999).  

55044 

Components for 55044 

 
To use FAO soils in AGWA, several 

modifications were made. FAO soils are classified 
into three broad soil texture categories: coarse, 
medium, and fine; however, the kin_lut.dbf uses 
textures based on the USDA soil texture triangle. 
All FAO soil units in the tables were assigned one 
of the twelve texture classes from the soils triangle. 
For those FAO soil mapping units that did not have 
any associated soil-units or soil properties, textures 
were assigned based on the most similar texture in 
the table. These units include “dunes/shifting 
sands”, “salt”, “rock”, “glaciers”, “water” and “No 
Data”. For example, “salt” is given the same values 
as “gypsum”, while “rock” is given values from 
“unweathered bedrock”.  

 
FAO soil classes are composed of multiple 

components. The components do not have 
multiple layers (Figure 40). 

 

 
Figure 40. FAO Structure. 
 
Occasionally, a soil-unit is not found in the 

tables, so texture is determined based on the soil-
unit name. FAO textures are “coarse”, “medium”, 
or “fine”, and are designated with a “1” (coarse), “2” 
(medium), or “3” (fine) following the soil-unit 
symbol (i.e. AF 2). These textures are defined in 
the FAO documentation based on the soil texture 
classes form the USDA Soil texture triangle 
(FAO/UNESCO, 2003). These three soil textures 
(coarse, medium, and fine) were added to the 
kin_lut.dbf and their soil properties created from 
weighted averages of values in the kin_lut.dbf. For 
example, “coarse” soil, defined as “Sand, Loamy 
sand, and Sandy loam soils when clay is less than 
18% and sand is greater that 65%” 
(FAO/UNESCO, 2003), uses the weighted average 
of these three soil textures (see Figure 41). 
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Figure 41. USDA Soil Texture Triangle with 

FAO soil textures outlined. 
 
When retrieving parameters for use as inputs to 

the models, parameters were first obtained from 
the FAO data if available (FAO_world.dbf and 
FAO_Africa.dbf), then from the Reynolds data 
(FAO_Summ.dbf), and finally from the AGWA 
kin_lut.dbf table if not found in any other source. 

 
The hydrologic soil group (HSG) is not given in 

the FAO documentation. It was determined using 
using the soil texture classes, the USDA soil 
texture triangle, and the FAO documentation on 
soil texture classes (FAO/UNESCO, 2003). 
General definitions for the hydrologic soil groups 
for use in verifying the relationship between texture 
and HSG were taken from Engel et al. (2004) and 
Jarrel and Bundy (2002). 

 
KINEROS 
Soil parameters for KINEROS are area-

weighted averages of the top 9 inches of the soil 
stratum. First, AGWA performs any depth-
weighting necessary based on the depth of the 
layers for each component within the plane. The 
depth-weighted values are then used during the 
area-weighting process to derive the final 
parameters. Weights are determined through the 
intersection of the watershed with the soils dataset.  

 
Parameters are added to the watershed 

attribute table once weighting is complete. 
 
Clay, silt, and sand fractions should sum to 1 for 

each plane element after area-weighting is 
complete. If the sums exceed the specified ranges, 
parameterization fails. This can be caused by 
missing data in a plane element or incorrect 

watershed intersections. Correct any problems 
before attempting to run KINEROS.  

 
In some cases, a plane element may fall 

completely within a soil type, such as water, that 
cannot be averaged. In earlier versions of AGWA, 
the soil parameters for these elements were 
assigned a value of –99; however, because these 
elements do not contribute runoff to the watershed, 
AGWA now provides the option to remove these 
elements from the watershed to allow users to 
continue the simulation process. 

 
If soil parameters for a plane element cannot be 

averaged, AGWA informs the user and asks if 
processing should continue without the affected 
elements. If the user declines, soil 
parameterization ceases and the watershed should 
not be used for simulation with the selected soil 
theme. If the user accepts, the affected plane 
elements are removed from the watershed and any 
affected parameters updated (cumulative area, 
and contributing element). Please note that this 
situation could be an indication of errors within the 
soils dataset or the intersection theme. If this is the 
case, removing the planes will result in misleading 
runoff estimates. It is the user’s responsibility to 
examine the watershed and soils theme before 
undertaking this option. 

 
SWAT 
Unlike KINEROS, SWAT soil parameters are 

not area-weighted by subwatershed. Instead, 
these values are based on the dominant soil type 
found in the subwatershed.  

 
Soil parameters are stored in a table, 

<watershed name>_soil_lut.dbf, with a record for 
each layer of each component in the watershed. 
The watershed attribute is modified to include a 
SOIL_ID field containing the dominant soil 
identifier. This table is required for SWAT 
simulation.  

 
Parameterization 
 

Parameterizing an individual watershed 
Before parameterizing a watershed, add any 

soil and landcover datasets that will be used. Also, 
add the landcover lookup tables for the landcover 
datasets. 

 
To parameterize a watershed, select AGWA 

Tools>Landcover and soils parameterization 
(Figure 42). Select the watershed from the 
Watershed Selection panel. If the watershed was 
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discretized for SWAT, users can select to use the 
default CROP value (16) or to parameterize for 
HRUs based on landcover. HRUs must be defined 
in this step to be simulated later. These options are 
not available for KINEROS. 

 

 
Figure 42. Soils and Landcover 

Parameterization dialog. A) Watershed Selection 
panel; B) Landcover Selection panel; C) Soils 
Selection panel; D) SSURGO Options panel. 

 
Select a landcover raster from the combobox on 

the Landcover Selection panel. Only rasters 
loaded into the view will be available for use. 
Select a landcover lookup table. All available 
tables in the project can be found in the combobox. 
Tables must have the minimum landcover fields to 
be used (Class, Name, A, B, C, D, Cover, Int, N, 
Imperv). If the desired landcover lookup table is not 
found in the combobox, it can be added to the 
project using the Add table button. Navigate to the 
table to add it to the project. Select the added 
table. Click Continue to proceed to the soils 
dataset section. 

 
Select a soil spatial dataset from the Soils 

Selection panel. If the selected dataset is a 
SSURGO soil theme, the SSURGO Options panel 
will be activated. If a tabular dataset has already 
been imported for the selected spatial dataset, 
select the associated COMP table from the 
combobox. Tabular datasets can be reused for 
spatial datasets that were corrected using the 
AGWA SSURGO Tool. If the combobox is left 
empty, i.e. no selection is made, AGWA will search 

for tables with the soil dataset name followed by 
_comp, _hor, or _tex. If those files are not located 
in the project, AGWA will import those files from 
the formatted text files. If the soil dataset was 
merged, a tabular dataset must be selected from 
the combobox unless the merged tables conform 
to the above naming convention. Users should not 
attempt to merge datasets outside of the SSURGO 
Tool as testing indicates that those datasets have 
a very high failure rate.  

A  
During the initialization process, the soils 

dataset is compared to the watershed to ensure 
that the two datasets fully overlap – the soils 
dataset must extend beyond the edges of the 
watershed and must not contain any internal voids 
or gaps. The user can choose to continue with the 
parameterization if either of those situations are 
found with a KINEROS watershed; however, the 
soils dataset must be corrected before 
parameterizing a SWAT watershed. If the internal 
void error occurs, AGWA will automatically fill the 
voids and create a new soil dataset with a 
temporary file name of “soil” and a number. If the 
watershed edge extends beyond the soils dataset 
with a SSURGO dataset, the user must use the 
SSURGO tool to correct the soils theme.  

B 

C 

D 

 
 
Parameterizing a buffered watershed 
Watersheds with riparian buffer elements can 

be parameterized based on the watershed 
configuration before buffer installation and after 
buffer installation (Figure 43). Affected parameters 
include cover, interception, roughness, percent 
impervious and slope. Both conditions require the 
presence of the original, unbuffered watershed in 
the view for successful parameterization. 
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Figure 43. KINEROS Buffers Landcover 

Options dialog. A) Treatment Options panel; (B) 
Post-treatment Landcover Selection panel. 

 
Because the watershed configuration of the 

buffered watershed is altered by the buffering 
process, the original watershed is parameterized. 
The planes of the buffered watershed receive the 
parameter values from the original watershed; 
elements created during the buffering process 
receive the parameters of the plane element the 
buffered elements replaced. This is true for both 
landcover and soil parameters. For the pre-
treatment option, all buffered elements receive the 
same values, including slope, to approximate the 
uniform surface of the original plane. To 
parameterize for pre-treatment conditions, select 
Before buffer treatment applied on the 
Treatment Options panel and click Continue. 

 
Table 1. Post-treatment parameter estimates 

(buffer = WS# 146). 
WS# SLOPE INT COVER KS 
72 6.5543 2.60 24.35 8.38 
73 6.5007 2.83 24.70 8.15 
142 6.5543 2.60 24.35 8.38 
143 6.5007 2.83 24.70 8.15 
146 6.9557 1.15 70.00 13.53 
152 6.5543 2.60 24.35 8.38 
153 6.5007 2.83 24.70 8.15 

 
For the post-treatment option, all affected 

planes excluding the buffer element are set to the 
original plane parameters; the buffer element 
parameters are selected by the user (see Table 1). 

The user can opt at this time to manually set the 
slope of the buffer element or to automatically 
recalculate the slope. To manually set the slope, 
check the Set buffer slope manually? option on 
the Post-treatment Landcover Selection panel. 
Select a buffer element from the list provided. 
Double-click the Landcover cell to select a 
landcover type for the selected buffer element 
(Figure 44). Any landcover type found in the 
landcover lookup table selected in the main 
landcover and soils dialog can be applied to the 
buffer. Double-click the Slope cell to enter a slope 
value for the buffer. Slope values should be 
between 0 and 25%. (Slopes vary based on the 
conditions and management options for a given 
region. Users are encouraged to consult the 
literature for appropriate buffer design 
specifications for their region or management 
needs.) Click Continue to complete the 
parameterization process. 

A 

B 

 

 
Figure 44. Post-treatment buffer 

parameterization landcover selection. 
 

 
Parameterizing a watershed group 
The process as described for an individual 

watershed also applies to a watershed group with 
one difference – the temporary tables are keyed to 
the GROUPID field instead of the WS# field. The 
same issues involving soils and landcover dataset 
extents apply to watershed groups. It is the user's 
responsibility to provide datasets encompassing 
the study area. Processing times are longer due to 
the increased number of plane elements in a 
watershed group.  
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KINEROS 
 
Generating Precipitation Files 
Several options are available for generating 
properly formatted KINEROS precipitation files. 
The files can be multiple gage or single gage 
events; however, creating files for multiple gages 
requires very specific inputs that may not be widely 
available. All precipitation files are written to the 
AGWA project's rainfall directory.  

 
To generate precipitation files, go to AGWA 

Tools>Write KINEROS precipitation file (Figure 
45).  

 

 
Figure 45. KINEROS Precipitation dialog. 
 
Five options are presented in the window:  
 
• Generate an event using a Precipitation-

Frequency map 
• Use an event from the AGWA design storm 

database 
• Enter an event manually 
• Generate an event from a single return-

period depth 
• Generate one or more events for one or 

more gages from observed data 
 
Select a precipitation option and click OK to 

continue. 
 
 
Uniform Inputs 
Precipitation-Frequency Maps 
Precipitation-frequency maps may be 

downloaded via NOAA's Precipitation Frequency 
Data Server (PFDS) 
(http://hdsc.nws.noaa.gov/hdsc/pfds/for the 
Western states and Ohio River Basin. For those 
states not covered by the NOAA dataset, we have 

developed a temporary alternative by digitizing and 
interpolating NOAA TP 40 rainfall frequency atlas 
maps. These data are available for download at 
http://www.tucson.ars.ag.gov/agwa/ 
rainfall_frequency.html until such time as the PFDS 
is complete. Multiple durations and frequencies are 
available, but users should note that durations 
exceeding 48 hours are not applicable in 
KINEROS. Releases prior to AGWA 1.4 also 
supported precipitation-frequency maps but in 
different units. AGWA 1.4X and 1.5 supports grids 
with units of 1000ths of inches, whereas prior 
releases supported grids with units of 100,000ths 
of inches. If grids measured in 100,000ths of 
inches are all that is available, a simple grid 
calculation will make the grids compatible. 

 
Instructions for importing precipitation-

frequency maps 
From the NOAA Precipitation-Frequency Data 
Server 
1. Go to http://hdsc.nws.noaa.gov/hdsc/pfds/ 

in your web browser.  
2. Click the desired state on the map. 
3. Click on the GRIDS button in the top right 

quadrant of the map. 
4. On the new page, scroll down until you see 

the first set of comboboxes. The 
appropriate region should already be 
selected in Region. Select the desired 
return period and duration of the storm. 
Choose ArcInfo ASCII Grid for the Format 
and Mean for the Type. 

5. When the appropriate selections are made, 
click the Click here to begin GIS data 
download and save the grid to your hard 
drive. 

6. Once the file is downloaded, it will need to 
be converted from an ASCII file to a grid. 
This can be accomplished in one of two 
ways, either through the Import Data 
Source option in ArcView or through the 
ArcInfo GRID command. 

7. In ArcView, go to File>Import Data 
Source. Navigate to the ASCII grid file and 
import the grid. 

8. In ArcInfo, use the ASCIIGRID command. 
Refer to the ArcInfo documentation for the 
required arguments. 

9. The grid is downloaded in geographic 
coordinates (Decimal Degrees). It must be 
projected to match the rest of the project 
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data. Use ArcInfo, ArcToolbox or the 
Reproject Grids extension (available from 
the ESRI website) to reproject the data. 

10. Add the grid to the view (this can be done 
using the Add data button or with the Add 
grid option in the dialog). 

 
From the USDA-ARS server 
1. Go to http://www.tucson.ars.ag.gov/agwa/ 

rainfall_frequency.html in your web 
browser. 

2. Select the desired state from the Location 
combobox. Select the return period and 
duration. 

3. Click the download button and save the 
grid to your hard drive (The grid does not 
need to be converted). 

4. Reproject the grid from geographic 
coordinates (Decimal Degrees). It must be 
projected to match the rest of the project 
data. Use ArcInfo, ArcToolbox or the 
Reproject Grids extension (available from 
the ESRI website) to reproject the data. 

5. Add the grid to the view (this can be done 
using the Add data button or with the Add 
grid option in the dialog). 

 
Select the desired grid from the combobox on 

the Grid Selection panel (Figure 46). Select a 
watershed on the Watershed Selection panel. 
Enter a precipitation name and a saturation index. 
This is the initial soil saturation value for the event. 
(It is equivalent to the SA value in the parameter 
file.) 

 

 
Figure 46. Precipitation-Frequency Precipitation 

File dialog. A) Grid Selection panel; B) Watershed 
Selection panel. 

 
AGWA takes the watershed centroid and 

intersects it with the NOAA grid to determine the 
event's total depth value. The depth value is 
converted to a hyetograph using the SCS 
methodology (SCS, 1973) and a type II distribution. 

The type II distribution and several others are 
shown in Figure 47 and is appropriate for deriving 
the time distribution of rainfall for most of the 
country. 

 
a. 

 
b. 

 
Figure 47. (a) SCS distributions. (b) Applicability 

of type II distribution. 
 
AGWA Design Storm database 
AGWA provides a number of design storms in 

the dsgnstrm.dbf (in the datafiles directory). This 
file contains return period depths and are available 
only for specific locations. Load this table into the 
project before creating a precipitation file. Select 
the location and frequency from the available 
choices. The events are generated using the SCS 
methodology for the type II method. (Area 
reduction can only be applied to events generated 
from the San Pedro data. The area reduction factor 
is computed using the Osborn et al. (1980) method 
for thunderstorms in the southwestern United 
States.) 

A 

B 

 
The dsgnstrm.dbf can be modified by the user 

to include additional locations, durations, or return 
period depths (Figure 48). Open the table and 
select Table>Start editing. Add a new record with 
Edit>Add record. Modify the fields as necessary 
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and save the changes (Table>Stop editing; click 
Yes when ArcView asks to save changes).  

 

 
Figure 48. The dsgnstrm table. 
 
To generate the file, select the location and 

frequency-duration from the available choices 
(Figure 49). Select the watershed for which the 
event will be generated. Set the saturation index 
for the event (it is equivalent to the SA value in the 
parameter file). Enter a name for the precipitation 
file and click Generate to write the file. 

 

 
Figure 49. AGWA Design Storm dialog. 
 
Manual Inputs 
Enter Event 
If the desired design storm is not found in the 

supplied database, the user can enter that event 
manually with the Enter data for a custom design 
storm manually>Enter storm data manually 
option (Figure 50). The user must supply each 
time-depth or time-intensity pair for the event 
duration. It is not recommended for events with 
long durations. 

 
First, enter any comments to the precipitation 

file on the Basic Storm Information panel 
(optional). Set the saturation index (it is equivalent 
to the SA value in the parameter file). Select the 

type of precipitation file to generate – time-depth 
pairs or time-intensity pairs. Enter the number of 
pairs that will be included and click Proceed. The 
Storm Entry panel is now active. Double-click in 
the Time (min) field to enter the time value 
(minutes); double-click in the Depth (mm) or 
Intensity (mm/hr) field to enter that value. Once 
all of the rows are completed, click Generate to 
write the precipitation file. 

 

 

A 

B 

Figure 50. User-Defined Storm Dialog. A) Basic 
Storm Information panel; B) Storm Entry panel. 

 
Single Return Period Depth 
If the desired design storm is not found in the 

supplied database, the user can enter that event 
manually with the Enter data for a custom design 
storm manually>Generate design storm based 
on single return period depth option (Figure 51). 
This option converts the depth and duration into a 
hyetograph based on the SCS methodology for 
type II distributions.  
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Figure 51. Single Return-period Depth Event 

dialog. 
 
Enter any comments in the textbox (optional). 

Enter the number of time-depth pairs, including 
time zero, to be written to the file. Enter the return 
period depth (mm) and the duration of the event 
(hours). Select a saturation index (it is equivalent 
to the SA value in the parameter file). Click 
Generate to write the precipitation file. 

 
 
Multiple Gage Inputs 
This process is based on the Perl script 

previously available in the datafiles download from 
the AGWA website. The component simplifies 
several aspects of the original process, and 
reduces it to one step for the user. The component 
allows you to select the gages, to include gages 
with zero depths for more accurate interpolation by 
KINEROS, to set a minimum depth that the gages 
must exceed before creating a precipitation file, 
and to generate files for any events between a 
given range of dates. 

 
The component uses breakpoint precipitation 

data (time-depth pairs) to generate precipitation 
files. Figure 52 shows an example of the type of 
raw data required by the tool, downloaded from the 
http://www.tucson.ars.ag.gov/dap website. 

 
 

 
 
Figure 52. Breakpoint precipitation data for 

Walnut Gulch, AZ. 
 
Once the precipitation data has been obtained, 

it must be formatted before use in the multiple 
gage file generator. The date must be separated 
into YEAR, MONTH, and DAY fields and the start 
time into HOUR and MINUTE fields. This can be 
done in Microsoft Excel using the YEAR(), 
MONTH(), DAY(), HOUR(), and MINUTE() 
functions. The start time should be based on 24-
hour time. In addition, the formatted table must 
contain an ELAPSED field (“Elapsed Time” above) 
that contains the time, in minutes, from the start of 
the event, and a DEPTH_MM field that contains 
the recorded depth of the precipitation in 
millimeters at the current time step. The only other 
field required from the raw data file is the GAGE 
field, containing the numeric gage identification 
number. These numbers must correspond to the 
gage numbers found in the raingage point theme. 
Once the data is formatted, it must be exported as 
a DBF table (figure 53). 

 

 
Figure 53. Example precipitation input table. 

 
Events are determined using the start time 

(HOUR and MINUTE), the elapsed time 
(ELAPSED), and the date. The end time of the 
event is based on the earliest start time for an 
event and the highest elapsed time. If the start time 
of a gage is later than the previous event’s end 
time, AGWA assumes the observations are part of 
another event. The time breakpoints for all affected 
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gages are adjusted based on the earliest start time 
for the event. 

 
Once the input table has been properly 

formatted, the multiple gage option can be used. 
Select the point theme containing the gage 
locations on the Raingage Selection panel (Figure 
54). Select the gages to be included in the 
precipitation files. Hold down Shift to add or 
remove points from the selection. A maximum of 
one hundred gages can be selected; however, for 
larger events, this number should be reduced to 
ensure that the total number of time-depth pairs 
does not exceed 5000. Gages with no recorded 
rainfall can be included in the precipitation files by 
selecting Include gages with no measured 
precipitation?. This will affect the KINEROS 
interpolation results.  

 
Select the event table from the Event 

Information panel. Enter a range of dates to limit 
the event search. Each date should be formatted 
as MM/dd/yyyy. Enter a minimum depth. Events 
can be excluded if at least one gage included in 
the event does not exceed the specified minimum 
depth. The default value is zero to include all 
events. 
 

 
Figure 54. Multiple Gage Precipitation dialog. A) 

Raingage Selection panel; B) Event Information 
panel; C) Saturation Index panel. 

 

Select an initial soil saturation value from the 
Saturation Index panel. This value will be used for 
every gage in every event generated in a given 
session. These values can be modified in a text 
editor before using in a simulation by resetting the 
SA value for any given gage. Click Generate to 
write the files. 

 
A file for each event in the specified range will 

be written to the specified directory within the 
AGWA project’s rainfall directory. If the 
subdirectory does not exist, AGWA will create it. 
Files are named with the following: 

 
Year_month_day_event# 
 
To avoid overwriting files, create a new 

subdirectory. The files will be available when 
creating a KINEROS simulaton. 

 
Setting the saturation index 
The saturation index can be entered manually 

as a decimal value or can be selected using the 
slider (Figure 55). 

 

 

A 

Figure 55. Saturation Index dialog. 
 

Inputs and Execution 
Once the watershed has been delineated, 
discretized, and parameterized, you can run 
KINEROS. The process includes writing the 
necessary input files to a KINEROS simulation 
directory (in the simulations directory of the current 
AGWA project), executing KINEROS, and 
importing the KINEROS output file into the project.  

B 

 C 
Three types of KINEROS simulations can be 

performed – an individual watershed with one 
parameter file and one precipitation file; a 
watershed group with multiple parameter files and 
one precipitation file; or a watershed or watersheds 
(not groups) with multiple parameter files and 
multiple precipitation files. The last two options are 
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examples of the new KINEROS batch simulation 
mode (all simulations use the same executable). 

 
To run KINEROS, select AGWA Tools>Write 

inputs and run KINEROS (Figure 56). KINEROS 
can be run for multiple parameter file/precipitation 
file pairs. Parameter files can be reused as 
necessary, providing the simulation rerun option, 
and modified parameter files can be imported for 
use. 

 

 
Figure 56. KINEROS Input dialog. A) Simulation 

Creation panel; B) Tabular Output panel; C) File 
Selection panel; D) Simulation Component panel. 

  
First, create a new simulation directory on the 

Simulation Creation panel. This directory will 
contain all parameter files, precipitation files, and 
output files for the simulation. The directory will 
also contain the kin.fil file and a copy of the 
KINEROS executable. Enter a simulation name 
and click Create simulation. A new directory will 
be created in the current project's simulations 
directory.  

 
Check the Include tabulated results in 

output? On the Tabular Output panel to include a 
tabular summary of the simulation at the end of the 
.OUT file (recommended). In some cases, writing 
this output can cause KINEROS to stall. Should 
this occur, do not select this option; however, 
results from the affected simulation can still be 
imported. 

 
Select a watershed on the File Selection panel. 

A list of available parameter files for the watershed 
will be provided in the parameter file combobox. 
This list includes parameter files written or 
imported for any previous simulation. Parameter 
files can also be written or imported at this time 
(see KINEROS>Inputs and Exectuion>Writing 

the parameter file). Click Write new file to 
generate a parameter file; click Import file to 
import an existing file into the simulation. The 
import option allows users to modify the parameter 
file in any text editor and reuse it in a simulation. 
The modified file should be located in an existing 
simulation directory for the selected watershed and 
must have a name unique to parameter files for the 
watershed (i.e., if a parameter file called kin1.par is 
found in sim1, the imported parameter file cannot 
be called kin1.par even if located in sim2). The 
new or imported parameter file will be added to the 
combobox. Select a file. A 

 
B 

Select a precipitation file on the File Selection 
panel. The list in the combobox contains all 
precipitation files found in the rainfall directory of 
the current project. This list will also contain any 
precipitation files found within subdirectories of the 
rainfall directory (see Multiple Gage Inputs). If a 
precipitation file is located in another location, use 
the Browse button to navigate to the file. 

C 

D 

 
Once all selections have been made, click Add 

to simulation to enter the parameter 
file/precipitation file pair to the simulation 
(Simulation Component panel). The filenames and 
watershed are added to the listbox. Repeat the 
above steps until the simulation inputs have been 
defined. Parameter file/precipitation file pairs 
cannot be repeated in a simulation. Parameter files 
written for different watersheds but used in one 
simulation also should not have the same name. 

 
To utilize the hydrograph option, the parameter 

file must contain the appropriate output options 
and the parameter file/precipitation file pair must 
be the only pair in the simulation. The parameter 
file can be used in a batch simulation, but, 
because of potential conflicts with the hydrograph 
outputs, the files will not be imported or available 
for display. 

 
Watershed groups also cannot be simulated in 

the multiple watershed/parameter file batch mode. 
AGWA will prevent users from adding additional 
parameter file/precipitation file pairs to the 
simulation. Groups make use of the batch 
simulation mode by pairing each parameter file for 
the group with the selected precipitation file and 
executing KINEROS.  

 
A parameter file/precipitation file pair can be 

removed from the simulation be selecting the row 
and clicking Remove entry.  
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When satisfied with the simulation inputs, click 
Run KINEROS to begin the simulation process. 
Any parameter files not created specifically for this 
simulation will be copied to the simulation 
directory. Again, all parameter file names in the 
simulation must be unique or the simulation 
outputs could reflect the wrong parameter file 
inputs. Precipitation files are also copied to the 
simulation directory. AGWA will generate the kin.fil 
file (the KINEROS control file) in the following 
format (all entries on one line per pair): 

 
parameter filename, precipitation filename, 
output filename, comments (optional), duration, 
timestep (1 minute default), use Courant criteria 
(Y/N), simulate sediment transport (Y/N), 
multipliers filename (not used), include tabular 
summary(Y/N), API initializing (Y/N) 
 
The filenames in the kin.fil file (and the 

hydrograph outputs) are not the full path names, 
so KINEROS will only read or write files within the 
simulation directory. The output filename is a 
combination of the parameter file name and the 
precipitation file name. For example, the output file 
for kin1.par and event2.pre will be kin1_event2.out. 
AGWA defaults to use the Courant condition, to 
simulate sediment transport and not to initialize 
API. AGWA will then write a batch file (kin2.bat). 
This file will navigate to the simulation directory 
and initialize KINEROS (Figure 57).  

 

 
Figure 57. The KINEROS2 simulation (MS-DOS 

window). 
 
AGWA does not automatically import simulation 

results. Files can be imported at any time through 
the View Results dialog. 

  
Writing the parameter file 
Parameter files are written when setting up a 

simulation. Any number of files can be written for a 
given watershed when in the KINEROS Simulation 

Inputs dialog. The new file is written to the current 
simulation directory (created in Simulation Setup). 
Every precaution should be made to avoid naming 
a parameter file the same name as a parameter file 
in another simulation for the watershed. This is to 
avoid confusion when using multiple parameter 
files from different simulations in batch processing 
mode. 

 

 

A 

B 

Figure 58. KINEROS Parameter File dialog. A) 
Parameter File Name panel; B) Multipliers panel. 

 
Enter a name for the parameter file on the 

Watershed Name panel (Figure 58). The name of 
the selected watershed is displayed in the 
Parameter File Name panel. To view hydrograph 
results for each element, check the Generate 
element hydrographs? checkbox. See 
KINEROS>Inputs and Execution>Hydrograph 
Output for more information. Enter any multipliers 
for the provided parameters on the Multipliers 
panel. See KINEROS>Inputs and 
Execution>Using multipliers for more 
information. Click Continue to write the file and 
return to the KINEROS Simulation Inputs dialog. 

 
If writing a parameter file for a watershed group, 

a parameter file will be written for each watershed 
in the group, with <parameter file name>_<group 
number>.par. These files are not available for 
individual simulation in AGWA. To perform an 
individual simulation with a watershed from a 
watershed group, first extract the watershed. 
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Hydrograph Output 
The standard AGWA practice provides only the 

hydrograph information for the outlet channel. This 
file can be found in the simulation folder as 
<parameter file name>_<precipitation file 
name>.csv. However, hydrographs for each 
element in the watershed and stream network can 
be generated through KINEROS. With these files, 
users can take advantage of a new display option 
for KINEROS results – the time series view (see 
Results>KINEROS Time Series). Parameter files 
written with the hydrograph option can be used in 
any simulation; however, the time step view is only 
available for those simulations where the 
hydrograph parameter file is the only parameter file 
used.  

 
The hydrograph outputs are written to two 

tables when AGWA imports simulation results, the 
<sim name>_plane_sim.dbf table and the <sim 
name>_channel_sim.dbf table. Each table contains 
the information for all plane elements or channel 
elements for each time step, in this case, the 
AGWA default of 1 minute.  

 
Using multipliers 
Multipliers are values used to adjust plane and 

channel parameters before KINEROS simulation, 
but do not modify the watershed or stream attribute 
tables. These values serve to calibrate the 
simulation. Multipliers range between -5 and 5, 
excluding zero. The multipliers are stored in the 
metadata file for the watershed and can be viewed 
with any of the simulation information buttons.  

 
Running KINEROS with a watershed group 
The batch processing method cannot be used 

when running a KINEROS watershed group 
(multiple parameter files cannot be added to the 
simulation). A watershed group automatically 
creates a parameter file for each watershed in the 
group; these files are stored in the simulation 
directory. The simulation takes advantage of the 
batch processing mode by simulating each 
watershed in the group with the specified 
precipitation file. A separate OUT file is written for 
each watershed. 

 
Multiplier values are applied to all watersheds in 

the group.  
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SWAT 
 
Generating precipitation files 
AGWA provides two methods for generating 
precipitation files for SWAT – a single gage, 
uniform method and a multiple gage, distributed 
method. The multiple gage method utilizes 
Thiessen polygons to create an area-weighted 
precipitation file. Precipitation estimates (and 
temperature estimates) can be adjusted for 
topography with the SWAT elevation band 
component for individual watersheds. 

 
To generate a precipitation file for SWAT, select 

AGWA Tools>Write SWAT precipitation file. 
This will open the SWAT Precipitation dialog 
(Figure 59).  

 

 
Figure 59. SWAT Precipitation dialog. A) 

Watershed Selection panel; B) Rain Gage Input 
Specification panel; C) Rain Gage Selection panel; 
and D) Elevation Input panel. 

 
First, select a SWAT watershed from the 

combobox on the Watershed Selection panel. 
Select a point theme containing the raingage or 
gages to be used on the Rain Gage Input 

Specification panel. Point themes can be added at 
this time with the Add button. Select the rain gage 
identifier field (this field cannot be called ID). The 
field values should correspond to the values found 
in the unweighted precipitation file, without the 
leading “G”. For example, Gage 24 from the 
GAGE_ID field in the attribute table will have 
precipitation values in the G24 field of the 
unweighted precipitation file. 

 
Using the point selection tool on the Rain Gage 

Selection panel, select all raingages to be used. To 
create a uniform precipitation file, select 3 or fewer 
gages; to create a distributed precipitation file, 
select more. The identifiers will be displayed in the 
Selected Gages area. Click Accept to continue. 

 
Elevation data is used by SWAT when adjusting 

precipitation and temperature estimates for 
orographic effects using the Elevation Bands 
option (see SWAT>Generating precipitation 
files>Elevation Bands). Two options are available 
for providing elevation data: extracting elevations 
from a DEM and extracting elevations from a field 
in the rain gage theme’s attribute table. If elevation 
data is not available for either of these options or if 
you do not wish to use elevation bands, you can 
generate files without elevation data. Elevation 
data cannot be added to an existing precipitation 
file. Elevation options are presented on the 
Elevation Input panel. 

A 

B 

C 

 
To use elevation data from the rain gage 

attribute table, select Acquire gage elevation 
from the gage attribute table. Select the 
elevation data field and units. If the units are not in 
meters or feet, you must provide the appropriate 
conversion value to convert your units to meters. 
AGWA will perform the conversion when 
calculating the mean elevation. 

D 

 
To use the elevation data from the DEM, first 

make sure that all of the selected points intersect 
the DEM. If any gage location falls outside the 
DEM, you must provide the elevation, in meters, at 
the AGWA prompt.  

 
To exclude elevation data, select Do not 

include elevation data (no elevation bands). 
You will not be able to define elevation bands with 
this precipitation file. When specifying inputs for a 
SWAT simulation, the elevation band option will 
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only be available for those watersheds that have 
bands defined and for precipitation files with 
elevation data defined. 

 
To define elevation bands for the selected 

watershed, check the Define elevation bands for 
this watershed? box. This option is only available 
if elevation data is being provided. Once the 
precipitation inputs have been specified, AGWA 
will display the Elevation Bands dialog if this option 
is selected. 

 
Click Accept when satisfied with the input 

selections. Click Continue to proceed to the 
Precipitation Weighting dialog. See Uniform 
Precipitation or Distributed Precipitation. 
 

Both options require an unweighted 
precipitation file containing a minimum of three 
fields: YEAR, DAY, and a gage field. DAY refers to 
the Julian day of the year (1-366) with values 
repeating for each year in the record. The values in 
the gage fields must be in millimeters. Weighted 
averages will be adjusted for missing or negative 
precipitation values. See Figure 60 for an example 
of an unweighted precipitation file. 

 

 
Figure 60. Example of an unweighted 

precipitation file. 
 
AGWA tracks all generated precipitation files in 

the swatpptfiles.dbf table. This table contains the 
watershed name, the precipitation file name, 
whether elevation data was included in the file, and 
the start and end dates of the file. Precipitation 
files are written to the project’s rainfall directory. 
For watershed groups, a precipitation file is 
generated for each watershed in the group, 
indicated by the GROUP number at the end of the 
filename. 

 
Uniform Precipitation 
For this option, the user only needs to provide 

an unweighted precipitation file in addition to the 
rain gage information. 

 
Figure 61. Uniform Precipitation Weighting 

dialog. (Note that the watershed/Thiessen 
intersection theme combobox and buttons are 
disabled. You do not need to provide this theme for 
uniform precipitation files.) 
 

First, select the unweighted precipitation file 
(Figure 61). (The point theme and gage identifier 
field have already been selected.) The file can be 
added at this time by selecting Browse. Click 
Accept when satisfied with the selection. If any 
gage in the point theme selection is not found in 
the unweighted precipitation file, AGWA will 
terminate the process. If multiple gages (<= 3) 
were selected, AGWA will use the values for the 
gage closest to the centroid of the watershed. 
Enter a name for the new precipitation file. Click 
Generate to generate the file.  

 
Once the file has been successfully written, 

AGWA will continue to the elevation bands 
processing if that option was selected. This option 
is not available for watershed groups. See 
SWAT>Generating precipitation files>Elevation 
Bands for more information. 

 
Distributed Precipitation 
Distributed precipitation files use Thiessen 

polygons to calculate weighted averages for each 
subwatershed. Two additional steps are required 
before the precipitation file can be written. First, the 
Thiessen polygon theme must be created from the 
selected gages. Then, the Thiessen polygons must 
be intersected with the watershed theme to 
determine the weights. Thiessen polygon themes 
and Thiessen polygon-watershed intersection 
themes can be used more than once.  
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Figure 62. SWAT Thiessen Precipitation 

Weighting dialog. A) Precipitation Weighting panel; 
B) Intersection Theme Generation panel; C) 
Thiessen Polygon Theme Generation panel. 

 
 First, select the unweighted precipitation file 

from the Precipitation Weighting panel (Figure 62). 
The unweighted precipitation file must contain 
columns for each gage selected in the previous 
dialog (see Figure 63 for an example selection 
set). Again, a file can be added to the project at 
this time with the Add button. Click Accept to 
continue. If an intersection theme has been 
created, select it from the combobox. The user will 
need to identify the gage identifier field in the 
selected intersection theme. If the intersection 
does not exist, click Create to generate the 
shapefile. This activates the Intersection Theme 
Generation panel of the dialog. 

 

 
Figure 63. Rain Gage locations for a SWAT 

watershed. 

If a Thiessen polygon theme has been 
generated for the selected raingage theme, select 
it from the combobox and click Accept. If a 
Thiessen polygon theme has not been created for 
the selected raingages, click Create. The Thiessen 
Polygon Theme Generation panel of the dialog is 
activated. In this section, enter a name for the new 
Thiessen polygon theme and click Generate. See 
Figure 64 for an example of a Thiessen polygon 
theme. 

A 

B  

 

C 

Figure 64. Thiessen polygon theme based on 
the selected rain gages. 

 
Once the Thiessen polygon theme has been 

created, it is added to the Thiessen polygon 
combobox in the Intersection Theme Generation 
panel. Select the theme and click Accept. Enter a 
name for the new intersection theme and click 
Generate. The new intersection theme is then 
added to the intersection combobox in the original 
panel. Select the intersection theme and click 
Accept. Enter a name for the precipitation file and 
click Generate to create the file. See Figure 65 for 
an example of the Thiessen polygon/watershed 
intersection theme. 
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Figure 65. Thiessen polygon/watershed 

intersection theme. 
 
If the gages in the intersection theme do not 

match the gages in the unweighted precipitation 
file, AGWA will display a message containing a list 
of gages that will not be used and a list of gages 
that will be used. This will not terminate the 
process. 

 
The weighting scheme is modified to account 

for missing or negative precipitation values. The 
following outlines the weighting process: 

 
• If all gages in a subwatershed have values 

then the weighted depth = weighted depth + 
(gage depth * gage weight) 

• If all the gages in the watershed have zero 
values or no data then the weighted depth = 
0. 

• If one or more of the gages in the 
subwatershed have no data then  
o If all the gages for the subwatershed 

have no data, then set the weighted 
depth to the depth of the closest gage 
with a value unless there are more than 
one gage within the subwatershed, then 
the weighted depth is the depth of the 
gage closest to the subwatershed 
centroid 

o If some gages within a subwatershed 
have no data, then if the gage depth is 
negative the weighted depth is 
unaffected; otherwise the gage weight 
is adjusted as (gage weight / (1 – sum 
of the weights of the no data gages)). 

 
The weighting process can take a considerable 

amount of time. Two factors affect the total 
processing time – the number of gages and the 

length of the unweighted precipitation file. In both 
cases, processing times increase as the number of 
records increases. Processing times are also 
increased for watershed groups, increasing with 
the number of watersheds within the group. The 
AGWA Progress bar displays the number of days 
processed out of the total number of days to be 
processed. Once the file is written, AGWA will 
proceed to the elevation band processing if that 
option was selected. This option is not available for 
watershed groups. See SWAT>Generating 
precipitation files>Elevation Bands for more 
information. 

 
 
Elevation Bands 
Elevation bands allow users to adjust 

precipitation and temperature estimates based on 
orographic effects. These adjustments are made 
during the simulation process and do not affect the 
precipitation file generation. The process utilizes 
the elevation data acquired earlier in the 
precipitation file generation process as well as the 
mean elevation of the bands for each 
subwatershed. 

 

 

A 

B 

C 

D 

Figure 66. SWAT Elevation Bands dialog. A) 
Watershed Identification panel; B) Elevation Band 
Parameter Specification panel; C) Precipitation 
Lapse Rate Specification panel; D) Temperature 
Lapse Rate Specification panel. 

 
On the Elevation Bands dialog (Figure 66), 

enter the band interval and interval adjustment 
values on the Elevation Band Parameter 
Specification panel. Specify the precipitation lapse 
rate (Precipitation Lapse Rate Specification panel) 
and the temperature lapse rate (Temperature 
Lapse Rate Specification panel). Click Process to 
generate the bands. 
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SWAT limits the number of bands for a given 
subwatershed to 10. To fall within this limitation, 
AGWA adjusts the elevation interval so that no 
subwatershed exceeds the 10 band limit. The 
elevation interval is the same across the 
watershed. The user enters the initial elevation 
interval (in meters) as well as an interval 
adjustment factor. This value is used to increment 
the initial interval value if necessary. For example, 
the initial interval is set to 30m with an adjustment 
factor of 10m. If one of the subwatersheds contains 
11 bands, the initial interval is increased to 40m 
and new bands are generated. This process is 
repeated until all subwatersheds have 10 or fewer 
elevation bands. Figure 67 shows elevation bands 
defined for a SWAT subwatershed. 

 

 
Figure 67. Discretization of elevation bands 

(gray regions). 
 
Once the bands are determined, AGWA 

generates ELE data files. These files are placed in 
the elev directory within the project’s rainfall 
directory. A file is created for each subwatershed, 
with <watershed name>_WS#.ele. Each file 
includes the following information: 

 
• A comment indicating the subwatershed 
• The precipitation lapse rate (if zero, SWAT 

will not adjust precipitation estimates) 
• The temperature lapse rate (if zero, SWAT 

will not adjust temperature estimates) 
• The mean elevation of the subwatershed 
• The number of elevation bands, the 

midpoint elevation of each band, and the 
fraction of the watershed within each band 
(this information is written on one line per 
subwatershed) 

 
These files are accessed when AGWA writes 

the subwatershed general input files (SUB). The 
user can also decide, when determining the inputs 
for a SWAT simulation, to use or not use the 
generated elevation bands. 

Inputs and Execution 
Once the watershed has been parameterized and 
a precipitation file generated, select AGWA 
Tools>Write output and run SWAT (Figure 68).  

 

 

A 

B 

C 

D 

E 

F 

G 

H 

Figure 68. SWAT Input dialog. A) Watershed 
Selection panel; B) Precipitation File Selection 
panel; C) Simulation Length panel; D) Output 
Frequency panel; E) Temperature Selection panel; 
F) Directory Name panel; G) Advanced Options 
panel; H) Weather Generator Station Selection 
panel. 

 
First, select the watershed on the Watershed 

Selection panel. If HRUs were generated for the 
selected watershed, this option can be simulated 
at this time.  

 
Select a precipitation file for the selected 

watershed on the Precipitation File Selection 
panel. Only precipitation files found in the 
swatpptfiles.dbf can be used for simulation. If 
elevation bands were generated for the watershed 
and elevation data used when generating the 
selected precipitation file, the Use elevation 
bands? option is activated. Check the box to use 
the elevation bands. 
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The beginning date of the simulation is based 
on the start date of the selected precipitation file. 
The date is entered as MMDDYYYY on the 
Simulation Length panel. This value can be 
changed if it does not reflect the desired start date. 
Enter the number of years to simulate. The 
precipitation file must contain all of the records 
necessary to simulate the time period from the 
specified start date to the end date indicated by the 
number of years. 

 
Select the output frequency on the Output 

Frequency panel. Simulations can be run on a 
daily, monthly or yearly frequency. Please note that 
processing times increase for simulations run at 
the daily timestep. 

 
Choose the type of temperature data to use 

during simulation on the Temperature Selection 
panel. Observed temperature data is the best 
option, but may not be available. If providing this 
type of file, refer to the included TMP file and the 
SWAT User’s Manual for the data and formatting 
requirements.  

 
Enter a simulation name on the Directory Name 

panel. This name will be used to create a directory 
in the simulations directory. All input files for the 
simulation will be written to this directory. 
Simulation names are limited to 5 characters in 
length.  

 
Determine which, if any, advanced options to 

use during the simulation from the Advanced 
Options panel (see SWAT>Inputs and 
Execution>Advanced Inputs). If HRUs were 
calculated for the watershed during the last 
parameterization, these can be used at this time. 
Other available options include groundwater 
simulation, rainfall adjustment factors and nitrogen 
and phosphorous simulation. To include any of 
these three options, check Use advanced 
parameters. Inputs for these options can be 
entered in the next dialog. 

 
Select a weather generator file selection 

method on the Weather Generator Station 
Selection panel. See SWAT>Inputs and 
Execution>Selecting the weather generator file 
for more information. 

 
Click Continue to proceed. If advanced 

parameters will be used, AGWA will proceed to the 
SWAT Advanced Inputs dialog; otherwise, AGWA 
generates the input files and initializes SWAT 
(Figure 69). 

 
Figure 69. The SWAT Simulation (MS-DOS 

window). 
 
Selecting the weather generator file 
A weather generator file contains statistical data 

for a gage location that is used by SWAT to 
estimate daily maximum and minimum 
temperatures, rainfall, and other climate 
parameters required by SWAT. Select the station 
closest to the watershed. To aid in this process, a 
point theme of the available stations is provided in 
the datafiles download. These stations are the 
same as those found in the provided WGN table. 
Both options are available through the Weather 
Generator Station Selection dialog (Figure 70). 

 

 

A 

B 

Figure 70. Weather Generator Station Selection 
dialog. A) Select by Point Theme panel; B) Select 
by Table panel. 

 
If selecting from the table, click Open WGN 

database and select the record of the gage closest 
to the watershed. Return to the dialog and click 
Process Selection to return to the SWAT Inputs 
dialog.  

 
If using the point selection option, select the 

point theme containing the stations. Use the point 
selection tool to select the ONE gage closest to the 
watershed. Click Continue to return to the SWAT 
Input dialog. 
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Advanced Inputs 
Three options are provided by the SWAT 

Advanced Options Input dialog (Figure 71). Any or 
all of the options can be utilized in a simulation. If 
you do not wish to to use one of the options, 
simply leave the default values provided by AGWA. 

 

 
Figure 71. SWAT Advanced Inputs dialog. A) 

Rainfall Adjustment Factors panel; B) Groundwater 
Input panel; C) Nitrogen and Phosphorus 
Simulation panel. 

 
Rainfall Adjustment Factors 
Rainfall adjustment factors modify the daily 

rainfall estimates for a given month. These values 
are given in percent on the Rainfall Adjustment 
Factors panel. For example, the rainfall adjustment 
factor for July is set to 12, so the daily estimates 
for July are adjusted to 112% of the original 
values. The factors are the same for all 
subwatersheds. 

 
Groundwater 
This option allows users to specify parameters 

for the groundwater files in SWAT on the 
Groundwater Input panel. SWAT simulates 
groundwater movement with two aquifer systems – 
a shallow, unconfined aquifer that contributes to 
the streams within the subwatershed and a deep, 
unconfined aquifer that contributes to streams 
outside the subwatershed. The specified values 
are used for all subwatersheds.  

 
Nitrogen and Phosphorous Modeling 
This provides basic water quality modeling 

through SWAT. This process can be undertaken 
with no additional information; however, the CROP 

values for each subwatershed can be modified to 
reflect different management or landcover types. 

 
To modify the CROP values, double-click the 

row for the subwatershed on the Nitrogen and 
Phosphorus Simulation panel. Select a new CROP 
type and click Return. The list will be modified to 
reflect the new CROP number. These will be used 
when parameterizing the current SWAT simulation. 
The CROP values in the watershed are not 
affected. A 

 
 Additional parameters are included in the 

channel and subwatershed results tables and can 
be viewed with the Results viewer. See Results for 
more information regarding these parameters. 

B 

 
Running SWAT for a watershed group 
This process is similar to that described above; 

however, within the created simulation directory, a 
subdirectory for each watershed in the group is 
created as <simulation name>_GROUP. Each 
watershed in the group is simulated separately, 
with different input files and output files.  

C 
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Results 
 
Simulation results must be imported following the 
successful execution of SWAT or KINEROS. Due 
to the nature of the various batch processing 
methods, automatic import is no longer feasible. By 
separating this functionality from the model 
simulation, simulation results can now be re-
imported if accidentally removed from the project 
or otherwise corrupted.   

 
KINEROS Plane Outputs 

Infilt_m: infiltration (mm) 
Infilt_e: infiltration (in) 
Runoff_mm: runoff (mm) 
Runoff_m3: runoff (m3) 
Sed_out: sediment yield (kg/ha) 
Pflow_m3s: peakflow (m3/s) 
Pflow_mmh: peakflow (mm/hr) 
PSedQ_kgs: peak sediment discharge (kg/s) 
Percent Error: mass balance error (%) 
 

KINEROS Stream Outputs 
Infilt_m: infiltration (mm) 
Infilt_e: infiltration (in) 
Runoff_mm: runoff (mm) 
Runoff_m3: runoff (m3) 
Sed_out: sediment yield (kg) 
Pflow_m3s: peakflow (m3/s) 
Pflow_mmh: peakflow (mm/hr) 
PSedQ_kgs: peak sediment discharge (kg/s) 
Z_change: channel scour (mm/m2) 
Percent Error: mass balance error (%) 

 
SWAT Subwatershed outputs 

Precip_mm: total precipitation for the 
subwatershed for the given time period (mm) 

ET_mm: estimated evapotranspiration (mm) 
Perc_mm: estimated percolation for the 

subwatershed (mm) 
Surq_mm: estimated surface runoff for the 

subwatershed (mm) 
Tloss_mm: estimated transmission loss for the 

subwatershed (mm) 
Watyld_mm: estimated water yield (mm) 
SedYld_t_h: estimated sediment yield (t/ha) 
OrgN_kg/ha: Organic Nitrogen contributed by the 

subwatershed to the channel (kg/ha) 
OrgP_kg/ha: Organic Phosphorus contributed by 

the subwatershed to the channel (kg/ha) 
SedP_kg/ha: Mineral Phosphorus attached to 

sediment contributed by the subwatershed to 
the channel (kg/ha) 

SurN_kg/ha: NO3 contributed by surface runoff 
from the subwatershed to the channel (kg/ha) 

SolP_kg/ha: Soluble Phosphorus contributed by 
surface runoff from the subwatershed to the 
channel (kg/ha) 

 
SWAT Stream Outputs 

Watyld_mm: estimated water yield (mm) 
Tloss_m3s: estimated transmission loss (m3/s) 
SedYld_mtn: sediment yield (tons) 
Q_cmd: channel runoff (m3/day) 
SedCon_mg/kg: Sediment concentration (mg/kg) 
OrgN_kg: Organic Nitrogen transported by water 

from the channel (kg) 
OrgP_kg: Organic Phosphorus transported by 

water from the channel (kg) 
NO3_kg: Nitrate transported by water from the 

channel (kg) 
NH4_kg: Ammonium transported by water from the 

channel (kg) 
NO2_kg: Nitrite transported by water from the 

channel (kg) 
MinP_kg: Mineral Phosphorus transported by 

water from the channel (kg) 
 
SWAT HRU outputs 
Same as the subwatershed results but 

separated for each HRU in a subwatershed. These 
results cannot be displayed in the view. 

  
Modifications for AGWA 1.5 allow results tables 

to be added back into a project without needing to 
rerun the simulation. Because the files end in 
“.dbf”, these files can be added using the ArcView 
Tables Add functionality. The files can also be 
added using the Results dialog Import button.  

 
To view results, go to AGWA Tools>View 

KINEROS Results or View SWAT Results 
(Figure 72). Select a watershed from Watershed 
Selection panel. Any previously imported 
simulations will be added to the simulations 
combobox on the Simulation Selection panel. If the 
combobox is empty or the simulation to be viewed 

is not listed, click the Import button ( ). 
Simulations can be imported at any time and can 
be reimported if deleted from the project. Select 
one or more simulations from the provided list to 
import. Once all of the files are imported, the 
simulation is added to the simulations combobox. 
Select a simulation.  
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Figure 72. View Results dialog. A) Watershed 

Selection panel. B) Simulation Selection panel; C) 
Standard View panel; D) Time Series View panel; 
E) Simulation Comparison panel. 

 
After selecting a watershed, the user can also 

use any previously imported simulations to set 
classification breakpoints. Click Set breakpoints 
and select from the list of simulations to determine 
the classification scheme for each output. 

 
Several options are available for viewing the 

results. All simulations can be viewed with the 
standard outputs on the Standard View panel 
(Simulation Totals). Select an output type and click 
Update to view the simulation totals. If breakpoints 
have been defined, the derived classifications can 
be used by checking the Use the defined 
breakpoints for this watershed box.  

 
If the simulation included KINEROS 

hydrographs or any SWAT output (excluding HRU 
simulations), the results can be viewed with the 
Time Series View option. Select an output in the 
Time Series output combobox. If SWAT, enter a 
date range based on the output frequency of the 
simulation. Acceptable formats can be viewed with 
the Identify button. Click Update to begin the time 
series display. 

 
Simulations can also be compared with options 

on the Simulation Comparison panel. To compare 
a buffered watershed with the original, unbuffered 
watershed, use the Unbuffered vs. Buffered 
option. Otherwise use the Difference option. 

 
 

Setting and using the breakpoints 
This option allows users to display any imported 
results for a watershed with the same classification 
scheme. It is similar to applying a stored AVL 
legend for the watershed with two important 
differences – the breakpoints can be changed as 
necessary and the color schemes are identical to 
those used for the standard AGWA results display. 
These breakpoints are only used if the Use the 
defined breakpoints for this watershed? 
checkbox is checked; otherwise, the breakpoints 
are based on the selected simulation and output 
values.  

A 

B 

C 

D 

 
To set the breakpoints, first select a watershed. 

Click Set breakpoints. Select any or all of the 
simulations listed in the provided listbox. 
Differenced results cannot be used to set the 
breakpoints to avoid misapplication of those values 
to a non-differenced simulation. AGWA will 
determine the maximum and minimum values for 
each output parameter from all of the selected 
simulations. The breakpoints are then calculated 
for each output parameter. The values are stored 
in the watershed metadata file for use in later 
AGWA sessions. Breakpoints can be reset as 
necessary by clicking the Set breakpoints button 
and selecting a different range. The simulations 
used to determine the breakpoints can be viewed 
with the watershed identification button. 

E 

  
Simulation Totals 
This option displays the results, by element, for the 
simulation. For KINEROS, the simulation in this 
case refers to a single OUT file, so if the simulation 
contains multiple parameter file/precipitation file 
pairs, the outputs will be imported and displayed 
separately. For SWAT, the simulation totals refers 
to the average values for the simulation regardless 
of the output frequency. Results for a specific time 
period within a SWAT simulation can be viewed 
with the SWAT timestep option. 

 
SWAT simulations using HRUs have an 

additional output table, <simulation 
name>_hru_results.dbf. This table contains the 
estimates for each HRU for each time step. The 
time step for monthly and yearly simulations are 
indicated by a “Y” (annual estimate), “M” (monthly 
estimate) or “S” (simulation estimate) before the 
number in the TIME field. The identifiers indicate 
which type of summary data is found within the 
record. These results cannot be displayed within 
AGWA as HRUs are not linked to a specific spatial 
component. The table is provided for analysis only. 
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See Appendix B: Analyzing Watersheds with 
AGWA and ATtiLA. 

 
KINEROS Time Series 
This option can only be used if hydrographs for 
each element are output by KINEROS (see 
KINEROS>Inputs and Execution>Hydrograph 
Output). These values are compiled into a SIM 
table for the watershed; one for the plane elements 
and one for the channel elements. The view is 
updated every 2-3 seconds for the duration of the 
simulation or until the selected output values are 
zero.  

 
Select an output on the Time Series View 

panel. Click Update to display the results. The 
ranges cannot be modified for KINEROS. AGWA 
assumes the simulation timestep is one minute 
(the AGWA default). The current time is displayed 
next to the Update button. 

 
SWAT Time Series 
This option can be used for any frequency SWAT 
simulation. Like the KINEROS timestep option, the 
view is updated every 2-3 seconds for the duration 
of the event or for the selected range for the 
selected output. Simulations using HRUs cannot 
be displayed with this method. 

 
Select an output on the Time Series View 

panel. Enter a range of dates. The simulation 
output frequency is indicated to the right of the 
range text boxes. Date ranges must be formatted 
based on the output frequency, with 

 
• Daily = MM/dd/yyyy 
• Monthly = MM/yyyy 
• Yearly = yyyy 
 

These formats can be displayed with the 
Information button. Click Update to display the 
results. The current time is displayed next to the 
Update button. 

 
Unbuffered vs. Buffered comparison 
This option allows users to compare the original, 
unbuffered watershed with the buffered watershed. 
Because the unbuffered and buffered watersheds 
are composed of a different number of elements, 
the differencing option is not available. 

 

 

A 

B 

C 

Figure 73. Unbuffered vs. Buffered Comparison 
dialog. A) Watershed Information panel; B) Output 
Selection panel; C) Simulation Selection panel. 

 
The watersheds to be compared are identified 

in the Watershed Information panel (Figure 73). 
First, select an output type in the Output Selection 
panel. Then select the pre-treatment simulation (a 
simulation performed with the original watershed) 
on the Simulation Selection panel. To display this 
simulation, click View. To compare the buffered 
watershed, select a post-treatment simulation and 
click View. AGWA displays the post-treatment 
results using the classification scheme of the pre-
treatment simulation. Click Done to return to the 
main Results dialog. 

 
Differencing 
This option generates new results tables 
containing the difference in output values between 
two simulations for a watershed. This can be used 
to analyze the impacts of different landcover types 
or events sizes. The difference can be expressed 
as absolute change or as percent change.  

 

 

A 

B 

C 

Figure 74. Difference dialog. A) Simulation 
Name panel; B) Simulation Selection panel; C) 
Equation panel. 

 
Click the Difference button after selecting a 

watershed. (This option cannot be used to 
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compare buffered vs. unbuffered watersheds or 
with previously differenced results.) In the 
Calculate Difference dialog (Figure 74), enter a 
name for the new tables on the Simulation Name 
panel. Select the two input simulations on the 
Simulation Selection panel. Metadata for the 
simulations can be viewed by clicking the 
Description buttons. Select the type of output to 
calculate: percent change or absolute change. The 
equation used to determine the new outputs is 
displayed in the Equation panel. If satisfied, click 
OK to create the new tables. AGWA will return to 
the Results window with the new simulations 
results added to the simulations combobox. The 
results can then be displayed using the standard 
AGWA functionality. 

 
Due to variations in SWAT outputs for different 

types of simulations, the differenced results contain 
only the estimates for outputs common to both 
simulations. For example, SIMA was performed 
with the Nitrogen and Phosphorus Simulation 
option but SIMB was not. The results specific to 
Nitrogen and Phosphorous modeling will not be 
included in the calculated differences. This also 
affects HRU outputs. 
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Rerunning Simulations 
 
The tools described here are provided to enhance 
the functionality of AGWA. The capability to rerun 
existing simulations allows users to modify input 
values for calibration or, for SWAT, to include 
inputs not currently supported by AGWA while 
taking advantage of AGWA’s results display 
options for visual analysis and comparison. AGWA 
assumes the modified input files will be correctly 
edited and formatted for the model. 
 
KINEROS 
To rerun a KINEROS simulation, select AGWA 
Tools>Write output file and Run KINEROS. 
Create a new simulation. Select the parameter file 
and precipitation file to run. AGWA will copy these 
files to a new simulation directory and run 
KINEROS. The original files remain in the original 
simulation directory; no output files are overwritten. 
Modified parameter files, saved under a different 
name, can be imported into the new simulation 
using the Import button. Any parameter files that 
are to be imported must be in an existing 
simulation directory for that watershed. The 
simulation metadata contains a list of all parameter 
files written or imported for a given watershed. This 
list can be viewed in the “SIMULATION” section of 
the metadata when viewed with the AGWA 
Tools>View metadata option. Parameter file 
names, even if written to different directories, 
cannot be the same for a watershed. For example, 
for two simulations, SIMA and SIMB, the 
parameter file name cannot be sim1.par even 
though the files are written to different directories. 
Imported file names also must not duplicate any 
existing file name for the watershed.  

 
SWAT 
Select AGWA Tools>Rerun Existing Simulation 
to view the Rerun Simulations dialog (Figure 75). 
Select the watershed and the simulation. AGWA 
will copy the contents of the original simulation to a 
new simulation folder, saving the original files, and 
rerun SWAT. The simulation metadata for the new 
simulation will indicate which simulation is being 
rerun. Bear in mind, the original simulation files 
and the new simulation files will be the same 
except for the outputs. To retain the original input 
files, copy the simulation directory to a new 
location before editing any files.  

 

 

A 

B 

C 

Figure 75. Rerun Simulation dialog. A) 
Watershed Selection panel; B) Simulation 
Selection panel; C) Simulation Name panel. 

 
First, select the SWAT watershed on the 

Watershed Selection panel. The watershed 
metadata can be viewed by clicking the 
Description button. Then, choose the simulation 
on the Simulation Selection panel. The simulation 
metadata can be viewed using the Description 
button. Enter a new simulation name (maximum 5 
characters) on the Simulation Name panel. Click 
Rerun. 

 
Watershed group simulations can also be rerun 

using this option. As with individual watersheds, all 
required files are copied to the new simulation 
directory.  

 
Rerun simulations contain two additional 

metadata properties – a parameter indicating that 
the simulation is not original and the name of the 
original simulation. In all other regards, AGWA 
treats the rerun simulation as a normal SWAT 
simulation. 
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Metadata 
 
Metadata Structure 
Watershed metadata is stored in an object 
database file (ODB). These files are created during 
the delineation and discretization process and are 
updated as necessary throughout the various 
AGWA processes. Stored information includes 
discretization inputs, current landcover and soils 
selections, simulation information, and breakpoint 
information if classifications were set when 
displaying results. 

 
The watershed’s metadata file is identified as 

<watershed name>.odb. It is located in the 
project’s working directory (av_cwd). If the file is 
lost or corrupted, the watershed can no longer be 
used in AGWA.  

 
For watershed outlines, including watershed 

group discretizations, the metadata includes the 
names of the input DEM, flow direction grid, flow 
accumulation grid, and stream map grid. The date 
the watershed was generated is also stored. The 
names of the input grids are accessed when 
reusing the outline(s); the specified files must be 
located in the active view. 

 
For watershed discretizations, the metadata is 

separated into four sections: Delineation and 
Discretization, Parameterization, Results, and 
Breakpoints. The breakpoint information is not 
displayed in the AGWA Metadata viewer (Figure 
76).  

 
View watershed metadata 
Watershed metadata can be viewed by going to 
AGWA Tools>View metadata. This opens the 
AGWA Metadata Viewer (Figure 76). Select a 
watershed outline or watershed discretization on 
the Watershed Selection panel to view the 
metadata in the Metadata panel. The metadata 
cannot be edited except for the user comments.  

 

 

A 

B 

Figure 76. Metadata Display dialog. A) 
Watershed Selection panel; B) Metadata panel. 

 
Delineation and discretization metadata 

includes the DEM name, flow direction name, flow 
accumulation name, the stream map, the DEM 
resolution, the date the watershed was created, 
the model the watershed was parameterized for, 
the CSA as area and percent, the units of the CSA 
area, the watershed area, the number of streams 
in the associated stream network, the hydraulic 
geometry relationship, if the watershed represents 
a watershed group, if the watershed contains 
channel buffers, if the watershed was created with 
ponds or reservoirs, the current landcover 
parameterization, the current soils 
parameterization, the selected KINEROS flow 
length method, if elevation bands exist and if HRUs 
exist. If the watershed is a watershed group, the 
CSA, area and stream number values are stored 
for each watershed in the group. 

 
Results metadata includes the precipitation file 

used, the landcover and soils themes used and the 
date the simulation was created. Additional 
information is described in the View simulation 
metadata section.  

 
KINEROS Results metadata includes a list of 

parameter files generated for the selected 
watershed. This list includes the full path name, the 
landcover and soils themes used, and the dates 
the files were created. 

 
Add user comments 
User comments can be added or edited from the 
Metadata dialog. Once a watershed has been 
selected, click Edit comments. Enter any 
comments in the provided text field (although the 
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field appears small, it can accomodate lengthy 
comments). Click OK when satisfied with the 
comments. To remove comments, delete all text 
from the field and click Cancel. The comments 
section will be automatically updated. 

 
View simulation metadata 
Simulation metadata can be viewed in either the 
Metadata Viewer described above or from any of 
the results dialogs (View Results, Differencing, or 
Unbuffered vs. Buffered Comparisons) or, for 
SWAT simulations, through the Rerun Simulations 
dialog. The option is presented as a View button, 

Description button, or an Identify button ( ) 
next to the simulation combobox. Only metadata 
for the selected simulation is displayed, including 
KINEROS multipliers.  

 
Metadata for differenced results includes only 

the equation used (as shown in the Differencing 
dialog), the type of equation (absolutte change or 
percent change), and the date the results were 
created. The simulations used to calculate the 
results can be found in the equation. 

 
Metadata for KINEROS simulations includes the 

parameter file/precipitation file pair, the duration of 
the event, the landcover and soils themes used to 
generate the parameter file, the multipliers used 
when generating the parameter file, the date the 
parameter file was created and the date the 
simulation was created. A list of multipliers is 
provided for each parameter file. 

 
Metadata for SWAT simulations includes the 

landcover and soils themes used, the precipitation 
file used, the number of years in the simulation, the 
start date of the simulation, the output frequency, if 
nitrogen and phosphorus simulation occurred, if 
HRUs were used, if elevation bands were used, if 
the simulation was rerun (and the original 
simulation), and the date the simulation was 
created.  
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Managing AGWA Datasets 
 
AGWA watersheds have several files associated 
with them, including stream network, 
parameterization tables, simulation inputs and 
outputs and metadata. These files are stored in 
specific locations within an AGWA project 
directory. To transfer datasets from project to 
project or user to user, AGWA now provides an 
export/import tool (Figure 77) that can package all 
required watershed files. The tool can be used for 
both watershed outline grids and for watershed 
and stream network pairs. Use of this functionality 
is strongly encouraged if AGWA datasets are to be 
transferred. 
 

 
Figure 77. Manage AGWA Datasets dialog. A) 

Export Watershed panel; B) Import Watershed 
panel. 
 
Package a watershed for export 
To ensure that a watershed moved from one 
project to another will be usable by AGWA, you 
must export it using the AGWA tool (Export 
Watershed panel). This option copies the 
watershed, stream and metadata files to an export 
directory to a user-specified location. This directory 
can then be transferred to another user, project 
directory or computer without losing any of the 
necessary files. We recommend compressing the 
export directory before sending the files as an 
email attachment to avoid file corruption. 

 

Simulation and parameterization files can also 
be exported for discretized watersheds. The 
simulation files will be copied to a new directory in 
the specified location called 
simulations/<simulation name>. If this option is not 
checked, alll simulation and parameterization will 
be removed from the metadata. 

 
To export a watershed, select the grid or 

shapefile from the combobox (Export Watershed 
panel). Enter the full path name to the directory 
that will contain the exported files. This directory 
must already exist. If exporting a discretized 
watershed, you can opt to export the 
parameterization and simulation files at this time. 
Enter a name for the export and click Export. 
 
Import an AGWA watershed 
Because AGWA searches for the watershed 
components in specific places, exported files 
should be imported using the AGWA management 
tool (Import Watershed panel). This tool moves the 
exported files to the proper locations in the current 
AGWA project. 

A 

 
Use the Browse button to locate the watershed 

to import. The directory must be uncompressed 
before this step. The selected watershed will be 
displayed in the dialog. Click Import to transfer the 
files to the current project’s directories. AGWA will 
place all files in the appropriate directories, 
including metadata and simulation files. To import 
a watershed outline, check the “Watershed 
Outline?” box and locate the grid when prompted. 
Click Import to add the watershed outline to the 
view. It is important that the input grids (DEM, flow 
direction, flow accumulation, and stream map) 
used when creating the watersheds are available 
in the new project. 

B 
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Advanced Options 
 
The advanced options for AGWA include the 
Landcover Modification Tool, the SSURGO Tool, 
Hydraulic Geometry relationships and AGWA 
preferences. The Landcover Modification Tool 
allows users to modify an existing landcover 
surface to account for fire, urbanization, climate 
change or other natural or anthropogenic changes. 
The tool can be used with the supported AGWA 
datasets (MRLC, NALC, etc.) or with custom-
defined landcovers, provided the custom lookup 
tables conform to the AGWA standard. The 
SSURGO Tool was designed to resolve certain 
issues with SSURGO datasets in AGWA as well as 
to improve the overall user experience. With the 
tool, users can merge spatial and tabular datasets, 
import SSURGO tables, and correct two errors in 
the spatial dataset that prevent AGWA from 
successfully parameterizing a watershed.  
Hydraulic geometry relationships can be defined 
and reset using this option. The AGWA 
preferences include the KINEROS baseflow option, 
model-specific warnings, the ability to change the 
DAT default files for SWAT, and the ability to select 
a flow length method for KINEROS. These options 
are described in more detail below.   

 
 

Landcover Modification Tool 
The Landcover Modification Tool (LCMT) was 
originally designed to be used as a separate 
extension to AGWA for ESRI's ArcView GIS 
software. The tool was combined with AGWA for 
version 1.4 as part of the Advanced Options 
component. The LCMT allows users to modify a 
landcover map and run AGWA to determine the 
hydrologic effects of the landcover change. The 
LCMT is accessed through AGWA 
Tools>Advanced Options>Landcover 
Modification Tool. See Figure 78 for the LCMT-
AGWA workflow. 

 

 
 

Figure 78. Landcover Modifcation workflow 
within AGWA. 

 
Any landcover supported by AGWA can be 

modified with the tool, including custom 
landcovers. The classification choices for the 
modified surface are limited to those classifications 
found in the selected landcover lookup table; users 
can modify these tables or create new tables to 
include different classes and parameter values. An 
example of this type of modification can be found 
in the included MRLC_FIRE table. 

 
The Landcover Modification Tool dialog offers 

five modification options: 
 
• Change all of the landcover in an area to a 

new landcover type using an interactively 
drawn polygon 

• Change one landcover type in an area to a 
new landcover type 

• Change all of the landcover in an area to a 
new landcover type using a polygon map  

• Change all of the landcover in an area to 2-
3 new landcover types in a spatially 
distributed random pattern 

• Analyze an area using a burn severity map 
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To proceed, zoom in on the area of interest, 
select which type of landcover modification you 
would like to perform, and click the Continue 
button (Figure 79). 

 

 
Figure 79. Landcover Modification Tool 

Selection dialog. 
 
Change all of the landcover in an area to a 
new landcover type using an interactively 
drawn polygon 
When this option is selected, the user is 

presented with the following screen (Figure 80): 
 

 
Figure 80. LCMT Change landcover based on 

interactively drawn polygon dialog. A) Landcover 
Selection panel; B) Landcover Change Information 
panel. 

 
Select a landcover surface to modify in the first 

combobox on the Landcover Selection panel. 
Select the landcover classification of the selected 
surface (the lookup table for this classification 
should be loaded in the project before running the 
tool). Select the landcover type to change and the 
landcover type to replace it on the Landcover 
Change Information panel. Enter a name for the 
new surface. Click OK to begin drawing a polygon 
around the area you wish to analyze (Figure 81). 
Double-click to finish the polygon. The LCMT will 

create a new landcover map with the landcover 
type specified. This map can then be used during 
landcover and soils parameterization. 

 

 
Figure 81. LCMT Draw polygon dialog. 
 
Change one landcover type in an area to a 
new landcover type 
When this option is selected, the user is 

presented with the following screen (Figure 82): 
 

 

A 

B 

Figure 82. LCMT Change entire area dialog. A) 
Landcover Selection panel; B) Landcover Change 
Information panel. 

 
Select the landcover grid to modify on the 

Landcover Selection panel. Select the landcover 
classification of the selected surface (the lookup 
table for this classification should be loaded in the 
project before running the tool). Select the new 
landcover type on the Landcover Change 
Information panel. Enter a name for the new 
surface. Click OK to begin drawing the polygon 
around the area you wish to analyze. The LCMT 
will create a new landcover map with the landcover 
type specified. This map can then be used during 
landcover and soils parameterization. 

A 

B 

 
Change all of the landcover in an area to a 
new landcover type using a polygon map  
When this option is selected, the user is 

presented with the following screen (Figure 83): 
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Figure 83. LCMT Change landcover based on 

polygon map dialog. A) Landcover and Polygon 
Map Selection panel; B) Landcover Change 
Information panel. 

 
Select a polygon theme to define the 

modification area on the Landcover and Polygon 
Map Selection panel. Select the landcover map to 
modify. Select the landcover classification of the 
selected surface (the lookup table for this 
classification should be loaded in the project 
before running the tool). Select the new landcover 
type on the Landcover Change Information panel. 
Enter a name for the new surface. Click OK to 
create the new landcover map. The LCMT will 
create a new landcover map with the landcover 
type specified. This map can then be used during 
landcover and soils parameterization. 

 
Change all of the landcover in an area to 2-3 
new landcover types in a spatially 
distributed random pattern 
This option provides two types of random 

distributions – completely spatially random 
surfaces and multifractal randomly distributed 
patchy surfaces. The multifractal surface is 
generated with the Landcover Modification Fractal 
executable (LCMF) that is provided on the AGWA 
website. See Appendix C: Landcover 
Modification Fractal Component for a description 
of the LCMF model. 

 

 

A 

A 

B 
B 

C 

Figure 84. LCMT Random Pattern dialog. A) 
Lancover Selection panel; B) Landcover Change 
Selection panel; C) Random Parameter Selection 
panel. 

 
First, select the landcover surface and 

classification on the Landcover Selection panel 
(Figure 84). Select the number of classes to use 
during modification on the Landcover Selection 
panel. Click Accept to enable the landcover type 
selection controls. Select the new landcover types 
and enter a percentage for each on the Landcover 
Change Selection panel. The combination of these 
values must sum to 100. 

 
Select a random distribution on the Random 

Parameter Selection panel. Random pattern 
refers to the completely spatially random surface. 
This option does not require any additional inputs. 
Patchy fractal refers to the multifractal surface 
option. To use this option, select an H value using 
the slider. This value indicates the size of the 
patches in the final surface, where patch size 
increases as H increases. Enter any negative 
integer value to act as the random seed.  

 
Enter a name for the new surface. Click 

Process to create the new surface.  
 
Analyze an area using a burn severity map 
This option modifies a landcover surface based 

on a burn severity map. The new landcover types 
are based on the combination of pre-fire conditions 
and the burn severity for each cell in the landcover 
grid.  
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Two additional inputs are required to use this 
option: a burn severity polygon theme (see Figure 
85 for an example attribute table) with a 
GRID_CODE field containing unique integer 
identifiers and a CLASS field containing a string 
descriptor of the burn severity (i.e. low, medium, 
high, or unburned) and a change table describing 
the transition from the unburned type to the burned 
type. The change table (Figure 86) consists of 
three fields: PREBURN, POSTBURN, and 
SEVERITY. PREBURN and POSTBURN contain 
the integer identifiers found in the landcover lookup 
table; SEVERITY contains the string descriptors as 
found in the burn severity map. Both PREBURN 
and POSTBURN must have corresponding values 
in the associated landcover lookup table to be 
used within AGWA. 

 

 
Figure 85. Example of a burn severity polygon 

theme’s attribute table. 
 

   
Figure 86. Example of a change table (left) for 

the Burn Severity component and the 
corresponding values in the landcover lookup table 
(right). 

 

 
Figure 87. LCMT Burn Severity dialog. A) Burn 

Severity and Landcover Selection panel; B) 
Landcover Name panel. 
 

First, select a burn severity map on the Burn 
Severity and Landcover Selection panel (Figure 
87). Only polygon themes with the required fields 
will be available. Select a landcover modification 
grid, the associated landcover lookup table and the 
change table. When satisfied, click Accept. Enter 
a name for the new grid (8 character maximum) on 
the Landcover Name panel. Click OK to generate a 
new surface. The final map can then be used 
during landcover and soils parameterization. 

 
SSURGO Tool 
The SSURGO tool provides several different 
functions designed to facilitate the use of the 
dataset with AGWA. Users can import SSURGO 
tables independently of landcover and soils 
parameterization, merge spatial and tabular 
datasets, fill internal voids, and extend the edges 
of a spatial dataset beyond the boundary of a 
given watershed. The tool cannot resolve any 
errors within the datasets, particularly those 
involving the data tables. It is the user's 
responsibility to provide properly formatted files for 
use in AGWA. Go to AGWA Tools>Advanced 
Options>SSURGO Tool (Figure 88). 

 

 

A 

B 

C 

A 

B Figure 88. SSURGO Dataset Tool dialog. A) 
Import Tables panel; B) Merge Datasets panel; C) 
Clean Shapefiles panel. 
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Import SSURGO Datasets 
To import SSURGO tables, enter a name for 

the set of tables (component.dbf, chorizon.txt, and 
chtexgrp.txt) on the Import Tables panel. Click 
Browse and navigate to the component.txt file. 
AGWA assumes the other tables are located in 
that directory. The full path of the component.txt 
file is displayed in the dialog. Click Import to 
import the tables. This process is identical to that 
undertaken during landcover and soils processing. 
The imported tables are added as <new 
name>_comp, <new name>_hor and <new 
name>_tex and are ready to be used during 
parameterization. 

 
Merge SSURGO Datasets 
To merge spatial datasets, add all of the 

SSURGO shapefiles or coverages to the view. 
From the listbox (Merge Datasets panel), select 
two or more datasets (hold down Shift to select 
more than one). Enter a name for the new dataset 
and click Merge. The new shapefile will be added 
to the view. The attribute table will contain only the 
MUKEY field as this is the only attribute required 
by AGWA. The merge process may produce 
internal voids in the dataset; this can be resolved 
in the SSURGO tool or can be fixed during the 
parameterization process. 

 
To merge tabular datasets, first import all of the 

table sets using the import option described above. 
This should help ensure that the tables are 
properly formatted for AGWA. Only the component 
tables are listed for clarity. Select two or more 
tables. Enter a name for the new table set and click 
Merge. The selected tables will be merged into 
one set as <new name>_comp, <new name>_hor, 
and <new name>_tex. These tables can now be 
used during parameterization. 

 
Correct Internal Voids 
Internal voids can be the result of dataset 

merging or lack of data. The presence of a void 
raises the same error as datasets that do not 
completely cover a watershed and must be fixed 
before parameterization can be successfully 
performed. Select the SSURGO dataset to test 
(Clean Shapefiles panel). Enter a name for the 
new dataset and click Fill voids. Any voids found 
within the dataset will be replaced by a new 
polygon. The MUKEY for this polygon will be set to 
the MUKEY of the existing SSURGO polygon with 
which it shares the longest edge. The repair 
process is shown in Figure 89. 

 

 
Figure 89. Internal void repair. A and B are 

original SSURGO polygons; C is the internal void 
and A' is the new polygon with the MUKEY from A. 

 
Extend SSURGO Edges 
This option ensures that the selected SSURGO 

dataset extends beyond the watershed boundary. 
The tool identifies the areas of the watershed not 
covered by the selected SSURGO theme. Using 
those areas, any SSURGO polygons that do not 
extend past the watershed boundary are identified. 
New SSURGO polygons are created to extend the 
affected polygons beyond the watershed boundary 
(the boundary is buffered to 100m). The new 
polygons are assigned a MUKEY based on the 
existing SSURGO polygon with which it shares the 
most edge. Figure 90 shows the edge extension 
process. The new SSURGO theme is specific to 
the selected watershed. 
 

 
Figure 90. SSURGO extension process. A and 

B are original SSURGO polygons; C is the 
watershed boundary; D is the buffered watershed 
boundary and E and F are the new SSURGO 
polygons. 

 
Select the SSURGO dataset to correct (Clean 

Shapefiles panel). Enter a name for the new 
dataset and click Extend Edges. When prompted, 
select the watershed to match the edge to. 

 
Hydraulic Geometry Relationships 
Hydraulic geometry relationships affect the width 
and depth of a watershed's stream network. This 
relationship should only be modified by those very 
familiar with their area of interest. This option 
allows users to set the default geometry, define a 
new hydraulic geometry, and modify geometries of 
existing watersheds (Figure 91). 
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Figure 91. Hydraulic Geometry Relationships 

Preferences dialog. 
 
The default geometry is set to the Walnut Gulch 

relationship until a new geometry is selected 
(Figure 92). Until the default relationship has been 
set, AGWA will query the user to select a 
relationship for each discretization. The default can 
be removed by clicking the Cancel button in the 
Hydraulic Geometry Relationship dialog.  

 

 
Figure 92. Hydraulic Geometry Relationships 

Options dialog. A) Default Relationship panel; B) 
Predefined Relationship Selection panel; C) New 
Relationship Definition panel. 

 
To add a new relationship, select Advanced 

Relationship. The dialog will expand to reveal the 
Predefined Relationship Selection panel. Click 
Create New and enter width and depth coefficients 
and exponents in the New Relationship Definition 
panel. Click Process to store the relationship. The 
relationship will be saved in the HGR.dbf for future 
use. Also, should the user wish to modify an 
existing relationship for the current discretization 
only, this can be accomplished by clicking the 
Custom buttons to enter new coefficients and 
exponents. 

 
Preferences 
AGWA preferences include warning message 
reporting, KINEROS baseflow and SWAT CROP 
file defaults (Figure 93). 

 

 

A B 

C 

D 

E 

A 
Figure 93. AGWA Preferences dialog. A) 

KINEROS Baseflow panel; B) Warning Messages 
panel; C) SWAT Landcover Options panel; D) 
KINEROS Flow Length Method Selection panel; E) 
File Management panel. B 

 
KINEROS Baseflow 
This is an option for advanced users. This 

option deactivates channel infiltration for a given 
channel element. To use baseflow, you must first 
check the Use baseflow? On the KINEROS 
Baseflow panel. This option will remain activated 
until you uncheck the box. Additional information 
must then be added to the KINEROS stream 
attribute table. In this table, AGWA sets a default 
value of -999.00 for the QBASE field. For baseflow 
to be modeled, the checkbox must be selected and 
the QBASE field modified. To enable baseflow for 
a channel, change the default value based on the 
following ranges: 

C 

 
• Values < 0: baseflow is not written to the 

KINEROS parameter file for the current 
channel, infiltration is active in this channel. 

• Values = 0: baseflow is written to the 
KINEROS parameter file with a value of 0 
for the current channel, even though there 
is no contributing baseflow 

• Values > 0: baseflow is written to the 
KINEROS parameter file with the values in 
the stream attribute table for the current 
channel, resulting in no infiltration in this 
channel and a flow (m3/s) equal to the value 
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in the stream attribute table being added to 
the channel. 

 
Note that each record in the stream attribute 

table corresponds to a channel in the KINEROS 
parameter file. The entire reach is composed of all 
the channels in the stream attribute table, so a 
reach may have gaining (QBASE >= 0) or losing 
channels (QBASE < 0) if positive and negative 
values appear in the QBASE field for different 
records. 

 
KINEROS applies an interpolation routine to the 

baseflow values by linearly interpolating between 
the value at the upstream node of the channel and 
the value of the next downstream element. If no 
baseflow (negative QBASE) is detected in the next 
downstream channel, baseflow is not interpolated 
and goes from the value in the upstream channel 
to zero abruptly. To avoid this, set the baseflow in 
the downstream channel to zero to enforce 
interpolation. 

 
For more information regarding KINEROS 

baseflow, refer to the KINEROS website at 
http://www.tucson.ars.ag.gov/kineros/. 

 
Warning Messages 
These checkboxes allow users to turn off 

warnings and informational messages during 
AGWA processes. When checked, warnings may 
appear if the user is attempting to apply SWAT or 
KINEROS with inappropriate datasets. The 
warnings do not prevent the use of AGWA. 
Warnings include: creating KINEROS watersheds 
with areas greater than 100 km2, extremely high or 
low channel or plane slope values in KINEROS, 
and soil or landcover datasets that do not 
completely contain the watershed. Check one or 
both of the options to turn on warning messages 
on the Warning Messages panel. 

 
SWAT DAT Defaults 
This option allows you to use modified DAT files 

when running SWAT with hydrologic response 
units or for water quality purposes. During those 
simulations, the default crop value and urban 
values can be modified based on landcover for 
each subwatershed or HRU. The default DAT files 
are provided by SWAT and can be found in the 
AGWA datafiles directory. These files should only 
be modified by those very familiar with the study 
area and the parameters involved. See the SWAT 
User's Manual for detailed information concerning 
the DAT files and their formats. 

 

Setting the default DAT location 
The default is set upon loading the AGWA 

extension to the crop2000.dat file found in the 
datafiles directory. To change the file, click Set 
default on the SWAT Landcover Options panel. 
Navigate to the new crop2000.dat file (even when 
modified, the file name should remain the same). 
The full path name is displayed below the buttons. 
AGWA assumes the other DAT files are located in 
the same directory as the crop2000.dat file. 

 
Editing Landcover Lookup Tables 
AGWA provides two tools to edit existing 

landcover tables to add or modify CROP, URBAN 
and URBANLU fields on the SWAT Landcover 
Options panel. Both tools utilize the default  DAT 
file information.  

 

 

A 

B 

Figure 94. Edit CROP Field dialog. A) 
Landcover Lookup Table Selection panel; B) 
CROP Editing panel. 

 
To add CROP values to a lookup table, click 

Edit Crop in the Preferences dialog. Select a 
lookup table from the provided list (only lookup 
tables found in the project can be modified) from 
the Landcover Lookup Table Selection panel 
(Figure 94). Click Accept. Double-click in a row to 
set the CROP for the landcover type on the CROP 
Editing panel. Select from the available choices. 
The CROP value will be added to the listbox. If 
satisfied with the edits, click Save Edits to update 
the lookup table. To restore the original values, 
click Restore. When finished, click Done. 
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Figure 95. Edit URBAN and URBANLU Fields 

dialog. A) Landcover Lookup Table Selection 
panel; B) URBAN and URBANLU Editing panel. 

 
A similar process occurs for the URBAN and 

URBANLU fields (Figure 95). If the URBAN value 
is 0, no additonal information is required. 
Otherwise, the type of urban landuse type 
(URBANLU) must be selected. Double-click in the 
URBANLU cell to select an urban landuse type. 

 
KINEROS Flow Length 
AGWA provides two options for calculating flow 

length for lateral elements in KINEROS. The 
default method is a geometric abstraction of the 
elements. Initial testing indicates that the geometric 
abstraction provides better results for both 
unbuffered and buffered AGWA watersheds. This 
method must be used for any KINEROS watershed 
to be buffered. The second method calculates the 
mean flow length of each lateral element. Previous 
studies have shown this method of calculating the 
mean flow length for each lateral element to 
perform better than other mean flow length options, 
excluding the geometric abstraction method (Syed, 
1999). The original AGWA flow length method is 
not available in AGWA 1.5. See a detailed 
description of the flow length methods in 
Watershed Delineation and 
Discretization>Basic Concepts>Flow Length. 

 
To change the default flow length method, 

select one of the provided flow length methods on 
the KINEROS Flow Length Method Selection 
panel. This method will be used until the selection 
changes. To view the flow length method used to 
calculate values for a specific watershed, view the 
watershed's metadata using AGWA Tools>View 
metadata. The options are identified as 
“Geometric abstraction” for the default method and 
“Mean flow length” for the calculated average. The 
flow length method cannot be changed once a 
watershed has been successfully created. 

File Management 
AGWA generates a number of temporary files 

during the various processing steps. These files 
are deleted from the project, but remain in the 
working directory following the completion of the 
given process. To avoid any confusion when 
clearing out the working directory, AGWA provides 
a file management option to delete these files from 
the working directory. First, save the AGWA 
project. The names of the temporary files can be 
viewed by clicking View on the File Management 
panel. Click the Delete button to remove any 
temporary files that were created during the current 
AGWA session. Only those files that can be 
deleted will be (for instance, if the file is in use by 
the current project, it will not be deleted). The 
temporary files are retained until the Delete button 
is clicked. 

A 

B 
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Troubleshooting 
 
Tips and Tricks 
Download the most up-to-date version of AGWA 
from http://www.tucson.ars.ag.gov/AGWA. This 
can resolve many errors. 

 
Carefully inspect the watershed and stream 

shapefiles before continuing with any other AGWA 
steps. Watersheds with internal planes missing or 
with misnumbered elements will not provide 
acceptable results even if parameterization and 
simulation proceeds normally. It is absolutely 
necessary to project all input datasets to a suitable 
projection with units in METERS. In most cases, 
creating flow direction and flow accumulation grids 
in AGWA with the properly projected DEM grid is 
necessary.  

 
DEM handling  
In many situations, a watershed will fall across 

more than one DEM. These grids must be 
mosaiced before the watershed can be delineated. 
An ArcView extension, Grid Utilities by Min-Lang 
Huang (huang@dprc.ncku.edu.tw), provides the 
necessary functionality to mosaic DEMs. The 
extension, grid01.avx, and its documentation are 
available for download from the AGWA website 
and through the ESRI support website 
(http://support.esri.com). 

 
Clipping the DEM, and other input grids, to a 

small buffer around the watershed will reduce 
processing times. Care should be taken if clipping 
the DEM prior to delineation to avoid inadvertently 
excluding some areas of the watershed. The Grid 
Utilities tool described above can be used to clip 
grids. 

 
Flow direction and flow accumulation grids 

generated from AGWA can be used more than 
once. Avoid generating these files more than once 
to save hard drive space. 

 
Naming Files 
Filenames should not contain any spaces. This 

includes anywhere within the full path name.  
 
Try to minimize name lengths. Certain 

situations require short file names. This is 
particularly true for SWAT. 

 
AGWA provides several datasets. The names 

of these datasets, particularly dBASE tables, 

should not be used. They include: tarea, delta, ints, 
calcws, dsgnstrm.dbf, kin_lut.dbf, swatpptfiles.dbf, 
and wgnfiles.dbf. 

 
Managing Themes 
Grids and coverages – These files should not 

be moved using Windows Explorer unless the 
entire directory containing the grid or coverage and 
the INFO file is moved or copied. If you must move 
a grid or coverage, use the Manage Data Sources 
option under File from an active view. Failure to do 
so will render the dataset unusable by ArcView. 

 
Shapefiles – If moving an AGWA watershed 

(and its associated stream network and metadata), 
use the provided Manage AGWA datasets option. 
This exports and imports AGWA watersheds and 
places the files in the correct locations for use in 
AGWA. If moving other shapefiles, be aware that 
shapefiles consist of five data files – *.shx, *.shp, 
*.sbn, *.sbx, and *.dbf. All of the files must be 
copied, moved, or deleted as a unit. 

 
SWAT Precipitation Files 
These files contain the average latitude, 

longitude and elevation of the watershed. The 
average elevation is derived from the DEM, and 
the precipitation values are adjusted for elevation 
in subwatersheds where elevation bands are 
defined. The latitude and longitude values are not 
used by the model. Due to the difficulty of 
converting projected data to geographic 
coordinates in ArcView, AGWA uses fixed values 
in the precipitation file. These values do not reflect 
the true location of the selected watershed. 

 
Data projections 
One of the problems with downloading spatial 

data from different sources is that the data is not 
always in a common projection. The NLCD 
dataset, for example, comes as either Interrupted 
Goode Homolosine or Lambert Azimuthal Equal 
Area projection while the STATSGO data are in 
Albers Equal Area. AGWA assumes the user has a 
working knowledge of data projections. It is crucial 
that all spatial data share a common projection and 
that the projection units are in meters. Failure to 
properly project data will result in unusable 
watersheds. 
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Very Small Watersheds or Subwatersheds 
These watersheds are difficult to delineate in 

AGWA. This is due, in part, to the high threshold of 
the stream network grid default. This value can be 
set during the delineation process to a lower value.  

 
Small subwatersheds, due to a small CSA, 

increases the potential for discretization and 
parameterization errors. Discretization errors 
include improper watershed configurations, 
misnumbered elements and sequencing errors. 

 
No Data in Results 
In certain rare situations for specific CSA values 

there can be errors in the watershed configuration 
that prevents KINEROS from running to 
completion. Rediscretize the watershed with a 
different CSA until the error is resolved. 

 
Errors 
Error messages are indicated in blue. 

 
Landcover grid cellsize is too large for the 
subdivided watershed. 
This error message appears when the CSA is 

very small compared to the resolution of the 
landcover grid. This interferes with AGWA's ability 
to determine the element averages. Two options 
are available for resolving this error: 

 
1. Rediscretize the watershed with a CSA 

such that no individual plane is smaller than 
the landcover resolution. 
 

2. Resample the landcover grid to a higher 
resolution (smaller cellsize). This does not 
'improve' the dataset or otherwise affect the 
parameterization algorithms. If the Grid 
Utilities extension has been added to the 
project, select the landcover grid in the 
table of contents and then go to 
Grid>Change Cell Size to enter a new 
value. (This can also be done with the 
functionality available through Spatial 
Analyst by setting the Analysis>Properties 
cell size to the desired values and 
generating a new grid with the Map 
Calculator.) 

 
Error calling unlink for <filename>: Returned 
Error Code 13. 
The errors occur when an error occurs during 

an AGWA process, which terminates before file 
cleanup can occur. First, make note of the filename 
indicated by the error message. Check the 
watershed and stream attribute tables for joins and 

remove any if found. Save the project and try 
again. If the error still occurs, quit ArcView and 
navigate to the directory indicated by the filename. 
In many cases, this will be the working directory of 
the project. Delete any files with names beginning 
with “delta” or the specified filename. Doing so 
does not damage the project. Restart the project. 

 
There was an error running KINEROS. Please 
try again.  
This is most likely due to ill-defined topography 

and channel routing for the watershed. This occurs 
with very linear stream networks or where the 
topography is relatively flat. Indications can include 
plane elements that remain unsplit or the channel 
routing is incorrect. The problem can be fixed by 
rediscretizing the watershed at a higher CSA. 

 
AGWA has detected an error with the sand, silt 
and clay fractions not summing to one. 
This error can occur when DEM and soil 

datasets are improperly projected, causing errors 
during intersection or when the soils dataset is 
missing data related to the soil fractions. During 
soils and landcover parameterization, this can 
cause the sand, silt and clay fractions to exceed 
the specified limits (fractions should be between 
0.7 and 1.3, where 1 is ideal). While KINEROS will 
run these watersheds, the results will not be valid. 
Check the temporary soils tables created by 
AGWA as well as the intersection theme (“ints” + 
number) for potential errors. If you have modified 
the soils tables in any way, for example to use 
existing STATSGO components for a custom soils 
theme, make sure that the sum of the soil 
component percentages approaches 1. 

 
The watershed does not lie entirely within the 
soil theme. 
This error can be caused by one of two 

situations – the soil theme contains voids between 
polygons or the soil theme does not extend beyond 
the boundaries of the selected watershed. This 
causes the parameterization to have missing or 
zero values, which results in inaccurate 
parameterizations. In rare instances, this can 
cause AGWA to crash. The problem is most critical 
when parameterizing a SWAT watershed with a 
SSURGO dataset. If the error occurs in this 
situation, the user can resolve most issues by 
taking advantage of the provided SSURGO Tool. 
This tool can fill internal voids, extend the edges of 
the SSURGO dataset beyond the boundary of a 
selected watershed, and merge multiple SSURGO 
datasets. These steps should not be performed 
manually due to inconsistencies in the spatial and 
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tabular dataset formatting. The DEM can also be 
clipped to a size smaller than the soils dataset 
before delineating and discretizing the watershed 
should that be desired. 

 
Invalid AGWA metadata 
Some required component in the watershed's 

ODB file is missing or corrupt. This cannot be 
corrected. A new watershed must be discretized. 

 
Error generating valid name 
An error occurred when checking for illegal 

characters or file name length. Try entering a new 
name string in the textbox. 

 
Could not locate <name>. The specified file 
could not be located.  
In most cases, the file should be added to the 

project. If the missing file is an AGWA metadata 
file, the watershed cannot be used until the correct 
file is placed in the current working directory 
(av_cwd). The watershed cannot be used again if 
the ODB file no longer exists. 

 
If this error refers to the _SWAT exe, AGWA will 

is unable to store the location of  the SWAT 
executable. Save and restart the project. You 
should be able to run SWAT once the project has 
reopened. 

 
GRID ERROR - Unable to set analysis window 
This error can occur after a processing step in 

AGWA fails and refers to an issue with the Spatial 
Analyst settings. To resolve this issue, first save 
the project. Restart and try to repeat the error. If it 
occurs again, it is necessary to delete the view and 
its contents, save the project and reopen it.  

 
Watershed Discretization Errors 
Despite efforts by the AGWA developers, some 

errors are not captured. In most cases, these 
errors are first noticed when running KINEROS or 
SWAT with the affected watershed. The first 
indication is typically an error message when 
running the model or the inclusion of NODATA 
values in the simulation results. Because the errors 
are due to invalid watershed configurations that 
cannot be easily corrected manually, the best 
solution is to rediscretize the watershed with a 
different CSA until achieving an appropriate 
configuration.  

 
Large Watershed Warning 
This occurs when discretizing a watershed with 

an area greater than 100 km2 for KINEROS. It 
does not prevent the user from discretizing the 

watershed but serves as a warning that KINEROS 
was not designed to be applied to watersheds 
larger than the given area.  

 
DEM Resolution Warning 
This warning occurs when the DEM resolution 

exceeds 30 meters. This is not an error, rather it is 
an indication that the selected DEM may not 
generate usable watersheds and stream networks. 
Coarse DEMs can cause problems during 
discretization for both SWAT and KINEROS that 
may later cause the parameterization or the 
simulation to fail. AGWA has been successfully 
tested with DEMs with a resolution of 30m or less, 
where smaller cellsize indicates higher resolutoin. 
This resolution is recommended. 

 
Low Elevation Warning 
This warning occurs when the selected DEM 

contains elevations at or below sea level. AGWA 
has difficulty filling, delineating or discretizing 
DEMs with low elevations or low slopes. Also, the 
kinematic wave equation used in KINEROS is not 
applicable in low slope situations or in coastal 
regions.  

 
Questions or comments regarding other 

program errors can be directed to: 
 
AGWA Help at agwa@tucson.ars.ag.gov
 
Please include the circumstances in which the 

error occurred. 
 

Additional Resources 
 

AGWA Frequently Asked Questions (FAQ) 
In many cases, AGWA errors can be resolved 

by downloading the most recent release of the 
extension from the website 
(http://www.tucson.ars.ag.gov/AGWA).  
 

What does it mean if the error message says 
scripts are missing from a dialog? 
The extension is corrupt or otherwise unusable. 

Download a new version from the AGWA website. 
 

What if AGWA doesn't recognize my 
watershed? 
First, make sure the metadata information 

exists. The project's working directory (av_cwd) 
should contain a file called 
<watershed_name>.odb. If this file is missing, the 
watershed is unusable and must be rebuilt.  
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If this occurs in a previous version of AGWA 
(1.42c or earlier), the theme comments have been 
lost. The best solution is to rebuild the watershed. 
Remember, watershed and stream themes cannot 
be added into a project once they've been deleted 
and still be used by these earlier versions of 
AGWA. To create portable watersheds, update to 
AGWA 1.5 or AGWA2.  
 

What if some comboboxes are empty? 
If a combobox is empty and you are sure that 

the appropriate data themes are in your project, try 
selecting an object from the previous dialog. In 
many cases, the choices you make affect the 
available choices later on. If you have selected an 
item in a combobox, then valid data themes for that 
option were not found in your view. Add the 
datasets and try again. 

 
What do I do if the landcover and soils 
parameterization stalls? 
If, during soils parameterization, the progress 

dialog remains open but there is no activity in the 
ArcView status bar (bottom of the application), the 
parameterization has failed. Double-check the 
tables to ensure there are no empty records, no 
duplicates, and that all of the columns have been 
written correctly. If it's a SSURGO dataset, use the 
provided SSURGO tool to import, merge and clean 
the datasets. 
 

In some cases, processing could stall due to 
overly large working directories. ArcView 
recommends working directory size limits of 100 
MB; however, that limit is not absolute. Delete 
temporary files from the working directory by going 
to AGWA Tools>Preferences. In the File 
Management panel, click Delete to remove any 
temporary files. Or, use the Manage Data 
Sources in the ArcView File menu to delete 
unnecessary files (especially files beginning 
with”intsec” or “ints”). 

 

I would like to buffer my KINEROS watershed 
but it is not listed in the watershed selection 
combobox. 
To create riparian buffers, watersheds must first 

be created for the KINEROS model. In addition, 
these watersheds must have been parameterized 
with the geometric flow length method. To 
determine which method your watershed uses, 
view the metadata for that watershed. If the flow 
length method parameter is “Mean”, you cannot 
use the watershed to create buffers. The flow 
length method must be set to “Geometric”. To set 

the default flow length method, go to AGWA 
Tools>Preferences and select the desired flow 
length method. 

 
I modified a KINEROS parameter file. Can I still 
use it in AGWA?  
KINEROS parameter files can be modified in 

any text editor (be sure to retain the .PAR 
extension). Simply save the parameter file with a 
different name in an existing simulation directory 
for the given watershed. In the Run KINEROS 
dialog, click Import file and select the modified 
parameter file. Once imported, the file will always 
be available in the parameter file combobox for 
selection. If you don't see your file in the list, make 
sure the modified file is in a simulation directory for 
the watershed (go to AGWA Tools>View 
metadata to view the list of simulations for the 
watershed). 

 
Parameter files for watershed groups follow 

specific naming conventions. When modifying 
these files, in order to ensure correct processing of 
the simulation and its results, it is best NOT to 
rename the files. Rather, a duplicate set of files 
should be copied to another location on your 
machine. Bear in mind that those files will only be 
available from within the original simulation 
directory and cannot be imported. 

 
What is an ODB file? 
These files contain metadata information 

regarding the watershed, watershed delineation, or 
AGWA project. The AGWA.odb file contains 
information regarding the preferences set for a 
given project (a new AGWA.odb file is created for 
each project directory). This allows the user to 
store preferences from one AGWA session to the 
next. Other ODB files (<watershed name>.odb) 
contain information regarding watershed attributes. 
These attributes include discretization parameters, 
current landcover and soils selections, and 
simulation details. The file is required for AGWA to 
recognize the watershed. Attribute values can be 
viewed in the Metadata viewer (AGWA 
Tools>View metadata). The watershed ODB files 
should not be deleted unless the watershed is 
being deleted. They cannot be rebuilt for an 
existing watershed. 

 
I'm using a SSURGO theme for 
parameterization, but get an error containing 
“Got a(n) Nil, expected a(n) Field”.  
First, make sure you have the latest AGWA 

extension. SSURGO datasets are available in 2 
versions—your version may be in the version that 
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is not supported by earlier AGWA versions (before 
1.42c). If the problem still occurs, check the 
SSURGO tables that were imported into AGWA. 
To aid in tracking down the problem, try running 
the provided SSURGO dataset with the San Pedro 
dataset. Compare the Access database files, the 
provided text files and, finally, the imported tables.  

 
I get an error during the landcover and soils 
parameterization that says “Unable to continue”.  
If this error occurs during the landcover 

parameterization process (AGWA Progress Bar 
says “Intersecting the Land Cover with the 
watershed”), the landcover grid is too large for 
ArcView to process. If the grid extends a 
considerable distance beyond the watershed 
boundary, clip the grid to a size just large enough 
to fully contain the watershed. Next, reset the 
cellsize of the grid. Use the provided Grid Utilities 
extension (go to Grid>Change Cell Size) and 
create a new grid with a larger cellsize. Landcover 
with a resolution of 60m or higher generally work 
better. This error is most likely to occur with 
watershed groups.  

 
I've created a lot of watersheds. Is there any 
way to remove the files AGWA no longer 
needs? 
Yes. Any temporary files created during AGWA 

processes can be deleted during an AGWA 
session by going to AGWA Tools>Preferences. A 
Delete button is located on the File Management 
panel. Clicking this button will delete any files 
created to that point that can be deleted (if a 
dataset is loaded into the project, it will not be 
deleted). Temporary files are deleted at the end of 
each AGWA session, as the project terminates. 

 
I'm trying to create a KINEROS watershed 
using a SWAT subwatershed but AGWA 
crashes.  
Some SWAT subwatersheds cannot be used to 

create a new watershed. In some cases, this is 
caused by the outlet location; in others, the size of 
the watershed results in incorrect channel 
formation. Adjusting the CSA with these errors 
probably will not resolve the problem. The best 
option is to simply use the SWAT subwatersheds 
to identify outlet locations and create a new 
watershed.  

 
My watershed is incorrect—it appears 
rectangular and does not include the outlet 
location. How can I fix this? 
Some processes, particularly watershed 

discretization, make use of the Analysis mask 

feature. Unfortunately, the mask cannot always be 
reset due to a known error in ArcView. The best 
option is to remove the mask from the view by 
going to Analysis>Properties and setting the 
extent to the extent of the View (or any theme that 
would completely encompass the watershed) and 
resetting the mask to “No mask set”.  

 
When discretizing watersheds, I get an error 
saying “Invalid stream network” accompanied 
by a list of numbers. What's wrong with my 
watershed? 
An invalid stream network basically contains 

more than one branch. The numbers refer to the 
ARCIDs of the unconnected streams. In some 
cases, two separate branches exit the watershed 
close to the specified outlet location but never 
connect. The only solution is to adjust the outlet 
location and redelineate the watershed. If the error 
occurs when using a SWAT subwatershed, the 
best option is to use the subwatershed to identify 
the outlet and use that to create a new watershed 
from a point location. 

 
This error can also occur when creating nested 

or multiple watersheds, but, in this case, the error 
is not related to the outlet. The error here is 
generally along the edge of the watershed where 
two or more streams end at the boundary without 
connecting. Sometimes, the error can be corrected 
by increasing the CSA (usually significantly); 
however, this often does not adequately resolve 
the problem, as the discretization may contain 
other fatal errors that had not yet been identified. 
You can discretize the problem watershed 
separately from the watershed group (with that 
group rediscretized without the problem 
watershed) and append the new watershed to the 
group with the Edit watershed group option. 

 
My watershed has “holes” (or missing plane 
elements) in it. Can I still use it? 
A watershed with missing elements should not 

be used for parameterizing or simulation. (The 
error does not refer to watersheds created with 
non-releasing ponds.) This error is most likely due 
to a projection conflict that ArcView is unable to 
resolve or due to the use of input rasters that use a 
geographic projection. A clear indication of this is if 
the outlet used to delineate the suspect watershed 
falls well within the watershed outline instead of at 
the most downstream point.  

 
To correct the problem, reproject the DEM to an 

appropriate projection. Then, recreate the filled 
DEM, flow direction grid and flow accumulation 
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grids based on the projected DEM in AGWA. If the 
flow direction grid or flow accumulation grid is not 
recognized by AGWA (it is not found in the 
appropriate combobox), the selected projection is 
still in error. Reproject all other inputs to the new 
projection before using them in AGWA. 

 
I've received an error saying “Shapefile has 
error. Unable to open” that interferes with the 
current AGWA process. 
This error can occur when AGWA deletes 

temporary files from the working directory that are 
still present in a view or in the Table view. First, 
make sure that all data sources for themes within 
the view are still available (to see the pathname for 
a theme, go to Theme>Properties). If the data 
source is no longer available, remove the theme 
and its attribute table from the project. Save the 
project and close ArcView. The error should be 
resolved when ArcView reloads the project. 

 
When opening my AGWA project, ArcView asks 
me to locate a GRID file and then, when 
opening a View, displays an error message 
stating the MASK file cannot be located. 
Running AGWA after receiving this error will 

produce unusable watersheds and inputs. To 
resolve this error, go to Analysis>Properties. 
Reset the Analysis Extent to be “Same as View”, 
the cell size to be the same as the DEM, and 
reselect “No Mask Set”. Close the window. If the 
processing step fails, close the project and reopen. 
You may have to reset the Analysis Properties 
again. 

 
When running AGWA, I received an error 
message not described here or in the help files. 
How do I resolve the issue? 
First, make sure that any tables involved in the 

process, including the watershed and stream 
attribute tables, contain the correct values (i.e., no 
null records, WS# or STREAM# = 0, improper 
stream sequencing, etc.). If you locate an error in 
an AGWA-generated table, try rebuilding the table 
by either recreating the watershed or performing 
the task again. In some instances, it might be 
necessary to completely rebuild the project to 

correct a corrupted ArcView project. If the error 
continues to occur, contact AGWA technical 
support (agwa@tucson.ars.ag.gov). Please 
provide the following information: the exact error 
message received, the task being performed, the 
type of watershed (KINEROS, SWAT, buffered, 
etc.), the type of inputs used and any other 
relevant information that could aid in the timely 
resolution of the problem. Please do not send 
datasets unless asked to do so. 

 
AGWA Technical Support 
For problems or errors not described in this 

manual or in the AGWA support FAQ, email 
AGWA technical support 
(agwa@tucson.ars.ag.gov). Before doing so, make 
sure you are using the newest version of AGWA – 
many problems can be resolved by updating the 
extension. If this does not resolve the problem, 
provide technical support with the following 
information: 

 
• The version of AGWA being used (1.5, 

1.42c, BASINS-AGWA) 
• the exact error message displayed, 
• the task being performed (i.e. Watershed 

delineation, landcover and soils 
parameterization, etc.), 

• the type of watershed being used 
(KINEROS, SWAT, buffered, etc.), 

• the type of inputs used, and 
• any other relevant information that could aid 

in the timely resolution of the problem. 
 
Please do not send datasets unless asked to do  

so. 
 
Third Party Support 
For questions regarding model specifications or 

general ArcView problems, refer to the associated 
website. 

 
ArcView: http://support.esri.com/
SWAT: http://www3.baylor.edu/cagsr/swat/
KINEROS: http://www.tucson.ars.ag.gov/KINEROS
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Appendix A: Obtaining Spatial Datasets 
 

The AGWA tool is designed to be used with geospatially referenced data, which includes most data types 
supported by ArcView. These include: coverages, shapefiles, and grids. Images can be used for 
reference within a view, but are not used directly by the AGWA tool. Specific data requirements for each 
of the model components are outlined below, and are described in more detail in the sections describing 
each component. 

 
Watershed Delineation 
USGS Digital Elevation Model (DEM) – available at multiple sites 

http://edcwww.cr.usgs.gov/doc/edchome/ndcdb/ndcdb.html
http://edcsns17.cr.usgs.gov/EarthExplorer/
http://seamless.usgs.gov/ (easiest download site) 
http://datagateway.nrcs.usda.gov/

Point coverage or shapefile of gauging station location(s) (optional) 
 
Land Cover grid 
North American Land Cover Characterization (NALC) 

http://www.epa.gov/owow/watershed/landcover/lulcny.html
Multi-Resolution Land Characteristics (MRLC) Consortium – National Land Cover Data (NLCD) 

http://www.epa.gov/mrlc/nlcd.html
http://seamless.usgs.gov/ (easiest download site) 
http://datagateway.nrcs.usda.gov/

New York – state-specific classification scheme 
http://www.epa.gov/owow/watershed/landcover/lulcny.html

User-Defined - this can cover any other classification scheme 
 
Soil Polygon Map 
State Soil Geographic Database (STATSGO) soils coverage/shapefile 

http://www.ncgc.nrcs.usda.gov/branch/ssb/products/statsgo/data/index.html (by state) 
http://water.usgs.gov/lookup/getspatial?ussoils (by basin) 

Soil Survey Geographic (SSURGO) Database – higher resolution soils coverage/shapefile. 
http://www.ncgc.nrcs.usda.gov/branch/ssb/products/ssurgo/data/index.html
http://datagateway.nrcs.usda.gov/

Food and Agriculture Organization of the United Nations (FAO) Digital Soil Map of the World – Low 
resolution global soils classification. 

http://www.tucson.ars.ag.gov/agwa/fao_soils.html
http://www.fao.org/icatalog/search/dett.asp?aries_id=103540

 
KINEROS Precipitation Data (one of the following) 
Uniform, single gage 

National Weather Service 
Precipitation Frequency Data Server http://hdsc.nws.noaa.gov/hdsc/pfds/
NOAA Atlas 2 http://www.nws.noaa.gov/oh/hdsc/noaaatlas2.htm
TP-40 Precipitation Frequency Grids http://www.tucson.ars.ag.gov/agwa/rainfall_frequency.html
AGWA design storm database, dsgnstrm.dbf – this is provided with AGWA, and should be located 

in the datafiles directory 
Uniform or Distributed Gages  

National Weather Service 
National Climatic Data Center http://www.ncdc.noaa.gov/
Western Regional Center http://www.wrcc.dri.edu/

 
SWAT Precipitation Data (one of the following) 
National Weather Service 
National Climatic Data Center http://www.ncdc.noaa.gov/
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NNDC Climate Data Online http://cdo.ncdc.noaa.gov/CDO/cdo
Western Regional Center http://www.wrcc.dri.edu/
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Appendix B: Analyzing watersheds with AGWA and ATtiLA 
 
The watershed assessment tools provided by AGWA can be utilized in conjunction with the Analytical 
Tools Interface for Landscape Assessment (ATtiLA) (Ebert et al., 2004) to integrate Landscape Ecology 
theory with hydrologic modeling. ATtiLA was developed by the U.S. EPA Landscape Ecology Branch 
(http://www.epa.gov/esd/land-sci/attila/index.htm) as an ArcView 3.x extension. It calculates many 
commonly used landscape metrics and can accommodate spatial data from a variety of sources. Four 
metric groups are currently included in ATtiLA: landscape characteristics, riparian characteristics, human 
stressors, and phusical characteristics. ATtiLA is suitable across all landscapes, from deserts to rain 
forets to urban areas. 

 
The integrated approach to conducting watershed assessment analyses with AGWA and ATtiLA is 

depicted in Figure B1 and consists of three elements: hydrologic simulation, landscape analysis, and 
assessment. The hydrologic simulation element is performed using the AGWA SWAT interface and 
hydrologic response units to evaluate the impact of landcover/land use on water yield and erosion (see 
Landcover and Soils Parameterization>Landcover>SWAT>Hydrologic Response Units (HRUs) and 
SWAT>Inputs and Execution). Landscape analyses are then performed using ATtiLA to calculate 
landscape characteristic metrics, e.g. number and size of grassland patches, for each subwatershed. The 
assessment element integrates outputs from both previous processes, AGWA-SWAT hydrologic modeling 
and ATtiLA landscape assessment. This step is carried out outside of the AGWA and ATtiLA 
environments. Different analyses can be performed based on the user’s stated objectives at the start of 
the assessment process by extracting select results from the generated outputs. 

 

 
Figure B1. Integrated approach for conducting watershed assessment analyses with AGWA and ATtiLA. 
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The approach shown in Figure B1 was formulated to identify and rank subwatersheds containing 

HRUs with high total sediment loads. This is accomplished by identifying all HRUs with average slope 
steepness greater than 9% and average sediment yields greater than 0.8 ton/ha; these values can be 
extracted from the watershed attribute table and SWAT subwatershed output table (or SBS file). The 
number and average patch size on each subwatershed for each landcover class are extracted from the 
ATtiLA attribute table. Average sediment yield is then computed based on the average patch size and  
the sediment yield. The subwatershed ranking by sediment load is a function of landcover type, slope 
steepness, and average patch size and is carried out by sorting sediment load values. This approach has 
been applied to the Upper San Pedro Basin in Southeastern Arizona to identify the main landcover 
classes contributing to soil erosion and high sediment loads (Hernandez et al., 2003). 
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Appendix C: Landcover Modification Fractal Component 
 
 

The Landcover Modification Fractal (LCMF) component generates a multifractal surface with multiple 
landcover types. The result is a surface consisting of spatially randomly distributed patches within any 
polygon area defined by the user (Figure C1). This option was previously available through the Landcover 
Modification Tool as an ArcView algorithm. The conversion to a Fortran 90 executable greatly improves 
its performance and allows for the generation of larger surfaces. This component was specifically written 
to be used in AGWA and the Landcover Modification Tool (Scott, 2005). 

 

 
Figure C1. The LCMF process. (left) The input mask grid (black = NODATA); (center) the multifractal 

surface; and (right) the final surface (Scott, 2005). 
 
The multifractal algorithm is based on the two-dimensional midpoint displacement algorithm described 

by Saupe and Peitgen (1988). The algorithm combines a displacement process with successive random 
additions, based on average cell values of the surrounding cells and modified by a Gaussian random 
number. The displacement, in effect, rotates the surface 45° for each processing step. Patchiness is 
determined by the fractal dimension D, where D = 3 - H. Patch size increases as H approaches 1. Low H 
values, however, do not produce completely spatially random surfaces – the multifractal surface always 
displays some clustering tendency. The algorithm is restricted to squares with dimensions based on 2x, 
where x is the number of recursions in the fractal process.  

 
The LCMF requires four basic inputs to create a surface – a mask of the irregular polygon, the new 

landcover types (as integer codes), the proportion of each type, and the level of patchiness. The number 
of recursions is determined by the size of the input mask, which calculates the x value based on the 
maximum number of rows or columns. The model constructs an array with the calculated dimensions, 
populates the array with random numbers based on the Bays and Durham generator (Press, 1996) and 
performs the multifractal displacement. Once the calculations are complete, breakpoints based on the 
proportions are calculated for the area described by the mask. The array values are replaced by integer 
values based on the input landcover types using the derived breakpoints. All other areas are set to 9999 
(NODATA). The integer array is written to a new ASCII file with the same dimensions as the original input 
mask. In general, proportions of the final surface are within 1-2% of the specified values. 

 
The executable can be run outside of AGWA to generate surfaces with more than three landcover 

types. The required inputs are listed in the patch.fil file in the following order: 
 
  Line 1  mask file name (full pathname) 
  Line 2  new grid name (no extension or path) 
  Line 3  working directory (location of the output ASCII) 
  Line 4  number of vegetation types 
  Line 5  integer values of vegetation types* 
  Line 6  integer values of percentages (percentages are the running total)* 
  Line 7  integer seed value (positive) 
  Line 8  H value (0.01-0.99) 
   
  *Lines 5 and 6 are fixed width inputs where vegetation types are 4 digit  
  integers and percentages are 3 digit integers followed by a blank space.   
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  If either value contains fewer digits, those digits should be represented  
  by blank spaces preceding numerical value.   
    Ex.  We would like an output grid of 30% vegetation 34 and 70% vegetation 75.   

                The corresponding input lines would be 
              [][]34[][][]75 
              []30[]100 
              ([] represents one blank space) 
  If the spacing is incorrect, the vegetation and/or percentage values will be   
  misread by the program, resulting in an incorrect ASCII file. 
 
The mask file should be in ArcView ASCII format, with NODATA values set to 9999. If the exported 

ASCII grid contains negative values, these must be changed before use in the LCMF. The mask file size 
is limited to 10 MB, approximately 1400 x 1400 cells. This size restriction is based only on the number of 
cells and not the resolution – the actual map area that can be modified decreases as resolution 
increases. 

 
To run the executable, open a DOS command line window and navigate to the directory containing the 

model and the input files. Enter “cmd /c lcmf” and hit Return. The model will generate a new ASCII file, 
with the new name, in the directory. This file can be imported into the GIS using the appropriate method. 

 

Automated Geospatial Watershed Assessment Tool  92



References 
 

Arnold, C.L. and C.J. Gibbons, 1996. Impervious surface coverage: the emergence of a key 
environmental indicator. J. American Planning Assoc. 62:243-258. 

 
Arnold, J.G., J.R. Williams, R. Srinivasan, K.W. King, and R.H. Griggs, 1994. SWAT-Soil Water 

Assessment Tool. USDA, Agricultural Research Service, Grassland, Soil and Water Research 
Laboratory, Temple, Texas. 

 
Aronoff, S., 1985. The minimum accuracy value as an index of classification accuracy. Photogrammetric 

Engineering & Remote Sensing, 51(1): 99-111. 
 
Band, L.E. and I.D. Moore, 1995. Scale: landscape attributes and geographical information systems, in: 

scale issues in hydrological modeling (Eds.) Kalma, J. D. and M. Sivapalan, John Wiley & Sons 
 
Band, L.E., 1986. Topographic partition of watersheds with digital elevation models. Water Resources 

Research, 22(1):15-24. 
 
Band, L.E., D.L. Peterson, R. Nemani, and S.W. Running, 1993. Forest ecosystem processes at the 

watershed scale: incorporating hillslope hydrology, Ecol. Modell., 63: 93-126. 
 
Band, L.E., D.L. Peterson, S.W. Running, J.C. Coughlan, R.B. Lammers, J. Dungan, and R. Nemani, 

1991. Forest ecosystem processes at the watershed scale: basis for distributed simulation, Ecol. 
Modell., 56: 151-176. 

 
Calore, C., P. La Barbera, and G. Roth, 1997. On the use of informational entropy in GIS. in: Remote 

Sensing and Geographic Information Systems for Design and Operation of Water Resources Systems, 
Proceedings of Rabat Symposium, IAHS, Publ. No. 242. 

 
Canfield, H.E., D.C. Goodrich, and I.S. Burns, 2004. Selection of Parameters Values to Model Post-fire 

Runoff and Sediment Transport at the Watershed Scale in Southwestern Forests. ASCE Conference 
Proceedings 178 (48). 

 
Charbonneau, R., and G.M. Kondolf, 1993. Land use change in California, USA: nonpoint source water 

quality impacts. Environ. Man. 17:453- 460. 
 
Chow, V.T., D.R. Maidment, and L.W. Mays, 1988. Applied Hydrology, McGraw Hill, New York , N.Y., p. 

147-154. 
 
Clarke, R.T., 1998. Stochastic Processes for Water Scientists: Developments and Applications. John 

Wiley & Sons, Inc., New York, 183pp. 
 
Congalton, R.G., M. Balogh, C. Bell, K. Green, J.A. Milliken, and R. Ottman, 1998. Mapping and 

monitoring agricultural crops and other land cover in the Lower Colorado River Basin. 
Photogrammetric Engineering & Remote Sensing, 64(11): 1107-1113. 

 
Congalton, R.M. and K. Green, 1999. Assessing the accuracy of remotely sensed data: principles and 

practices. Lewis Publishers, CRC Press, NY. 
 
Congalton, R.M., R.G. Oderwald, and R. Mead, 1983. Assessing Landsat classification accuracy using 

discrete multivariate statistical techniques. Photogrammetric Engineering & Remote Sensing, 49(12): 
1671-1678. 

 
Crawford, N.H., and R.K. Linsley, 1966. Digital simulation on hydrology: Stanford Watershed Model IV. 

Stanford University Tech. Rep. No. 39. Palo Alto, Cal.: Stanford University. 

Automated Geospatial Watershed Assessment Tool  93



 
Driessen, P., J. Deckers, O. Spaargaren, F. Nachtergaele, editors, 2001. Lecture Notes on the Major 

Soils of the World. FAO, Publishing and Multimedia Service, Information Division, Viale delle Terme di 
Caracalla, 00100 Rome, Italy. http://www.fao.org/DOCREP/003/Y1899E/ Y1899E00.HTM

 
Ebert, D.W., and T.G. Wade, 2004. Analytical Tools Interface for Landscape Assessments (ATtiLA), User 

Manual Version 2004, U.S. EPA Office of Research and Development, National Exposure Research 
Laboratory, Environmental Division, Landscape Ecology Branch, EPA/600/R-04/083. 

 
Engman, E.T. and R.J. Gurney, 1991. Remote sensing in hydrology. Chapman and Hall, Van Nostrand 

Reinhold, NY. 
 
Entekhabi, D., H. Nakamura, and E.G. Njoku, 1994. Solving the inverse problem for soil moisture and 

temperature profiles by sequential assimilation of multifrequency remotely sensed observations. IEEE 
Trans. Geosci. Remote Sensing, 32: 438-448. 

 
Engel, B., J. Harbor, M. Bland, A. Krause, D. George, 2004. Impacts of Land Use Change on Water 

Resources, Purdue Research Foundation, West Lafayette, Indiana 47907. 
http://www.ecn.purdue.edu/runoff/index.html

 
Famiglietti, J.S. and E.F. Wood, 1991. Evapotranspiration and runoff for large land areas: land surface 

hydrology for atmospheric general circulation models. Surv. Geophys., 12: 179-204. 
 
Famiglietti, J.S. and E.F. Wood, 1994. Multi-scale modeling of spatially variable water and energy 

balance processes. Water Resources Research, 30: 3061-3078. 
 
Famiglietti, J.S. and E.F. Wood, 1995. Effects of spatial variability and scale on areal-average 

evapotranspiration. Water Resources Research, 31: 699-712. 
 
FAO/UNESCO, 2003. Digital Soil Map of the World and Derived Soil Properties, Version 3.6. CD-ROM, 

Information Division, FAO, Viale delle Terme di Caracalla, 00100 Rome, Italy. 
http://www.fao.org/ag/agl/agll/dsmw.stm

 
Franklin, J.F., 1992. Scientific basis for new perspectives in forests and streams. pp. 25-72. IN: R. J. 

Naiman (ed.) Watershed Management. Springer-Verlag, NY. 
 
Garbrecht, J. and L.W. Martz, 1993. Network and subwatershed parameters extracted form digital 

elevation models: The Bills Creek Experience, Water Resources Bulletin, American Water Resources 
Association, 29(6): 909-916. 

 
Garbrecht, J. and L.W. Martz, 1995. TOPAZ: An automated digital landscape analysis tool for topographic 

evaluation, drainage identification, watershed segmentation and subcatchment parameterization; 
overview. ARS Pub. No. NAWQL 95-1, USDA-ARS, Durant, OK, 16 pp. 

 
Garbrecht, J., and L.W. Martz, 1996. Digital landscape parameterization for hydrological applications, in 

HydroGIS 96: Applications of Geographic Information Systems in Hydrology and Water Resources 
Management, IAHS Publ., 235. 

 
Goodrich, D.C., 1991. Basin scale and runoff model complexity, University of Arizona, Dep. of Hydrology 

and Water Resources Technical Report No. HWR 91-010,361 p. 
 
Graf, W. L., 1988. Fluvial Processes in dryland rivers, Springer-Verlag Berlin Heidelberg, Germany. 
 
Hernandez, M., W.G. Kepner, D.J. Semmens, D.C. Goodrich, and S.N. Miller, 2003. Integrating a 

Landscape/Hydrologic Analysis for Watershed Assessment, First Interagency Conference on 

Automated Geospatial Watershed Assessment Tool  94



Research in the Watersheds, Oct 27-30, Benson, AZ, U.S. Department of Agriculture, Agricultural 
Research Service. 

 
Hord, R.M. and W. Brooner, 1976. Land-use map accuracy criteria. Photogrammetric Engineering & 

Remote Sensing, 42(5): 671-677. 
 
Hunsaker, C.T., and D.A. Levine, 1995. Hierarchical approaches to the study of water quality in rivers. 

BioScience 45:193-203. 
 
Hunsaker, C.T., D.A. Levine, S.P. Timmins, B.L. Jackson, and R.V. O'Neill, 1992. Landscape 

characterization for assessing regional water quality. Pp. 997-1006, in D.H. McKenzie, D.E. Hyatt, and 
V.J. McDonald (eds.), Ecological indicators. Elsevier Appl. Sci., New York. 

 
Jackson, T.J., R.M. Ragan, and R.P. Shubinski, 1976. Flood frequency studies on ungauged urban 

watersheds using remotely sensed data. Proc. Natl. Symp. on Urban Hydrology, Hydraulics and 
Sediment Control, University of Kentucky, Lexington, KY. 

 
Jackson, T.J., R.M. Ragan, and W.N. Fitch, 1977. Test of landsat-based urban hydrologic modeling. 

ASCE J. Water Resources Planning Management Division, 103, No. WR1 Proc. Paper 12950, pp 141-
158. 

 
Jarrell, W. (Discovery Farms Program), and L. Bundy (Department of Soil Science, University of 

Wisconsin), 2002. http://wpindex.soils.wisc.edu/ hydrologicsoilgroup.html  
 
Jenson, S.K. and J.O. Domingue, 1988. Extracting topographic structure from digital elevation data for 

geographical information system analysis. Photogrammetric Engineering and Remote Sensing 
54(11):1593-1600. 

 
Junk, W. J., P.B. Bailey, and R.E. Sparks, 1989. The flood pulse concept in river-floodplain systems. Can. 

Spec. Publ. Fish. Aquat. Sci. 106:110- 127. 
 
Karr, J.R. and I.J. Schlosser, 1978. Water resources and the land-water interface. Science 201:229-233. 
 
La Barbera, P. and G. Roth, 1994. Scale properties and scale problems: network morphology and 

network identification from digital elevation maps. In: Advances in Distributed Hydrology (Ed.) Rosso et 
al., 131-148, Water Resources Publication, Colorado. 

 
Langbein, W.B. and S.A. Schumm, 1958. Yield of sediment in relation to mean annual precipitation. 

Trans. Am. Geophys. Union, 39:1076- 1084. 
 
Law, A.M., and Kelton, W.D., 1982, Simulation Modeling and Analysis. McGraw-Hill Inc., 400pp. 
 
Lowrance, R.R., R.L. Todd, J. Fail, O. Hendrickson, R. Leonard, and L.E. Asmussen, 1984. Riparian 

forests as nutrient filters in agricultural watersheds. Bioscience 34:374-377. 
 
Maidment, D.R., 1993. Handbook of Hydrology. David R. Maidment, ed., McGraw Hill, Inc. 
 
Mark, D., J. Dozier, and J. Frew, 1984. Automated basin delineation from digital elevation data. 

GeoProcessing, 2:299-311. 
 
Martz, L.W., and J. Garbrecht, 1993. Automated extraction of drainage network and watershed data from 

digital elevation models. Water Resources Bulletin, American Water Resources Association, 
29(6):901-908. 

 
Meentemeyer, V. and E.O. Box, 1987. Scale effects in landscape studies. In: Landscape heterogeneity 

and disturbance, pp. 15-34. (Ed.) M. G. Turner, Springer-Verlag, NY. 

Automated Geospatial Watershed Assessment Tool  95



 
Miller, S.N, 1995. An Analysis of Channel Morphology at Walnut Gulch Linking Field Research with GIS 

Applications. Masters Thesis, School of Renewable Natural Resources, University of Arizona. 
Available from UMI Dissertation Services. 169 pp. 

 
Moore, I.D. and R.B. Grayson, 1991. Terrain based prediction of runoff with vector elevation data. Water 

Resources Research, 27: 1177-1191. 
 
Moore, I.D., A.K. Turner, J.P. Wilson, S.K. Jenson, and L.E. Band, 1993. GIS and land surface-

subsurface modeling. In: Geographic Information Systems and Environmental Modeling (Eds.) 
Goodchild, M. F., P. O. Parks, and L. Y. Stayaert, Oxford University Press, Oxford, pp. 196-230. 

 
Moore, I.D., E.M. O'Loughlin, and G.J. Burch, 1988. A contour-based topographic model for hydrological 

and ecological applications. Earth Surface Processes Landforms, 13: 305-320. 
 
Nemani, R., L.L. Pierce, S.W. Running, and L.E. Band, 1993. Ecological processes at the watershed 

scale: sensitivity to remotely sensed leaf area index estimates. Int. J. Remote Sensing, 14: 2519-2534. 
 
Nielsen, D.R. and J. Bouma, 1985. Soil spatial variability. In: Proceedings of a Workshop of the 

International Soil Science Society and the Soil Science Society of America, Pudoc, Wageningen, 243 
pp. 

 
O'Callaghan, J.F. and D.M. Mark, 1984. The extraction of drainage networks from digital elevation data. 

Computer Vision, Graphics and Image Processing, 28:323-344. 
 
Omernik, J.M. 1987. Ecoregions of the United States: Map at a scale of 1:7,500,000. Suppl. Annals 

American Assoc. Geogr. 77(1). 
 
Osborn, H.B., L.J. Lane, and V.A. Myers, 1980. Rainfall/watershed relationships for Southwestern 

thunderstorms; Transactions of the ASAE, v. 23, n. 1, p. 82-91. 
 
Peterjohn, W.T. and D.L. Correll, 1984. Nutrient dynamics in an agricultural watershed: Observations on 

the role of a riparian forest. Ecology 65:1466-1475. 
 
Press, W.H., 1996. Numerical Recipes in Fortran 90: the art of parallel scientific computing. 2nd Edition. 

Cambridge University Press, New York. 
 
Ragan, R.M. and T.J. Jackson, 1980. Runoff Synthesis Using Landsat and SCS Model, J. of Hydrology, 

Divn., ASCE, Vol. 106 (HYS5): 667-678. 
 
Rango, A., A. Feldman, T.S. George, III, and R.M. Ragan, 1983. Effective use of Landsat data in 

hydrologic models. Water Resources Bulletin, 19, 165-74. 
 
Rawls, W.J., D.L. Brakensiek, and K.E. Saxton, 1982. Estimation of soil water properties. Transactions of 

the American Society of Agricultural Engineers 25(5):1316-1320. 
 
Renard, K.G., G.R. Foster, G.A. Weesies, D.K. McCool, and D.C. Yoder (Coordinators), 1997. Predicting 

Soil Erosion by Water: A Guide to Conservation Planning with the Revised Universal Soil Loss 
Equation (RUSLE). Agricultural Handbook No. 703., U. S. Department of Agriculture, Washington, 
D.C. 404 p. 

 
Reynolds, C.A., T.J. Jackson, and W.J. Rawls, 1999. Estimated Available Water Content from the FAO 

Soil Map of the World, Global Soil Profile Databases, and Pedo-transfer Functions. 
http://www.ngdc.noaa.gov/seg/cdroms/reynolds/reynolds/reynolds.htm

 

Automated Geospatial Watershed Assessment Tool  96



Rosenfield, G.H., K. Fitzpatrick-Lins, and H. Ling, 1982. Sampling for thematic map accuracy testing. 
Photogrammetric Engineering & Remote Sensing, 48(1):131-137. 

 
Roth, N.E., J.D. Allan, and D.L. Erickson, 1996. Landscape influences on stream biotic integrity assessed 

at multiple scales. Landscape Ecology 11:141-156. 
 
Saupe, D. and H. Peitgen, eds., 1988. The Science of Fractal Images. Springer, New York. 
 
Scott, S.N., 2005. Implementing best management practices in hydrologic modeling using KINEROS and 

the Automated Geospatial Watershed Assessment (AGWA) Tool. Masters Thesis, School of Natural 
Resources, University of Arizona. 204p. 

 
Shannon, C.E., 1948. A mathematical theory of communications. Bell System Technology Journal, 27: 

379-423, 623-659. 
 
Singh, V.P., 1995. Watershed modeling, In Computer Models of Watershed Hydrology (V. P. Singh, Ed.). 

Water Resources Publications, Highlands Ranch, Colorado. p. 1-22. 
 
Soil Conservation Service, 1973. A Method for Estimating Volume and Rate of Runoff in Small 

Watersheds; SCS-TP-149, U.S. Department of Agriculture, Soil Conservation Service, Washington, 
DC. 

 
Soil Conservation Service, 1986. Urban hydrology for small watersheds, Technical release No. 55; Soil 

Conservation Service, U.S. Department of Agriculture, Washington, DC. 
 
Spanner, M.A., L.L. Pierce, D.L. Peterson, and S.W. Running, 1990. Remote sensing of temperate forest 

leaf area index: influence of canopy closure, understory vegetation and background reflectance. Int. J. 
Remote Sensing, 11: 96-111. 

 
Spanner, M.A., L. Johnson, J. Miller, R. McCreight, J. Freemantle, J. Runyon, and P. Gong, 1994. 

Remote sensing of seasonal leaf area index across the Oregon transect. Ecol. Appl., 4: 258-271. 
 
Sparks, R.E., 1995. Need for ecosystem management of large rivers and their floodplains. BioScience 

45:168-182. 
 
Star, J.L., J.E. Estes, and K.C. McGwire, 1997. Integration of Geographic Information Systems and 

Remote Sensing, Cambridge University Press, Cambridge, UK. 
 
Sweet, W.V. and J.W. Geratz, 2003. Bankfull Hydraulic Geometry Relationships and Recurrence Intervals 

for North Carolina's Coastal Plain. Journal of the American Water Resources Association 39(4): 861-
871. 

 
Syed, K.H., 1999. The impacts of digital elevation model data type and resolution on hydrologic modeling. 

Doctoral Dissertation, Department of Hydrology and Water Resources, University of Arizona, 269pp. 
 
U.S. Department of Agriculture, Soil Conservation Service, 1972. National Engineering Handbook, 

Section 4, Hydrology US Government Printing Office, Washington, D.C. 
 
U.S. Department of Agriculture, Natural Resources Conservation Service, 1994. State Soil Geographic 

(STATSGO) Data Base: Data Use Information, National Cartography and GIS Center, Fort Worth, 
Texas. 

 
U.S. Department of Agriculture, Natural Resources Conservation Service, 1995. Soil Survey Geographic 

(SSURGO) Data Base: Data Use Information, National Cartography and GIS Center, Fort Worth, 
Texas. 

 

Automated Geospatial Watershed Assessment Tool  97



U.S. Army Corps of Engineers, 1976. Urban storm water runoff, STORM. Computer program 723-L2520, 
Hydrologic Engineering Center, Davis, CA. 

 
van Genderen, J.L. and B.F. Lock, 1977. Testing land use map accuracy. Photogrammetric Engineering 

& Remote Sensing, 43(9): 1135-1137. 
 
Weller, M.C., M.C. Watzin, and D. Wang, 1996. Role of wetlands in reducing phosphorus loading to 

surface water in eight watersheds in the Lake Champlain Basin. Environ. Man. 20:731-739. 
 
Wigmosta, M.S., L.W. Vail, and D.P. Lettenmier, 1994. A distributed hydrology-vegetation model for 

complex terrain. Water Resources Research, 30:1665-1680. 
 
Williams, J.R., 1969. Flood routing with variable travel time or variable storage coefficients. Trans. ASAE 

12(1):100-103. 
 
Wischmeier, W.H., and D.D. Smith, 1978. Predicting rainfall erosion loss: A guide to conservation 

planning. Agricultural handbook 537. U. S. Department of Agriculture, Washington, D.C. 
 
Wood, E.F., 1994. Scaling, soil moisture and evapotranspiration in runoff models. Advances Water 

Resources, 17: 25-34. 
 
Wood, E.F., M. Sivapalan, K. Beven, and L. Band, 1988. Effects of spatial variability and scale with 

implications to hydrologic modeling. Journal of Hydrology, 102: 29-47. 
 
Woolhiser, D.A., R.E. Smith, D.C. Goodrich, 1990. KINEROS, a kinematic runoff and erosion model: 

Documentation and user manual. U.S. Department of Agriculture, Agricultural Research Service, ARS-
77, 130p. SWRC Reference No.: 703. 

Automated Geospatial Watershed Assessment Tool  98


	Contents
	Abstract
	Introduction
	Watershed Modeling
	Process Description
	Spatial Scale
	Temporal Scale
	Land Use
	Effects of aggregation of landscape attributes on watershed 
	Integration of geographic information systems and remote sen
	Kinematic Runoff and Erosion Model - KINEROS
	Soil Water Assessment Tool - SWAT

	AGWA Tool Overview
	Changes for AGWA 1.5
	New to 1.5
	Changes from 1.4


	Set-up and Installation
	Hardware and Software Requirements
	Installation
	For Windows 2000 and XP
	For Windows NT
	For Windows 95 & 98



	File Management
	Required Files and Datasets
	Watershed Raster Inputs
	Watershed Components
	Landcover Components
	Soil Components
	Precipitation Components: KINEROS
	Precipitation Components: SWAT
	Simulation Output Components


	Moving spatial data

	Watershed Delineation and Discretization
	Basic Concepts
	Stream Map
	Watershed Outline
	Contributing Source Area (CSA)
	KINEROS Flow Length
	Hydraulic Geometry Relationships
	Watershed and Stream parameters
	KINEROS Watershed
	KINEROS Stream
	SWAT Watershed
	SWAT Stream


	Watershed Delineation
	Create a new watershed
	Create a nested watershed
	Create a Watershed Group
	Multiple outlet locations
	Area of Interest outlet locations

	Edit a watershed group
	Append watersheds
	Remove watersheds
	Extract watersheds

	Use existing watershed delineation(s)
	Select a subwatershed from a SWAT watershed
	Apply channel buffers to a KINEROS watershed

	Watershed Discretization
	Individual watersheds
	CSA Enforcement
	Multiple or nested watersheds
	Internal Breakpoints: Gages, Ponds, and Reservoirs
	Internal Gages
	KINEROS Ponds
	SWAT Reservoirs
	Non-releasing Ponds

	Setting the hydraulic geometry relationship


	Landcover and Soils Parameterization
	KINEROS Parameters
	SWAT Parameters
	Landcover
	KINEROS
	SWAT
	Hydrologic Response Units
	Default CROP values

	Custom Lookup Tables

	Soils
	Soils Datasets
	STATSGO
	SSURGO
	FAO

	KINEROS
	SWAT

	Parameterization
	Parameterizing an individual watershed
	Parameterizing a buffered watershed
	Parameterizing a watershed group


	KINEROS
	Generating Precipitation Files
	Uniform Inputs
	Precipitation-Frequency Maps
	AGWA Design Storm database
	Manual Inputs

	Multiple Gage Inputs
	Setting the saturation index

	Inputs and Execution
	Writing the parameter file
	Hydrograph Output
	Using multipliers
	Running KINEROS with a watershed group


	SWAT
	Generating precipitation files
	Uniform Precipitation
	Distributed Precipitation
	Elevation Bands

	Inputs and Execution
	Selecting the weather generator file
	Advanced Inputs
	Rainfall Adjustment Factors
	Groundwater
	Nitrogen and Phosphorous Modeling

	Running SWAT for a watershed group


	Results
	KINEROS Plane Outputs
	SWAT Subwatershed outputs
	SWAT HRU outputs
	Setting and using the breakpoints
	Simulation Totals
	KINEROS Time Series
	SWAT Time Series
	Unbuffered vs. Buffered comparison
	Differencing

	Rerunning Simulations
	KINEROS
	SWAT

	Metadata
	Metadata Structure
	View watershed metadata
	Add user comments
	View simulation metadata

	Managing AGWA Datasets
	Package a watershed for export
	Import an AGWA watershed

	Advanced Options
	Landcover Modification Tool
	Change all of the landcover in an area to a new landcover type using an interactively drawn polygon
	Change one landcover type in an area to a new landcover type
	Change all of the landcover in an area to a new landcover type using a polygon map
	Change all of the landcover in an area to 2-3 new landcover types in a spatially distributed random pattern

	Analyze an area using a burn severity map

	SSURGO Tool
	Import SSURGO Datasets
	Merge SSURGO Datasets
	Correct Internal Voids
	Extend SSURGO Edges

	Hydraulic Geometry Relationships
	Preferences
	KINEROS Baseflow
	Warning Messages
	SWAT DAT Defaults
	Setting the default DAT location
	Editing Landcover Lookup Tables

	KINEROS Flow Length
	File Management


	Troubleshooting
	Tips and Tricks
	Errors
	Additional Resources
	AGWA Frequently Asked Questions (FAQ)
	AGWA Technical Support
	Third Party Support


	Appendix A: Obtaining Spatial Datasets
	Appendix B: Analyzing watersheds with AGWA and ATtiLA
	Appendix C: Landcover Modification Fractal Component
	References


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


